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Visual Execution Analysis

The Visual Execution Analyzer (VEA) 1s made up of an
advanced and powerful suite of tools that allow you to build,
debug, record, profile, simulate and otherwise construct and
verify your software development while keeping the code
tightly integrated with your model. Enterprise Architect has
rich support for a wide range of popular compilers and
platforms, in particular the Java, .Net and Microsoft
Windows C++ environments. Software development
becomes a highly streamlined visual experience, quite
unlike working in traditional environments.

Enterprise Architect is itself modeled, built, compiled,
debugged, tested, managed, profiled and otherwise
constructed totally within the Visual Execution Analyzer
built into Enterprise Architect. While the VEA can be used
to complement other tool suites, it also shines when used as
the primary development IDE in close coupling with the
model and project management capabilities provided by
Enterprise Architect.

Access

(c) Sparx Systems 2019 Page 9 of421
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Ribbon Develop > Preferences > Analyzer > Edit
Analyzer Scripts

Execute > Tools > Analyzer

Keyboard Shift+F12
Shortcuts

Execution Analyzer Features

Feature Description

Build and | Using Analyzer Scripts linked to Model
Debug Packages, it 1s possible to tightly

integrate the code/build/debug cycle into

/’g\ Enterprise Architect. For Java, .Net and

b\ Microsoft C++ in particular, it is simple
to link to project code bases and take over
the building and debugging within
Enterprise Architect's Model Driven
Development Environment. In addition to
standard debugging features, the strong
coupling with the model and the use of
advanced debugging features such as
Action Points makes Enterprise Architect
the ideal platform from which to both
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Simulation

Profiling

Recording
Execution

(c) Sparx Systems 2019

design and construct your software
application.

Bring your behavioral models to life with
instant, real-time behavioral model
execution. Coupled with tools to manage
triggers, events, guards, effects,
breakpoints and simulation variables,
plus the ability to visually track execution
at run-time, the Simulator 1s a powerful
means of 'watching the wheels turn' by
visualizing execution of your behavioral
models.

Lift the hood on software performance
and see what is actually going on.
Quickly gain a clear picture of why
certain tasks behave poorly or worse than
expected. Whether its Microsoft .NET,
native C++ or Java, use profiles to
effectively judge changes in performance
over your software lifecycle.

Record the execution of code without the
need for instrumentation. Control the
amount of detail through filters and stack
depth. Generate beautiful Sequence
diagrams and diagrams that illustrate
Class collaboration. Use recording to
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create Test Domain diagrams that can be
used with the VEA Testpoints feature.

Testing Create and manage test scripts for model
=) elements. Explore the Testing interface,
= supporting unit, integration, scenario,

system, inspection and acceptance tests.
Employ programming by contract
methodology with the Testpoints facility.

Object Workbench Class behavior on the fly, by
Workbench | instantiating them in the Object
- Workbench and then invoking their
l N operations. You can even pass objects on
the workbench as parameters to other
workbench objects.

Visual Try our sample patterns to set up and
Execution | explore some of the powerful features of
Analyzer the Visual Execution Analyzer.

Samples

Benefits of the Execution Analyzer

The Execution Analyzer provides an integrated development

(c) Sparx Systems 2019 Page 12 of 421
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and testing environment for multiple platforms, including
Microsoft .NET, Java, Native C++, Mono and Android. It
includes a feature-rich debugger, execution recording and
profiling, and Testpoint management.

It helps you to generate Sequence, Test Domain Class and
Collaborative Class diagrams from a single recording. This
1s a great way to understand and document your application.

e Visualize program execution

e Optimize existing system resources and understand
resource allocation

e Verify that the system is following the rules as designed

e Produce high quality documentation that more accurately
reflects system behavior

e Understand how and why systems work

e Train new employees in the structure and function of a
system

e Provide a comprehensive understanding of how existing
code works

e Identify costly or unnecessary function calls

e [llustrate interactions, data structures and important
relationships within a system

e Trace problems to a specific line of code, system
interaction or event

e Establish the sequence of events that occur immediately
prior to system failure

e Simulate the execution of behavior models including
StateMachines, Activities and Interactions

(c) Sparx Systems 2019 Page 13 of 421
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Operations

Operation Description

Simulate Simulate UML behavior models to verify
Behavior their logical and design correctness, for:

. Activities
. Interactions and Sequences
. StateMachines

Record Record executing programs and represent
execution the behavior as a UML Sequence
diagram; recording is supported for:

. Microsoft Windows Native C, C++,
Visual Basic

. Microsoft NET Family (C#, J#, VB)
. Java

. Mono

. Android

. PHP

Profile Quickly view / report on behaviors of
behavior running applications. Profiling 1s
supported for these platforms:

. Microsoft Native C, C++, Visual Basic
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Test Use
Cases with
Testpoints
system

(c) Sparx Systems 2019

. Microsoft .NET Family (C#, J#, VB)
(including any unmanaged / managed
code mix)

. Java
. Mono

Testpoints Management provides a
facility to define the constraints on a
Class model as contracts. The contracts
provide the assets on which to create Test
domains. A single Testpoint domain can
then be used to test and report the
behavior of multiple applications. You
can also use the Execution Analyzer to
record a Use Case and generate a Test
Domain diagram with very little effort.
Any existing Testpoints are automatically
linked to the generated domain or the
Test Domain diagram can be used as the
context for new contract compositions.
How an application behaves for a given
Test domain can be seen immediately in
real time! Results are displayed in the
Testpoint report window every time a
contract 1s passed or failed. The
decoupling of test measurement from the
code-base has a number of benefits, one
of which is aiding the reconciliation of
multiple systems with a common Test
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Object
Workbench

Run xUnit
tests

Import code
from analysis

(c) Sparx Systems 2019

domain, rather than one another.

The Testpoint system supports these
contracts:

. Class invariants

. Method pre-conditions
. Method post-conditions
. Line conditions

Create and work with objects created
within the Enterprise Architect modeling
environment using a dynamic Object
Workbench.

. Create objects from Class model
. Invoke methods and view results
. Workbench Class collaboration

. Pass objects as parameters to other
objects

. Full debugging features including
recording

Run nUnit and jUnit tests for Java and
Microsoft .NET

Record and document results.

Execution Recording and Profiling both
acquire a collection of relevant code files,
which you can reverse-engineer to the
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current model in a single operation.

c) Sparx Systems age 170
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Build and Debug
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Enterprise Architect builds on top of its already exceptional
code generation, diagramming and design capabilities with a
complete suite of tools to build, debug, visualize, record,
test, profile and otherwise construct and verify software
applications. The toolset 1s intimately connected to the
modeling and design capabilities and provides a unique and
powerful means of constructing software from a model and
keeping model and code synchronized.

Enterprise Architect helps you define 'Analyzer Scripts'
linked to Model Packages that describe how an application
will be compiled, which debugger to use and other related
information such as simulation commands. The Analyzer
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Script 1s the core configuration item that links your code to
the build, debug, test, profiling and deployment capabilities
within Enterprise Architect.

As a measure of how competent the toolset is, it should be
noted that Enterprise Architect is in fact built, debugged,
profiled, tested and otherwise constructed fully within the
Enterprise Architect development environment. Many of the
advanced debugging tools such as 'Action Points' have been
developed to solve problems inherent in the construction of
large and complex software applications (such as Enterprise
Architect) and are routinely used on a daily basis by the
Sparx Systems development team.

It 1s recommended that new users take the time to fully
understand the use of the Analyzer Scripts and how they tie
the model to the code, to the compilers and to other tools
necessary for building software.

Integrating Model and Code

Model Driven Engineering 1s a modern approach to software
development and promises greater productivity and higher
quality code, resulting in systems getting to market faster
and with fewer faults. What makes this approach compelling
is the ability for the architecture and the design of a system
to be described and maintained in a model, and then
generated to programming code and schemas that can be
synchronized with and visualized within the model.

Enterprise Architect's Model Driven Development

(c) Sparx Systems 2019 Page 19 of 421
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Environment (MDDE) supports this approach and provides
a set of flexible tools to increase productivity and reduce
errors. These include the ability to define the architecture
and design in models, generate code from these models,
synchronize the code with the models and maintain the code
in sophisticated code editors. Source code or binaries can
also be imported, and users can record and document
pre-existing or recently developed code. The Analyzer
Script tool helps you to describe how to build, debug, test
and deploy an application.

Facility Description
Model Model Driven Development provides a
Driven more robust, accessible and faster

Development = development cycle than traditional
coding-driven cycles.

A well constructed model, intimately
linked with source code build, run,
debug, test and deploy capabilities
provides a rich, easily navigated and
casily understood target architecture.
Traceability, linkage to Use Cases,
Components and other model artifacts,
plus the ability to readily record and
document pre-existing or recently
developed code, make Enterprise
Architect's development environment
uniquely powerful.

Enterprise Architect incorporates industry
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standard intelligent editing, debuggers
and modeling languages.

The Model The MDDE provides tools to design,

Driven visualize, build and debug an application:
Development ., UML technologies and tools to model
Environment software

(MDDE)

. Code generation tools to
generate/reverse engineer source code

. Tools to import source code and
binaries

. Code editors that support different
programming languages
. Intelli-sense to aid coding

. Analyzer scripts that enable a user to
describe how to build, debug, test and
deploy the application

. Integration with compilers such as
Java, .Net, Microsoft C++

. Debugging capabilities for Java, .NET,
Microsoft C++ and others

. Advanced visualization, recording,
inspection, testing and profiling
capabilities

pApp = new CBCGPAppointmentDemo
(

A 2 of 2 ™ CBCGPAppointmentDemonCBCGPAppointmentDemo(COleDateTime8: dtStart,
COleDateTimed dtFinish, CString & strText, COLORREF clrBackground, COLORREF
clrfForeground, COLORREF clrDuration)

RGE (les%, 222, 399),

CLE_DEFAULT,

RGE (128, O, 128)
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Analyzer Scripts

Analyzer Scripts are used by the Execution Analyzer. You
do not need to worry about creating these. They are not the
same type of script as JavaScript or PHP, but are managed
using a familiar user interface - a tree view - and you can
quickly locate the feature to change. Analyzer Scripts can be
shared by users of a community model and are easily
imported and exported as XML files.

» Tomcat

- B}“'; - Build Execute Command as: Batch File
‘... Bui

i Clean javac.exe -g -verbose -cp %CLASSPATH%; %WAPACHE_HOME%\1lib‘\servlet-api.jar" -d clia
B-Test IF ERRORLEVEL 1 GOTO BUILD_ENC

i Test cd

.. Testpoints jar cvf servlet.war *

E- Debug :BUILD_END

- Platform

- Runtime Host

- Tracepoints

- Waorkbench

El- Source Contro

- Merge

- Changes

- Histary

- Commit

- Working Copy

- Repositon F] »
El- Code Miner

Service
i Libraries
El- Private Option: Parse Output: Java SDK

Default Directory:  %VEA%)\] ava\Tomcat\HelloServiet\WEB-INF

Remote host: eg: mypc01:7777
- Run L

- Deploy Deploy after build
- Recording

- Simulation

- Run | avascript

Close

A single project can have multiple configurations and these
can be found grouped together in the Analyzer window.
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Execution Analyzer v q

- -9 Bagd i @
4 09 Example Model.Analysis and Business Modeling.DMM Examples.Package]
[#] DMM.Affordability calculation.Java
] DM .Application risk score model Java
Ol DMM.Bureau call type table.Java
[ [ DMM.Credit contingency factor table.Java
Ol DMN.Eligibility rules.Java
[l [ DMM.Installment calculation.Java
Ol DMN.Post-bureau risk categery tableJava
[ [ DMM.Pre-bureau risk category tableJava
Ol g DMN.Routing rules.Java
4 09 Example Model.Model Simulation.Executable State Machine.Entering A State
Ol Simulation.5tateMachine Artifact1.C++ Microsoft Native
O [ Simulation.StateMachine.EnteringAStateSimulation JavaScript.Scripting
i» 9 Example Model.Model Simulation.Executable State Machine.Entry and Exit Points (Connecti
I» 9 Example Model.Model Simulation.Executable State Machine.Example: CD Player
i» 9 Example Model.Model Simulation.Executable State Machine.Example: Regular Expression P:
I» 09 Example Model.Model Simulation.Executable State Machine.ForkMJoin

i» 9 Example Model.Model Simulation.Executable State Machine.History Pseudostate

Each Analyzer Script is defined for a Package, so projects
can co-exist quite happily. In many organizations, the
procedures to manage systems are distributed, and vary
from individual to individual and group to group. Analyzer
Scripts in an Enterprise Architect model can provide some
peace of mind to these organizations, by trusting a single,
shared and accountable procedure for building and
deploying any variety of configurations. All aspects of a
script are optional. You can, for instance, debug without
one; however, with a few lines they can enable these
powerful features:

. Building

. Testing

. Debugging
. Recording
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. Execution
. Deployment
. Simulation

Remote Script Execution

Various Analyzer Script sections such as Build and Run,
provide a 'Remote Host' field. This field is used to describe
the computer on which the script should run. In order to use
this feature, the Sparx Satellite service must be running on
the machine. The format of this field is hostname:port,
where hostname 1s the IP address or network name of a
Windows or Linux machine and port 1s the Port number that
the Satellite service is listening on. The primary goal of this
feature is to allow a user of Enterprise Architect running on
Linux to execute commands native to Linux.

c) Sparx Systems age 250
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Managing Analyzer Scripts

The Execution Analyzer window enables you to manage all
Analyzer scripts in the model. You can use the window
toolbar buttons or script context menu options to control
script tasks. Scripts are listed by Package; the list only
shows Packages that have Analyzer scripts defined against
them. Each user can set their own active script, independent
of other users of the same model; one user activating a script
does not impact the currently active scripts for other users or
affect the scripts available to them. The active script governs
the behavior of the Execution Analyzer; when choosing the
build command from a menu, for example, or clicking the
Debug button on a toolbar.

There can be a lot of Packages with scripts listed in the
window. To help you locate and isolate a particular
Package, use the 'Filter Packages' context menu options,
described in the Context Menu Options table in this topic.

Access
Ribbon Develop > Preferences > Analyzer > Edit
Analyzer Scripts
Execute > Tools > Analyzer
Keyboard Shift+F12

(c) Sparx Systems 2019 Page 26 of 421
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Shortcuts
Toolbar Options
Toolbar Action
Button
2 Quick access to the Analyzer core
windows such as Call Stack or Local
Variables, plus the power features:
e Profiling
e Recording
e Testpoints
e Simulation
g -

(c) Sparx Systems 2019

Create and edit a new Analyzer Script for
the selected Package, under either Linux
or Windows™,

Export Scripts.

Export one or more Analyzer Scripts to
an XML file, which can be used to import
the scripts into another model.

The 'Execution Analyzer: Export' dialog
displays from which you select the script
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(c) Sparx Systems 2019

or scripts to export, followed by a prompt
for the target file name and location.

Import Scripts.

Import one or more Analyzer Scripts into
the current model from a previously
exported XML file.

The 'Find Package' dialog displays, on
which you select the Package into which
to import the scripts, followed by a
prompt for the source filename and
location.

Execute the 'Build' command of the
active script.

Cancel the 'Build' command currently in
progress.

Execute the 'Run' command of the active
script.

Execute the 'Test' command of the active
script.

Execute the 'Deploy' command of the
active script.
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Display the Help topic for this window.

Context Menu Options

Right-click on the required script or Package to display the
context menus.

Option Action
Add New Add a new script to the selected Package.
Script The Execution Analyzer window

displays, showing the 'Build' page.

Paste Script  Paste a copied script from the Enterprise
Architect clipboard into the selected
Package.

You can paste the copied script several
times; each copy has the suffix 'Copy'.

To rename the copied script, press F2 and
overtype the script name.

Export Export scripts from the selected Package.

Scripts The 'Execution Analyzer: Export' dialog
displays, from which you select the script
or scripts to export, followed by a prompt
for the target filename and location.

(c) Sparx Systems 2019 Page 29 of 421
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Import
Scripts

Filter
Packages

Select In
Project
Browser

(c) Sparx Systems 2019

Import scripts from a . XML file into the
selected Package.

A prompt displays for the source
filename and location.

Displays a submenu of options to:

. Enter the Package path against which
to filter the list of Packages - when you
select the 'Filter Packages' option, a
prompt displays to accept the
currently-selected Package path, or you
can remove the end elements of the
path to specify a larger set of Packages;
when you click on the OK button the
first Package in the list 1s expanded to
list the scripts i1t contains

. Switch between hiding the full list of
Packages to expose only the
currently-selected Package, and
showing the full list

. Remove the currently-active filter to
show the full list of Packages

Highlight the selected Package in the
Browser window.

Display the Browser window, which is
now expanded to show the highlighted
Package.
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Help

Build

Clean

Rebuild

Debug

Run

Test

Deploy

Merge

Changes

(c) Sparx Systems 2019

Display the Help topic for this window.

Execute the 'Build' command of the
selected script.

Execute the 'Clean' command of the
selected script.

Execute the 'Clean' and 'Build' commands
of the selected script.

Execute the 'Debug' command of the
selected script.

Execute the 'Run' command of the
selected script.

Execute the 'Test' command of the
selected script.

Execute the 'Deploy' command of the
selected script.

Execute the 'Merge' source control
command of the selected script.

Execute the 'Changes' source control
command of the selected script.
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History Execute the 'History' source control
command of the selected script.

Commit Execute the 'Commit' source control
command of the selected script.

Working Execute the "Working Copy' source
Copy control command of the selected script.
Repository Execute the 'Repository' source control

command of the selected script.

Run Execute the 'Run Javascript' command of

Javascript the selected script.

Start Start the simulation referenced by the

Simulation 'Analyzer Script Simulation' page.

Run Start a simulation of the selected

Executable Executable Statemachine Artifact.

Statemachine

Edit Open the selected script in the 'Analyzer
Scripts Editor'.

Copy Copy the selected script to the Enterprise
Architect clipboard.
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Paste Paste the most-recently copied script to
the same Package as the selected script.

You can paste the copied script several
times; each copy has the suffix 'Copy'.

To rename the copied script, press F2 and
overtype the script name.

Delete Delete the selected script; there 1s no
prompt for confirmation.

To delete a Package from the Execution
Analyzer window, delete the scripts from
the Package. When the last script 1s
deleted, the Package is no longer listed.

Package Set the selected script as the default script
Default for the Package.

The icon to the left of the script changes
color; any previous Package default
reverts to normal.
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Analyzer Script Editor

The Analyzer Script Editor has a straightforward user
interface with a tree view of the scripts on the left enabling
easy navigation of the script groups, and a content view on
the right in which you define and configure the scripts.

» Tomcat v

: - Build Execute Command as: Batch File
- Build

i Clean javac.exe -g -verbose -cp %CLASSPATH%; APACHE_HOME%\1ib‘servlet-api.jar" -d clia
B Test IF ERRORLEVEL 1 GOTO EBUILD_END

i Test cd

.. Testpoints jar cvf servlet.war *

El- Debug :BUILD_END

El- Code Miner
Service Default Directory:  %VEA%)\)ava\Tomcat\HelloServiet\WEB-INF
i ies
El- Private Options Parse Output: Java SDK
! Remote host: eq: mypc0L: 7777

.. Deploy Deploy after build

Close

Access

From the 'Execution Analyzer' window, either:
. Double-click on a script to edit it or
. Right-click on a script and select the 'Edit' option

Ribbon Develop > Preferences > Analyzer > Edit
Analyzer Scripts

Execute > Tools > Analyzer
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Keyboard Shift+F12
Shortcuts

Execution Analyzer Scripts

Task - Page  Action

Build - Build = Enter the script or command to build the
application. This can be an Apache Ant
or Visual Studio command, but can also
be tailored depending on your
development environment. Note:
Remember to select a parser to get
directly to the source code in the event of
any errors. The parser field 1s on the same
page and offers support for many
languages.

Build - Clean = Enter the script or command to clean the
previous build. This is the command line
you would normally issue to build your
system. This can be an Apache Ant or
Visual Studio command depending on
your development environment.

c) Sparx Systems age 350
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Test - Test

Test -
Testpoints

Debug -
Platform

Debug -
Tracepoints

Debug -
Workbench

Debug -
Runtime
Host

Source
Control -
Merge

Source
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Enter the script or command to test the
application. This is typically where an
nUnit or jUnit invocation might be
configured, but it just as easily could be
any procedure or program.

Specify where the output from a
Testpoint run is sent.

Specify the debugging platform, the
application to be debugged, and the mode
of debugging (attach to process or run).

Specify where the output from
Tracepoints encountered during a debug
session are sent.

For .NET projects, the assembly to load.
Not required for Java.

Specify the Runtime Host.
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Control -
Changes

Source
Control -
History

Source
Control -
Commit

Source
Control -
Repository

Code Miner -
Service

Code Miner -
Libraries

Private
Options -

Services

Run
JavaScript

Source
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Control -

Working

Copy

Run Enter a script or command to run the
application.

Deploy Enter a script or command to deploy the
project. Build your jar file. Deploy to
your device, an emulator or Tomcat
server.

Publish a web site. Its up to you.

Recording Does your Sequence diagram resemble
the national grid? Reduce the clutter with
filters. Filters define exclusion zones in
your code base that can cut down
dramatically on any 'noise' that is being
recorded. Even accurate noise 1s not
always helpful.

Simulation Complete the configuration for

Simulation Control.
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Build Scripts

The 'Build' page enables you to enter commands to build
your project. You can use Enterprise Architect Local Paths
and environment variables in composing your command
line(s). You can choose to create your own build script,
entering various shell commands. You can also choose to
simply run an external program or batch file such as an Ant
script.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Build > Build' page or

. Click on # - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Build > Build'

page

Ribbon Develop > Preferences > Analyzer > Edit
Analyzer Scripts

Execute > Tools > Analyzer

Analyzer Build
Context
Menu
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Keyboard Ctrl+Shift+F12
Shortcuts

Build

Write your script in this text box, using the windows shell
commands; the format and content of this section depends
on the actual compiler you use to build your project. If the
path or arguments contain spaces, surround them with
quotes; for example: "c:\program files
(x86)\java\bin\javac.exe".

Here are some examples:
Visual Studio:

"C:\Program Files (x86)\Microsoft Visual Studio
9.0\Common7\IDE\devenv.com" /Rebuild Debug
RentalSystem.sln

Visual Studio using a Local Path:
"% VsCompPath%\devenv.exe" /build Debug Subway.sln
Java:

C:\Program Files (x86)\Java\jdk1.6.0 22\bin\javac.exe"
-g -cp "%classpath%;." %r*.java
Java using a Local Path:

"0JAVA%)\bin\javac.exe" -g -cp "%classpath%;."
%r*.java
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Wildcard Java Builds (%r) - Source files in sub-folders
can be built using the %r token. The token has the effect of
causing a recursive execution of the same command on any
files 1n all sub-folders, as shown in the example.

Execute Command as

Click on the drop down arrow and select the mode of
executing the script:

. Batch File - Use this option to execute a shell script in a
system command window; environment variables can be
accessed by commands in this script

. Process - Use this option to execute the command as a
single program; the command should specify the path to
the program, plus any command line arguments

Default Directory

Browse for or type in the default directory path in which the

build script process will run.

Parse Output

Click on the drop-down arrow and select a method for
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automatically parsing the compiler output.

If you select this option, output from the script is logged in
the System Output window; Enterprise Architect parses the
output according to the syntax you specify.

Remote Host

Type in the ID of the remote host system and its port; for
example, mypc01:7777.

If you set this property to #SYSTEMHOST#, the script 1s
sent to the Windows Satellite Service when running on
Windows, and the Linux Satellite Service when running
under Wine. The service IDs and Ports are defined in the
'Private Options - Services' section of the Analyzer Scripts

Editor.

Deploy after Build

Check this box to cause the Deploy script to be executed
immediately after this Build script completes.

Notes

To execute the Build script, click on the Package in the
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Browser window and either:

. Right-click on any Toolbar and select 'Analyzer Toolbars |
Build', or

. Press Ctrl+Shift+F12 or

Select the 'Execute > Source > Build > Build' ribbon
option
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Cleanup Script

Incremental builds are the practice of only building those
assets that have changed in some way. There are times,
however, when there 1s cause to build everything again from
scratch. This command is used for those occasions, to
remove the binaries and intermediary files associated with a
particular build or configuration. The project can then be
rebuilt. When you execute the 'Rebuild' menu option on a
script, the command(s) you specify in this field are
executed, followed immediately by the 'Build' command
from the same Analyzer script. Some compilers have
options do this for you. Visual studio for example has the
"/clean" command line switch.

This 1s an example script: devenv.com /Clean Debug
MyProject.sln

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Build > Clean' page or

. Click on ¥ - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Build > Clean'

page

Ribbon Develop > Preferences > Analyzer > Edit
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Analyzer Scripts
Execute > Source > Build > Clean

Analyzer Clean

Context
Menu

Keyboard Shift+F12

Shortcuts
Aspects
Aspect Detail
Clean Enter the command to be executed when
you select 'Clean' from the script context
menu.
Execute Click on the drop-down arrow and select

Command as | the appropriate option:

. Batch File - Use this option to create a
shell script that is executed in a system
command window; environment
variables can be accessed by
commands in this script

c) Sparx Systems age 450
(c)S S 2019 P 45 of 421



User Guide - Visual Execution Analysis 20 January, 2020

. Process - Use this option to run a single
program - the command should specify
the path to the program, plus any
command line arguments; - if the path
or arguments contain spaces, surround
them with quotes - for example:
"c:\program files
(x86)\java\bin\javac.exe"

Default Defaults to the value entered for the

Directory Build script. If a value has not been set
for the Build script, browse for or type in
the default directory path in which the
Clean script process will run.

Parse Output = Click on the drop-down arrow and select
a method for automatically parsing the
compiler output.

If you select this option, output from the
script is logged in the System Output
window; Enterprise Architect parses the
output according to the syntax you
specify.

Remote Host = Type in the ID of the remote host system
and its port; for example, mypc01:7777.

If you set this property to
#SYSTEMHOST#, the script is sent to
the Windows Satellite Service when
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running on Windows, and the Linux
Satellite Service when running under
Wine. The service IDs and Ports are
defined in the 'Private Options - Services'
section of the Analyzer Scripts Editor.
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Test Scripts

These sections explain how to configure the 'Test' page of
an Analyzer Script for performing unit testing on your code.
Most users will apply this to NUnit and JUnit test scenarios.
Enterprise Architect accepts the output from these systems
and can automatically add to and manage each unit test case
history. To view the case history, you would select the test
case Class element and press Alt+2 > Testing.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Test > Test' page or

. Click on # - 1n the window Toolbar, select the Package in
which to create a new script, and select the '"Test > Test'

page

Ribbon Develop > Preferences > Analyzer > Edit
Analyzer Scripts

Execute > Tools > Analyzer

Analyzer Test
Context
Menu
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Keyboard Shift+F12
Shortcuts

Actions

Test Type the Test command or script in this
field. For example:

. NUnit - "C:\Program
Files\NUnit\bin\nunit-console.exe"
"bin\debug\Calculator.exe"

. JUnit - java junit.textui. Testrunner %N

The command listed in this field 1s
executed as 1f from the command prompt;
as a result, if the executable path or any
arguments contain spaces, they must be
surrounded 1n quotes.

If you include the string %N in your test
script it 1s replaced by the fully
namespace-qualified name of the
currently selected Class when the script 1s
executed.

Execute Click on the drop-down arrow and select
Command the appropriate option:

As . Batch File - Use this option to create a
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Default
Directory

Parse
Output

Remote Host

(c) Sparx Systems 2019

shell script that is executed in a system
command window; environment
variables can be accessed by
commands 1in this script

. Process - Use this option to run a single
program - the command should specify
the path to the program, plus any
command line arguments; 1f the path or
arguments contain spaces, surround the
path with quotes - for example:
"c:\program files
(x86)\java\bin\javac.exe"

Defaults to the value entered for the
Build script. If a value has not been set
for the Build script, browse for or type in
the default directory path in which the
Clean script process will run.

When a parser is selected, output of nUnit
and jUnit tests can be parsed, saved and
managed from the model; (Alt+2 >
Testing). Be aware that output is only
captured when a parser is selected.

Type 1n the ID of the remote host system
and its port; for example, mypc01:7777.

If you set this property to
#SYSTEMHOST#, the script is sent to
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the Windows Satellite Service when
running on Windows, and the Linux
Satellite Service when running under
Wine. The service IDs and Ports are
defined in the 'Private Options - Services'
section of the Analyzer Scripts Editor.

Build First Select to ensure that the Package is
compiled each time you run the test.
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Testpoints Output

The 'Testpoints' page of the Analyzer Script helps you to
configure the output of a Testpoint run.

By default the output 1s logged to the System Output
window, as in this example.

System Output v R

System Script  Testpoints 4 4
StockExchange!Exchange. Stock. GetStockCost

Hoard Resources unit cost is §23.51
StockExchange!Exchange. Account. Credit

Credit: purchased 132 of stock "Hoard Resources” (id: 4)

Credit: cost §-3036

Total Test Count: 10

Total Passes: 10

Total Failures: 0

Total Invalid constraints: 0

Total Test Points encountered in run: 10
Total Test Points not encountered in run: O

Total Test Points evaluated by Analyzer: 668

Simulation Events Breakpoints & Markers System Output | Execution Analyzer

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Test > Testpoints' page or

. Click on # - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Test >
Testpoints' page

Ribbon Develop > Preferences > Analyzer > Edit
Analyzer Scripts
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Execute > Tools > Analyzer

Keyboard Shift+F12
Shortcuts
Options
Option Description
Output You can select from two options:

. 'Screen' (the default) - The output is
directed to the '"Testpoints' tab of the
System Output window

. 'File' - The output is directed to file

Folder Click on the folder to use for Testpoint
log files.

Filename Enter the name to use for the Testpoint
log files.

Overwrite When this option is selected, the file

specified is overwritten each time a
Testpoint run is performed.
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Auto Number = When this option is selected, the
Testpoint output 1s composed of the
filename you specify and the number of
the Test run; each time you perform a
Test run the number 1s incremented.

Prefix trace When this option is selected, any trace

output with statements executed during the Testpoint
function run are prefixed with the current function
call.
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Debug Script

The process of configuring the Debug section of an
Analyzer Script 1s usually a one-time affair that rarely has to
be revisited. So once you have your script working, you
probably won't have to think about i1t again. The details you
provide are not complicated, yet defining a script provides
access to a great many benefits such as:

. Debugging

. Sequence diagram recording

. Executable StateMachine execution and simulation

. Test domain authoring and recording

. Behavioral profiling of processes on a variety of runtimes

All you need to do is select the appropriate platform and
enter some basic details. The debugger platforms you can
use include:

. Java

. Java Debug Wire Protocol (JDWP)

. Microsoft NET Debugger

. Microsoft Native Code Debugger (C++, C, VB)
. Mono

. The PHP Debugger

. The GNU Debugger (GDB)

Access
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Ribbon Develop > Preferences > Analyzer > Edit
Analyzer Scripts

Execute > Tools > Analyzer

Keyboard Fo6
Shortcuts

Notes

. An Analyzer script is not necessary for debugging
Enterprise Architect model scripts such as JavaScript or
VBScript
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Operating System Specific
Requirements

The Enterprise Architect debugger is able to operate on a
number of different platforms. This table describes the
individual requirements for debugging on each platform.

Platforms

Platform Detail

Microsoft . Microsoft™ NET Frameworks 4.0, 3.5
NET and 2.0
. Language support: C, C#, C++, J#,
VB.NET

Java . Java SE Development Kit from
Oracle™ (version 5.0 minimum)
(either 32-bit or 64-bit JDK)

The Java Platform Debugger Architecture
(JPDA) was introduced in Java SE
version 5.0. The JPDA provides two
protocols for debugging; the Java Virtual
Machine Tools Interface (JVMTI), and
the Java Debug Wire Protocol (JDWP).

Enterprise Architect's debugger supports
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both protocols.
GNU Enterprise Architect supports debugging
Debugger using the GNU Debugger, which enables
(GDB) you to debug your applications under

Linux either locally or remotely.
Requires GDB version 7.0 or higher.

The source code file path must not
contain spaces.

Windows for = Enterprise Architect supports debugging

Native native code (C, C++ and Visual Basic)

Applications = compiled with the Microsoft™ compiler
where an associated PDB file is available.

PHP Enterprise Architect enables you to
perform local and remote debugging of
PHP scripts in web servers.

Requires web server to be configured to
support PHP.

Requires PHP to be configured to support
XDebug PHP (3rd party PHP extension).

Notes

e The debugging facility is available in all editions of
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Enterprise Architect

e Debugging under Windows Vista (x64) - if you encounter
problems debugging with Enterprise Architect on a 64-bit
platform, you should build a platform specific
configuration in Visual Studio; that is, do not specify the
AnyCPU configuration, specify either Win32 or x64
explicitly
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UAC-Enabled Operating Systems

The Microsoft operating systems Windows Vista and
Windows 7 provide User Account Control (UAC) to
manage security for applications.

The Enterprise Architect Visual Execution Analyzer is
UAC-compliant, and users of UAC-enabled systems can
perform operations with the Visual Execution Analyzer and
related facilities under accounts that are members of only
the Users group.

However, when attaching to processes running as services
on a UAC-enabled operating system, it might be necessary
to log in as an Administrator.

Log in as Administrator

Ste | Action
p

1 | Before you run Enterprise Architect, right-click on
the Enterprise Architect icon on the desktop and
select the 'Run as administrator' option.

Alternatively
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Edit or create a link to Enterprise Architect and configure
the link to run as an Administrator.

Ste | Action
p

1 | Right-click on the Enterprise Architect icon and
select the 'Properties' option.

The Enterprise Architect 'Properties' dialog displays.

2 | Click on the Advanced button.
The 'Advanced Properties' dialog displays.

3 Select the 'Run as administrator' checkbox.

4 | Click on the OK button, and again on the 'Enterprise
Architect Properties' dialog.
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WINE Debugging

Configure Enterprise Architect to debug
under WINE

Ste Action
p

1 | Atthe command line, run $ winecfg.

2 | Select the 'Applications' tab. Add the Enterprise
Architect executable 'EA.exe' from the Enterprise
Architect installations folder. Then add these
programs from the VEA sub directories:

. SSampler32.exe
. SSampler64.exe
. SSProfiler32.exe
. SSProfiler64.exe

3 | Select each program in turn, then switch to the
'Libraries' tab. Ensure these values are listed with a
(native, built-in) precedence:

. dbghelp
. msxml4
. msxml6
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4 | Copy the application source code plus executable(s)
to your bottle.

The path must be the same as the compiled version;
that is:

If Windows source = C:\Source\SampleApp, under
Crossover 1t must be C:\Source\SampleApp.

5 | Copy any Side-By-Side assemblies that are used by
the application.

Permissions

An 1installation of Enterprise Architect contains some native
Linux programs that provide building and debugging
services to Enterprise Architect under Wine. These
programs need to checked using the Linux file system or
shell to ensure they have the 'Execute' permission set
appropriately. The programs are located in the
"VEA/x86/linux" subdirectory of the Enterprise Architect
installation.

Access Violation Exceptions

Due to the manner in which WINE handles direct drawing
and access to DIB data, an additional option is provided on
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the drop-down menu on the Debug window toolbar to
ignore or process access violation exceptions thrown when
your program directly accesses DIB data.

Select this option to catch genuine (unexpected) access
violations; deselect it to ignore expected violations.

As the debugger cannot distinguish between expected and
unexpected violations, you might have to use trial and error
to capture and inspect genuine program crashes.

Notes

. If WINE crashes, the back traces might not be correct

. If you are using MFC remember to copy the debug
side-by-side assemblies to the C:\window\winsxs
directory

. To add a windows path to WINE, modify the Registry
entry:
HKEY LOCAL_ MACHINE\System\CurrentControlSet\
Control\Session Manager\Environment
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Java

This section describes how to set up Enterprise Architect for
debugging Java applications and Web Servers.
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General Setup for Java

The general setup for debugging Java Applications supports
two options:

. Debug an Application
. Attach to an application that is running

Option 1 - Debug an Application

Field Action
Debugger Select Java.

x64 Select this checkbox 1f you are debugging
a 64-bit application.

Deselect the checkbox if you are
debugging a 32-bit application.

Mode Select Run.

Default This path 1s added to the class path

Directory property when the Java Virtual Machine
is created.

Application  Identify the fully qualified Class name to
Class debug; the Class must have a method
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Command
Line
Arguments

Java Virtual

Machine
Options

(c) Sparx Systems 2019

declared with this signature:
public static void main(String());

Application Class samples. Collector

Command Line "param1” param2 "param3” param4
Arguments:

Specify any parameters to be passed to
the main method of the Application
Class.

Parameters containing spaces should be
surrounded with double quotes.

Specify command line options for Virtual
Machine creation.

You also must provide a parameter (JRE)
as the path to be searched for the jvm.dll;
this 1s the DLL supplied as part of the
Java runtime environment or Java JDK
from Sun Microsystems™,

The JRE parameter can be either:

. An Enterprise Architect-defined Local
Path

. An absolute file path (with no double
quotes) to the installation folder of the
Java JDK to be used for debugging

The JRE parameter must point to the
installation folder for the Java JDK. A
JDK installation is necessary for
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debugging to succeed. The JRE should
not point to the installation of the public
Java Runtime Environment, if that 1s
installed. Environment variables can be
used when specifying the VM startup
options, such as classpath.

For example, using:

. An Enterprise Architect Local Path
JAVA and an environment variable
classpath:

Java Virtual Machine Options:
JRE=%:]AVA%:, Diava.dass. path="%dasspath%%;.;

. Or an absolute path to the JDK
installation directory and an
environment variable classpath:

Java Virtual Machine Options:
JRE=C:'Program Files (x36)Javatjdk 1. 7.0,-Djava. dass. path=%casspath %s; .}

In these two examples, the debugger will
create a virtual machine using the JDK
located at the value of the JRE parameter.

If no classpath is specified, the debugger
always creates the virtual machine with a
class path property equal to any path
contained in the environment variable
plus the path entered in the default
working directory of this script.

If source files and .class files are located
under different directory trees, the
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classpath property MUST include both
root path(s) to the source and root path(s)
to binary class files.

Option 2 - Attach to Virtual Machine

There 1is very little to specify when attaching to a VM;
however, the VM must have the Sparx Systems debugging
agent loaded.

Field Action

Debugger Select Java

Mode Select Attach to Virtual Machine
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Advanced Techniques

In addition to the standard Java debugging techniques, you
can:

. Attach to Virtual Machine
. Internet Browser Java Applets
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Attach to Virtual Machine

You can debug a Java application by attaching to a process
that 1s hosting a Java Virtual Machine; you might want to do
this for attaching to a webserver such as Tomcat or JBOSS.

The Java Virtual Machine Tools Interface from Sun
Microsystems is the API used by Enterprise Architect; it
allows a debugging agent to be specified when the JVM is
created.

To debug a running JVM from Enterprise Architect, the
Sparx Systems' debugging agent must have been specified
as a startup option to the JVM when it was started; how this
is accomplished for products such as Tomcat and JBOSS
should be provided by that product's own documentation.

For java.exe, the command line option to load the Enterprise
Architect debugging agent could be (depending on your
environment):

. -agentpath:"c:\program files\sparx
systems\ea\VEA\x86\SSJavaProfiler32"

. -agentpath:"c:\program files (x86)\sparx
systems\ea\VEA\x86\SSJavaProfiler32"

. -agentpath:"c:\program files (x86)\sparx
systems\ea\VEA\x64\SSJavaProfiler64"

The appropriate option will depend on your operating
system and whether you are working on a 32-bit application
or a 64-bit application.

Alternatively, if you add the appropriate VEA directory to
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your PATH environment variable you can choose to use:
. -agentlib:SSJavaProfiler32

. -agentlib:SSJavaProfiler64

It 1s not necessary to configure an Analyzer Script when you
attach to a Virtual Machine; you can just use the Attach
button on one of the Analyzer toolbars.

If you configure an Analyzer Script, there are only two
things that must be selected:

. Select 'Java' as the debugging platform
. Choose the 'Attach to Virtual Machine' option
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Internet Browser Java Applets

This topic describes the configuration requirements and
procedure for debugging Java Applets running in a browser
from Enterprise Architect.

Attach to the browser process hosting the
Java Virtual Machine (JVM) from Enterprise
Architect

Ste Action
P

1 | Ensure binaries for the applet code to be debugged
have been built with debug information.

2 Configure the JVM using the Java Control Panel.

3 | Inthe 'Java Applet Runtime Settings' panel, click on
the View button.

4 | On the 1nstalled version to use, include one of these
options in the 'Runtime Parameters' field, depending
on your environment and whether you are working
on a 32-bit application or a 64-bit application:

-agentpath:"c:\program files\sparx
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systems\ea\VEA\x86\SSJavaProfiler32"

-agentpath:"c:\program files (x86)\sparx
systems\ea\VEA\x86\SSJavaProfiler32"

-agentpath:"c:\program files (x86)\sparx
systems\ea\VEA\x64\SSJavaProfiler64"
5 | In this field add the required Class paths.
At least one of these paths should include the root
path of the source files to use in debugging.
6 | Set breakpoints.

7 | Launch the browser.

8 | Attach to the browser process from Enterprise
Architect.

(c) Sparx Systems 2019 Page 74 of 421



User Guide - Visual Execution Analysis 20 January, 2020

Working with Java Web Servers

If you are debugging Java web servers such as JBOSS and
Apache Tomcat (both Server configuration and Windows
Service configuration) in Enterprise Architect, apply these
configuration requirements and procedures.

Note: The debug and record features of the Visual
Execution Analyzer are not supported for the Java server
platform 'Weblogic' from Oracle.

Attach to process hosting the Java Virtual
Machine from Enterprise Architect

Ste | Action
P

1 Build binaries for the web server code to be
debugged, with debug information.

2 | Launch the server with the '"Virtual Machine startup'
option, described in Server Configuration.

3 | Import source code into the Enterprise Architect
Model, or synchronize existing code.

4 | Set breakpoints.

(c) Sparx Systems 2019 Page 75 of 421



User Guide - Visual Execution Analysis 20 January, 2020

5 | Launch the client.

6 | Attach to the process from Enterprise Architect.

Server Configuration

The configuration necessary for the web servers to interact
with Enterprise Architect must address these two essential
points:

. Any VM to be debugged, created or hosted by the server
must have the Sparx Systems Agent command line option
specified or in the VM startup option (that is:

-agentlib:SSJavaProfiler32 or
-agentlib:SSJavaProfiler64)

. The CLASSPATH, however it is passed to the VM, must
specify the root path to the Package source files

The Enterprise Architect debugger uses the java.class.path
property in the VM being debugged, to locate the source file
corresponding to a breakpoint occurring in a Class during
execution; for example, a Class to be debugged 1s called:

a.b.C
This 1s located 1n physical directory:
C:\source\a\b

So, for debugging to be successful, the CLASSPATH must
contain the root path:
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c:\source

Analyzer Script Configuration

Using the 'Debug' tab of the 'Build Script' dialog, create a
script for the code you have imported and:

. Select the 'Attach to process' radio button and, in the field
below it, type 'attach’

. In the 'Use Debugger' field, click on the drop-down arrow
and select 'Java'

All other fields are unimportant; the 'Directory’' field is
normally used in the absence of any Class path property.

Run the Debugger

The breakpoints could show a question mark. In this case
the Class might not have been loaded yet by the VM. If the
question mark remains even after you are sure the Class
containing the breakpoint has been loaded, then either:

. The binaries being executed by the server are not based on
the source code

. The debugger cannot reconcile the breakpoint to a source
file (check Class paths), or

. The JVM has not loaded the Sparx Systems agent
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Ste Action
P
1 | Run the server and check that the server process has

loaded the Sparx Systems Agent:
DLL SSJavaProfiler32.DLL or SSJavaProfiler64

Use 'Process Explorer' or similar tools to prove that
the server process has loaded the agent.

In Enterprise Architect, open the source code and set
some breakpoints.

Click on the Run Debug button in Enterprise
Architect.

The 'Attach To Process' dialog displays.
Select the server process hosting the application.

Click on the OK button.

A confirmation message displays in the Debug
window, stating that the process has been attached.
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JBOSS Server

In this JBoss example, for a 32-bit application, the source
code for a simple servlet is located in the directory location:

C:\Benchmark\Java\JBOSS\Inventory

The binaries executed by JBOSS are located in the
JAW .EAR file 1n this location:

C:\JBOSS\03b-dao\build\distribution

The Enterprise Architect debugger has to be able to locate
source files during debugging; to do this it also uses the
CLASSPATH, searching in any listed path for a matching
JAVA source file, so the CLASSPATH must include a path
to the root of the Package for Enterprise Architect to find
the source during debugging.

This 1s an excerpt from the command file that executes the
JBOSS server; the Class to be debugged is at:

com/inventory/dto/carDTO

Therefore, the root of this path is included in the
JBOSS CLASSPATH.

Example Code

RUN.BAT
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set SOURCE=C:\Benchmark\Java\JBOSS\Inventory
set JAVAC JAR=%JAVA HOME%\lib\tools.jar

if "%JBOSS CLASSPATH%" ==""

(

set
JBOSS CLASSPATH=%SOURCE%;%JAVAC JAR%;%
RUNJAR%;

)

else

(

set
JBOSS CLASSPATH=%SOURCE%;%JBOSS CLASSPA
TH%;%JAVAC JAR%;%RUNJAR%;

)
set JAVA_ OPTS=%JAVA_ OPTS% -agentpath:"c:\program
files\sparx systems\vea\x86\ssjavaprofiler32"
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The Apache Tomcat Server can be configured for debugging
using the Java debugger in Enterprise Architect. This
example shows the configuration dialog for Apache Tomcat

7.0 on a PC running Windows 7.

‘g. Apache Tomcat 7.0 Tomecat? Properties Iﬁ

| General I Log On | Logging | Java |513r11.|p | Shutdown

[ Use default
Java Virtual Machine:

Java Classpath:
C:\Tomcatwebappsiserviet\WEB-INF\src; C: \Tomcat\bintbootstrap.jar; C

Java Options:

C:\Program Files (x36)Javayjdk1. 7.0_04rebinidientjvm.dl D

-Dijava.util.logging.manager=arg. apache. juli. ClassLoaderLogManage -«
Dijava.util.logging file=C:Tomcat\confYogaing.
e a3 5 M d 4

Initial memory poal: ME
Maximum memary pool; ME
Thread stack size: KB
[ QK ] [ Cancel ] [ Apply

These three points are important:

. The 'Java Virtual Machine' specifies the runtime from an

installation of the Java JDK

. The source path to any servlet to be debugged 1s added to
Java Classpath; in this case we add the path to the Tomcat

servlet:

c:\tomcat\webapps\servlet\ WEB-INF\src

. The 'Java Options' include the path to the Sparx Systems

debugging agent:
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-agentpath:c:\program files (x86)\sparx
systems\vea\x86\ssjavaprofiler32
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Apache Tomcat Windows Service

Configuration

For users running Apache Tomcat as a Windows™ service,
it 1s important to configure the service to enable interaction
with the Desktop; failure to do so causes debugging to fail

within Enterprise Architect.

Log on as:

@ Local System account
Allow service to interact with desktop

Select the 'Allow service to interact with desktop' checkbox.
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NET

This section describes how to configure Enterprise Architect
for debugging .NET applications. It includes:

. General Set up for .NET

. Debugging an Unmanaged Application
. Debug COM Interop

. Debug ASP .NET
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General Set up for .NET

This is the general set up for debugging Microsoft NET
applications. You have two options when debugging:

. Debug an application
. Attach to an application that is running

Option 1 - Debug an application

Field Action

Debugger Select Microsoft .NET as the debugging
platform.

x64 Select this checkbox if you are debugging
a 64-bit application.

Deselect the checkbox if you are
debugging a 32-bit application.

Mode Select the Run radio button.

Default This is set as the default directory for the
Directory process being debugged.

Application Select and enter either the full or the
Path relative path to the application
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executable.

. If the path contains spaces, specify the
full path; do not use a relative path

. If the path contains spaces, the path
must be enclosed by quotes

Command Parameters to pass to the application at

Line start up.

Arguments

Show Create a console window for the

Console debugger; not applicable to attaching to a
process.

Symbol Specify any additional paths to locate

Search Paths | debug symbols for the debugger; separate
the paths with a semi-colon.

Option 2 - Attach to an application that is
running

Field Action

Debugger Select Microsoft .NET as the debugging
platform.
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x64 Select this checkbox if you are debugging
a 64-bit application.

Deselect the checkbox if you are
debugging a 32-bit application.

Mode Select the Attach to Process radio button.
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Debugging an Unmanaged Application

If you are debugging managed code using an unmanaged
application, the debugger might fail to detect the correct
version of the Common Language Runtime (CLR) to load.

You should specify a config file if you don’t already have
one for the debug application specified in the Debug
command of your script.

The config file should reside in the same directory as your
application, and take the format:

name.exe.config
where 'name' is the name of your application.

The version of the CLR you specify should match the
version loaded by the managed code invoked by the
debuggee.

This is a sample config file:

<configuration>
<startup>
. < < _n . "
<requiredRuntime version="version "/>
</startup>

</configuration>

'Version' 1s the version of the CLR targeted by your plug-in
or COM code.

(c) Sparx Systems 2019 Page 88 of 421



User Guide - Visual Execution Analysis 20 January, 2020

Debug COM Interop

Enterprise Architect enables you to debug .NET managed
code executed using COM i1n either a Local or an In-Process
server.

This feature is useful for debugging Plug-ins and ActiveX
components.

Debug .NET Managed Code Executed Using
cCoOM

Ste Action
p

1 | Create a Package in Enterprise Architect and import
the code to debug.

2 | Ensure the COM component is built with debug
information.

3 | Create a Script for the Package.

4 | In the 'Debug | Platform' page, you can select to
either attach to an unmanaged process or specify the
path to an unmanaged application to call your
managed code.
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5 | Add breakpoints in the source code to debug.

Attach to an Unmanaged Process

If you are using:
. An In-Process COM server, attach to the client process
. A Local COM Server, attach to the server process

Click on the Debug window Run button (or press F6) to
display a list of processes from which you can choose.

Notes

. Detaching from a COM interop process you have been
debugging terminates the process; this is a known issue

for Microsoft .NET Framework, and information on it can
be found on many of the MSDN .NET blogs
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Debug ASP .NET

Debugging for web services such as ASP requires that the
Enterprise Architect debugger is able to attach to a running
service.

Begin by ensuring that the directory containing the ASP
NET service project has been imported into Enterprise
Architect and, if required, the web folder containing the
client web pages.

If your web project directory resides under the website
hosting directory, you can import from the root and include
both ASP code and web pages at the same time.

It 1s necessary to launch the client first, as the ASP .NET
service process might not already be running; load the client
using your browser - this ensures that the web server 1s
running.

In the debug set up you would then select the 'Attach' radio
button. When this choice is selected, the debugger will
prompt you each time for the process to debug.

Click on the Debug window Run button to start the
debugger; the 'Attach To Process' dialog displays.

The name of the process varies across Microsoft operating
systems, as explained in the ASP .NET SDK; for example,
under Windows Vista the name of the IIS process is
w3wp.exe.

On Windows XP, the name of the process resembles
aspnet wp.exe, although the name could reflect the version
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of the .NET framework that it 1s supporting.

There can be multiple ASP.NET processes running under
XP; you must ensure that you attach to the correct version,
which would be the one hosting the .NET framework
version that your application runs on; check the web.config
file for your web service to verify the version of .NET
framework it is tied to.

The Debug window Stop button should be enabled and any
breakpoints should be red, indicating they have been bound.

You can set breakpoints at any time in the web server code.
You can also set breakpoints in the ASP web page(s) if you
imported them.

Notes

Some breakpoints might not have bound successfully, but if
none at all are bound (indicated by being dark red with
question marks) something has gone out of synchrony; try
rebuilding and re-importing source code
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The Mono Debugger

Mono i1s a software platform sponsored by the .NET
Foundation to facilitate cross-platform development. It is
popular with game developers for its rich gaming API-based
and portability features.

Enterprise Architect provides support to the Mono
community by providing a modern environment for both
modeling and developing software. Existing Projects can be
imported, built and debugged natively on Linux as well as
on Windows.

Overview

Debugging under Mono involves the cooperation of three
processes. The Mono runtime manages the application and
communicates using a socket protocol with the Enterprise
Architect debugger, which in turn communicates with
Enterprise Architect acting as the front end. When you
launch Mono you need to direct it to support debugging.
This 1s achieved through a command line directive in which
you name the host and Port number that Mono should listen
on. The host can be omitted, in which case Mono will accept
connections from any IP address. The host can have the
value 'localhost' to restrict connections to the same machine.
The Port number is a number of your choosing.

The host and Port number are the import pieces of
information, as they are used when configuring the Analyzer
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Script.

Requirements for Windows

. Enterprise Architect (version 14 minimum)
. Mono for Windows (version 5.4 minimum)

Requirements for Linux

. Enterprise Architect (version 14 minimum)
. Mono for Linux (version 5.4 minimum)
. Wine for Linux

Debugger Configuration (Windows)

This section describes the Debug Section of an Analyzer
Script in respect to debugging Mono under Windows.
Fields that are not listed here are not required.

Field Description

Debugger Select 'Mono'.

x64 Select if the program to be debugged is a
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Run or
Attach

Default
Directory

Application
Path

Command
Line
Arguments

64bit executable.

Choose 'Run' to name the program to
launch. Choose 'Attach’ if you will
always attach to a running process.

The default directory that the program
will take when it is run.

The full path of the Mono application.
Any parameters to pass to the program.

Surround the parameters in double quotes
if they contain spaces.

Debugger Configuration (Linux)

This section describes the Debug Section of an Analyzer
Script in respect to debugging Mono under Linux. Fields
that are not listed here are not required.

Debugger

Default

(c) Sparx Systems 2019

Select 'Mono'.

This is the fully qualified native Linux
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Directory path where the application is located.

Connection . port: the debugging port

. host: the name or 1p address of the
machine where mono runs ('localhost'
if the machine is the same)

. localpath: the Wine / Windows root
path of the source code

. remotepath: the native Linux root path
of the source code

. shutdown: (true or false); when true the
VM is terminated when the debugger is
stopped

. timeout: the timeout in milliseconds for
socket calls

. output: the Wine / Windows path of the
log file to write to

. logging: (true or false); when true,
extra messages are logged in the Debug
window and socket messages are
logged to the specified output file

The DebugRun Page

This page is optional and is only useful where Mono and

(c) Sparx Systems 2019 Page 96 of 421



User Guide - Visual Execution Analysis 20 January, 2020

Enterprise Architect will be running on the same machine.
What it provides 1s the ability to run Mono first with the
required debugging directives, before the Enterprise
Architect debugger is started. After the debugger connects,
it resumes the Mono runtime, which has been started as
suspended. If the application runs on a different machine
from the Enterprise Architect you are using, you should
clear this section.

Starting Mono with Debugger Support using
an Analzyer Script

You can configure Enterprise Architect to start Mono for
you when you start the debugger. You do this by
configuring the 'DebugRun' page of your Analyzer Script.
The format of the commands is described here:

Linux:

cd path-to-program

/usr/bin/mono --debug

--debugger-agent=transport=dt socket,address=host:port,ser
ver=y,suspend=y program

Windows:

cd path-to-program

mono --debug

--debugger-agent=transport=dt _socket,address=host:port,ser
ver=y,suspend=y program
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where:

- path-to-program is the directory path where the program is
located

- host 1s one of these:

. localhost

. an ip address

. anetworked machine name

- port 1s the Port for the socket and

- program 1s the name of the application (such as
MonoProgram.exe)

Starting Mono with Debugger Support from
the Command Line

You can start Mono manually from a console. Locate the
program in your file explorer, then open a console at that
location. The format of the command line 1s described here:

Linux:

/usr/bin/mono --debug
--debugger-agent=transport=dt_socket,address=host:port,ser
ver=y,suspend=y program

Windows:
mono --debug
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--debugger-agent=transport=dt socket,address=host:port,ser
ver=y,suspend=y program

where host 1s one of these:

. localhost

. an 1p address

. anetworked machine name

port is the Port for the socket and program is the name of
the application (for example, MonoProgram.exe).
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The PHP Debugger

The Enterprise Architect PHP Debugger enables you to
debug PHP.exe scripts. This section discusses basic set up
and the various debugging scenarios that are commonly
encountered; the scenarios concern themselves with the
mapping of file paths, which is critical to the success of a
remote debugging session.

. Script Setup

. Local Windows Machine (Apache Server)
. Local Windows Machine (PHP.exe)

. Remote Linux Machine (Apache Server)

. Remote Linux Machine (PHP.exe)

Setup and Scenarios

Scenario Details

Script Setup | An Analyzer Script is a basic requirement
for debugging in Enterprise Architect;
you create a script using the toolbar of the
Execution Analyzer.

Select PHP.XDebug as the debugging
platform; when you select this platform
the property page displays these
connection settings:
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. host - localhost - The adaptor that
Enterprise Architect listens on for
incoming connections from PHP

. localpath - % LOCAL% - Specifies the
local file path to be mapped to a remote
file path; this is a remote debugging
setting - for local debugging, clear the
value, the value 1s a placeholder and
you should edit it to fit your particular
scenario

. remotepath - %REMOTE% - Specifies
the remote file path that a local file
path is to be mapped to; this is a remote
debugging setting - for local
debugging, clear the value, the value is
a placeholder and you should edit it to
fit your particular scenario

. logging - Enter true or false to enable
logging of communication from
XDebug server

. output - names the file path on the
remote machine to be used with the
logging option; this file will always be

overwritten
Local In this situation, consider this
Machine configuration:
Apache . O/S: Windows7

Server
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. Network computer name: MyPC

. Network share MyShare mapped to
c:\myshare

. Source files in Enterprise Architect
have been imported from
c:\myshare\apache\myapp\scripts

. Apache document root is set to
//MyPC/MyShare/apache

In this scenario an Analyzer Script for the
connection parameters might be
configured as:

. host: localhost

. port: 9000

. localpath: c:\myshare\apache\

. remotepath: MyPC/MyShare/apache/

Local In this scenario an Analyzer Script for the

Machine connection parameters might be

PHP.EXE configured as shown, as file paths always
map to same physical path:

. host: localhost
. port: 9000

. localpath:

. remotepath:

Remote In this situation consider this
Linux configuration:
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Machine Local Machine:
Apache . O/S: Windows7
Server

. Source files in Enterprise Architect
have been imported from
c:\myshare\apache\myapp\scripts

Remote Machine:
. O/S: Linux

. Apache document root 1s set to
home/apache/htdocs

. Source files in Apache are located at
home/apache/htdocs/myapp/scripts

In this scenario an Analyzer Script for the
connection parameters might be
configured as:

. host: localhost

. port: 9000

. localpath: c:\myshare\apache\

. remotepath: home/apache/htdocs/

Remote In this situation consider this
Linux configuration:

Machine . Local Machine

PHP.exe . O/S: Windows7

. Source files in Enterprise Architect
have been imported from
c:\myshare\apache\myapp\scripts
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PHP Global
variables
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. Remote Machine
. O/S: Linux

. Source files in Apache located at
home/myapp/scripts

In this scenario an Analyzer Script for the
connection parameters might be
configured as:

. host: localhost

. port: 9000

. localpath: c:\myshare\apache\
. remotepath: home/

When you are at a breakpoint, you can
examine the values of PHP globals using
the Analyzer Watch window. To list
every global, type either 'globals' or
'superglobals' into the field. To show an
individual item, enter its name. This
image shows the value of the PHP
environment variable § SERVER being
displayed.

Watches v R X
$_SERVER ==
Variable Value Type Address
= & $_SERVER array[31] 00000001k | &

& $_SERVER[O] "127.0.0.1" string 00000001

@& $_SERVER[1] "keep-alive" string Ox0000001d

& $_SERVER[Z] "max-age=0" string Ox0000001e

& $_SERVER[3] -1~ string 0x0000001F

& $_SERVER[4] "Mozilla/3.0 (X11, Linuxx2&6_&4) AppleW string Ox00000020

& $_SERVER[3] “text/html, application/xhtml+xmlapplic  string Ox00000021

& $_SERVER[E] "gzip, deflate, sdch" string Ox00000022

& $_SERVER[T] "en-Us,en; q=0.8" string Ox00000023

& $_SERVER[2] "fusrflocalfsbin: fusrflocal/bin:fusrisbin:/ string Ox00000024

@& $_SERVER[Z] "waddress=Apache/2.4.7 (Ubuntu) Serv  string Ox00000025

[*) 4 _SERVER[10] "Apache/2.4.7 (Ubuntu)" string x00000026

& $_SERVER[11] "127.0.0.1" string 000000027

& $_SERVER[1Z] "127.0.0.1" string (00000028  |w
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PHP Debugger - System Requirements

This topic identifies the system requirements and operating
systems for the Enterprise Architect PHP debugger.

System Requirements:

. Enterprise Architect version 9
. PHP version 5.3 or above
. PHP zend extension XDebug 2.1 or above

. For web servers such as Apache, a server version that
supports the PHP version

Supported Operating Systems:

. Client (Enterprise Architect)

. Microsoft Windows XP and above
. Linux running Crossover Office

. Server (PHP)

. Microsoft Windows XP and above

. Linux
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PHP Debugger Checklist

This topic provides a troubleshooting guide for debugging
PHP scripts in Enterprise Architect.

Check Points

Check Point | Details

System . Apache HTTP Web Server version 2.2
Requirements ., PHP version 5.3 or above

. XDebug version 2.1.1

Enterprise . The model has an Analyzer Script
Architect configured to use the PHP XDebug
platform

. PHP source code has been imported
into the model (for recording and
testpoints)

. When the PHP XDebug platform is
selected from the 'Analyzer Script'
dialog, default runtime settings are
listed in the 'Connection' field:

localpath:%LOCAL%
remotepath:%REMOTE%
Either define local paths for these default
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PHP
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variables or edit the script to provide
actual paths.

For example: local source, remote source

localpath:c:\code
samples\vea\php\sample

remotepath:webserver/sample
'webserver' 1s a network or local share
'sample' is a folder below share

In order to debug PHP scripts in
Enterprise Architect, it is a requirement
that the PHP 1s configured properly to
load the XDebug extension.

Settings similar to these should be used:
. [xdebug]
. xdebug.extended info=1
. xdebug.idekey=ea
. xdebug.remote enable=1
. xdebug.remote handler=dbgp
. xdebug.remote autostart=1
. xdebug.remote host=X.X.X.X
. xdebug.remote port=9000
. xdebug.show local vars=1

The IP address X.X.X.X refers to and
should match the host specified in the
model Analyzer Script.

The IP address is the address XDebug
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connects with and the same address the
Enterprise Architect PHP agent listens
on.

Apache For debugging using Apache, these lines
should be present in the Apache
configuration file, httpd.conf:

LoadModule php5 module
"php home/phpSapache2 2.dI1"

AddHandler application/x-httpd-php
.php
PHPIniDir "php home"

The value "php home" is the PHP
installation path (the path where php.ini
and apache dlII exist).

Troubleshoot = To prevent both PHP and Apache
ing timeouts during a debugging session,
these settings might require modification.

The settings were used while developing
the PHP Debugging agent in Enterprise
Architect.

PHP File: php.ini
; Enterprise Architect prevents PHP

timeouts when debugging PHP
extensions

max_execution_time =0
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; Enterprise Architect prevents web
server timeouts when debugging PHP
extensions

max_input time = -1

; Enterprise Architect logs errors
display errors = On

; Enterprise Architect displays startup
errors

display startup errors = On

Apache File: httpd.conf

; Enterprise Architect prevents timeouts
while debugging php extensions

Timeout 60000
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The GNU Debugger (GDB)

When debugging your applications you can use the GNU
Debugger (GDB), which 1s portable and runs on Unix-like
systems such as Linux, as well as on Windows. The GDB
works for many programming languages including Ada,
Java, C, C++ and Objective-C. Using the GDB, you can
debug your applications either locally or remotely.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Debug > Platform' page  or

. Click on # - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Debug >
Platform' page

Ribbon Develop > Preferences > Analyzer > Edit
Analyzer Scripts

Execute > Tools > Analyzer

Context Browser window | Right-click on
Menu Package | Execution Analyzer
Keyboard Shift+F12

Shortcuts
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Set up the GNU Debugger

Task

Set up Script

Define
Connection
Settings

(c) Sparx Systems 2019

Details

An Analyzer Script is a basic requirement
for debugging in Enterprise Architect;
you create a script using the Execution
Analyzer toolbar.

On the 'Platform' page of the Execution
Analyzer Script Editor, in the 'Debugger’
field click on the drop-down arrow and
select 'GDB'.

The property panel displays a number of
connection settings for which you
provide values.

. path - <path> - The complete file path
of the GDB executable; you only
specify this if the GDB cannot be
found in the system path

. source - <path>, <path> - The path in
which the debugger will search for
source files, i1f they do not reside in the
executable directory

. remote - F - Set for remote debugging;
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otherwise leave blank

. port - <nnnnn> - The Port to connect to
on the remote server

. host - localhost - The host name to
connect to

. fetch - T - Set to retrieve the binary
from the remote system

. dumpgdb - <path> - The filename to
write the GDB output to

. 1nitpath - <path> - The complete file
path to the gbinit file

Notes

. A requirement of the GDB is that your source code file
path does not contain spaces; the debugger will not run
correctly with spaces in the file path
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The Android Debugger

If you are developing Java applications running on Android
devices or emulators, you can also debug them. The Local
and Remote machines can be on either a 32-bit platform or a
64-bit platform.

N\
Remote Machine ( K )
Local Machine
ExecutionEnvironment . .
Execution Environment

Android Debug e
«device»
Bridge (ADB,
e ( ) Android Emulator
J

System Requirements

On the Remote machine, this software 1s required:

. Android SDK, which includes the android debug bridge,
ADB (you need to be familiar with the SDK and its tools)
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. Java JDK (32 and 64 bit support)
. Port Forwarding software (3rd party)

On the Local machine, this software 1s required:

. Enterprise Architect Version 10 or higher

Analyzer Script Settings

Field/Button |Action

Debugger

Run

Default
Directory

Application
path

Command
Line

Arguments

Build first

(c) Sparx Systems 2019

Click on the drop-down arrow and select
Java (JDWP).

Click on this radio button.

Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.
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Show
console

Show
diagnostic
messages

Connection

Port

Host

Source
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Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

This is the application port,
forward-assigned using adb or other
means, through which Enterprise
Architect and the Android Virtual
Machine (VM) can communicate.

Host computer (defaults to localhost)

If Android is running on an emulator on a
device attached to a networked computer,
enter the network name here.

By default, debugging will attempt to
connect to the Port you specify on the
local machine.

This is the source equivalent of the
classpath setting in Java.

The root to each source tree should be
listed. If more than one is specified, they
should be separated by a semi-colon; that
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1S:
c:\myapp\src;c:\myserver\src

You must specify at least one root source
path.

When a breakpoint occurs the debugger
searches for the java source in each of the
source trees listed here.

Logging Enables logging additional information
from debugger

possible values: true,false,1,0,yes,no

Output Specifies the full name of the local log
file to be written.

The folder must exist or no log will be
created.

The log file typically contains a dump of
bytes sent between debugger and VM.

Platform If you are debugging Java running under

any android scenario, select Android.
For all other scenarios, select Java.
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Configure Ports for Debugging - Port
Forwarding (Local)

The debugger can only debug one VM at a time; it uses a
single Port for communication with the VM. The Port for
the application to be debugged can be assigned using ADB,
which is supplied with the Android SDK.

Before debugging, start the application once in the device.
When the app starts, discover its process identifier (pid):

adb jdwp
The last number listed 1s the pid of the last application
launched; note the pid and use it to allow the debugger to
connect to the VM:
. adb forward tcp:port jdwp:pid
- port = Port number listed in analyzer script
- pid = process 1d of the application on the device

Configure Ports for Debugging - Port
Forwarding (Remote)

To debug remotely, the same procedure should be followed
as for the local machine, but the communication requires
additional forwarding as the socket created using the adb
forward command will only listen on the local adapter. The
socket is bound to the localhost, and attempts to connect to
this Port will be met with 'connection refused' messages.
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In order to achieve remote debugging it is necessary to have
a proxy running on the remote machine that listens to all
incoming connections and forwards all traffic to the adb
Port; there are numerous software products available to do
this.

Remote debugging with Enterprise Architect will not work
unless you have configured a proxy Port forwarder.
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Java JDWP Debugger

Java provides two main debugging technologies: an
in-process agent-based system called the Java Virtual
Machine Tools Interface (JVMTI) and a socket-based
paradigm called the Java Debug Wire Protocol (JDWP). A
Java Virtual Machine can name either one of these but not
both, and the feature must be configured when the JVM 1is
started.

System Requirements

1. The Enterprise Architect JDWP debugger will only be
able to communicate with a JVM started with the 'JTDWP'
option. Here 1s an example of the command line option:

java
-agentlib:jdwp=transport=dt_socket,address=localhost:90
00,server=y,suspend=n -cp "c:\java\myapp;%classpath%"
demo.myApp "paraml" "param?2"

2. The Virtual Machine should not be currently attached to a
debugger.

3. It 1s not possible for a VM to be debugged by Enterprise
Architect and Eclipse at the same time.

Analyzer Script Settings
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Field/Button | Action

Debugger Click on the drop-down arrow and select
Java (JDWP).
Run Click on this radio button to run the

debugger when the script is executed.

Default Not applicable - leave blank.
Directory

Application  Not applicable - leave blank.
path

Command Not applicable - leave blank.
Line

Arguments

Build first Not applicable - leave blank.

Show Not applicable - leave blank.
console

Show Not applicable - leave blank.
diagnostic

messages

Connection Not applicable - leave blank.
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Port Set the application Port forward-assigned
to the VM process during start-up, in the
Java command-line options.

Host Set the host computer (defaults to
localhost)

If VM is running on a networked
computer, enter the network name or url
here.

By default debugging will attempt to
connect to the Port you specify on the
local machine.

Source This is the source equivalent of the
classpath setting in Java.

List the root to each source tree; specify
at least one root source path. If you
specify more than one, separate them
with a semi-colon; for example:

c:\myapp\src;c:\myserver\src

When a breakpoint occurs the debugger
searches for the Java source in each of the
source trees listed here.

Logging Enable or disable logging of additional
information from the debugger.

Possible values include:
. true
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. false
.1

. 0

. yes
. NO

Output Specify the full name of the local log file
to be written. If the folder does not
already exist, no log will be created.

The log file typically contains a dump of
bytes sent between the debugger and VM.

Platform Select Java.

Configure Ports for Debugging

The debugger can only debug one VM at a time; it uses a
single Port for communication with the VM. The Port for
the application to be debugged 1s assigned when the VM is
created.

Local Debugging

Where both Enterprise Architect and the Java VM are
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running on the same machine, you can perform local
debugging. It 1s necessary to launch the VM with the JDWP
transport enabled - see the documentation on Java Platform
Debugger Architecture (JPDA) at Oracle for the command
line option specifications. For example:

java
-agentlib:;jdwp=transport=dt socket,address=localhost:9000,
server=y,suspend=n -cp
"c:\samples\java\myapp;%classpath%" samples.MyApp
"paraml1" "param?2"

In this example the values for the Analyzer script would be
'host: localhost' and 'port:9000'.

Remote Debugging

Where Enterprise Architect is running on the local machine
and the Java VM is running on a remote machine, you can
perform remote debugging. It is necessary to launch the VM
with the JDWP transport enabled - see the documentation on
JPDA at Oracle for the command line option specifications.
Here 1s an example, where the remote computer has the
network name testmachinel :

java
-agentlib:;jdwp=transport=dt socket,address=9000,server=y,
suspend=n -cp "c:\samples\java\myapp;%classpath%"
samples.MyApp "param1" "param2"

Note the absence of a host name in the address. This means
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the VM will listen for a connection from any machine. In
this example the values for the Analyzer script would be
'host: testmachinel' and 'port: 9000'.
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Tracepoint Output

The Tracepoints page of the Analyzer Script enables you to
direct where the output from any Trace statements goes
during a debug session.

Access

On the Execution Analyzer window, either:
. Locate and double-click on the required script and select
the 'Debug > Tracepoints' page  or

. Click on ¥ - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Debug >
Tracepoints' page

Ribbon Develop > Preferences > Analyzer > Edit
Analyzer Scripts
Execute > Tools > Analyzer > select and
run script

Context Browser window | Right-click on

Menu Package | Execution Analyzer

Keyboard Shift+F12

Shortcuts
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Tracepoint properties

Field Detail

Output You can select from two options:

. 'Screen’' (the default) - The output is
directed to the Debug window

. 'File' - The output 1s directed to file

Folder Enter the folder to use for Trace
statement log files.

Filename Enter the name to use for the Trace
statement log files.

Overwrite If selected, the specified file is
overwritten each time a debug session is
started.

Auto Number  If selected, the Trace log file 1s composed
of the filename you specify and a
number.

Each time you start a debug session, the
number 1s incremented.

Prefix trace If selected, any Trace statements
output with executed during the debug session run are
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function prefixed with the current function call.
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Workbench Set Up

This topic describes the requirements for setting up the
Object Workbench on Java and Microsoft .NET.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Debug > Workbench' page  or

. Click on - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Debug >
Workbench' page

Ribbon Develop > Preferences > Analyzer > Edit
Analyzer Scripts

Execute > Tools > Analyzer

Keyboard Shift+F12
Shortcuts

Platforms

Platform Detail
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Platforms The Workbench supports these platforms:
Supported . Microsoft NET (version 2.0 or later)
. Java (JDK 1.4 or later)

Microsoft The .NET workbench requires an
NET assembly, which 1s used to create the
Workbench workbench items.

You specify the path to the assembly on
the 'Workbench' page of the Analyzer
Script.

There are two constraints in using the
NET workbench:

. Members defined as struct in managed
code are not supported

. Classes defined as internal are not
supported

Java The Java workbench uses the Virtual

Workbench Machine settings configured in the
Analyzer Script 'Debug' page to create
the JVM.
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Microsoft C++ and Native (C, VB)

You can debug native code only if there is a corresponding
PDB file for the executable. A PDB file 1s created as a result
of building the application.

The build should include full debug information and there
should be no optimizations set.

The script must specify two things to support debugging:
. The path to the executable
. Microsoft Native as the debugging platform
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General Set Up

This is the general set up for debugging Microsoft Native
Applications (C++, C, Visual Basic). You have two options
when debugging:

. Debug an application
. Attach to an application that is running

Option 1 - Debug an application

Field Action

Debugger Select Microsoft Native as the debugging
platform.

x64 Select this checkbox i1f you are debugging
a 64-bit application.

Deselect the checkbox 1f you are
debugging a 32-bit application.
Mode Select the Run radio button.

Default This is set as the default directory for the
Directory process being debugged.

Application Select and enter either the full or the
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Path relative path to the application
executable.

. If the path contains spaces, specify the
full path; do not use a relative path

. If the path contains spaces, the path
must be enclosed by quotes

Command Parameters to pass to the application at

Line start up.

Arguments

Show Create a console window for the

Console debugger; not applicable for attaching to
a process.

Symbol Specify any additional paths to locate

Search Paths | debug symbols for the debugger; separate
the paths with a semi-colon.

Option 2 - Attach to an application that is
running

Field Action

Debugger Select Microsoft Native as the debugging

(c) Sparx Systems 2019 Page 133 of 421



User Guide - Visual Execution Analysis 20 January, 2020

platform.

x64 Select this checkbox 1f you are debugging
a 64-bit application.

Deselect the checkbox if you are
debugging a 32-bit application.

Mode Select the Attach to Process radio button.

Symbol Specify any additional paths to locate
Search Paths | debug symbols for the debugger.

You could specify a symbol server here if
you prefer; separate the paths with a
semi-colon or comma.
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Debug Symbols

For applications built using Microsoft Platform SDK, Debug
Symbols are written to an application PDB file when the
application is built.

The Debugging Tools for Windows, an API used by the
Visual Execution Debugger, uses these symbols to present
meaningful information to Execution Analyzer controls.

These symbols can easily get out of date and cause aberrant
behavior - the debugger might highlight the wrong line of
code in the editor whilst at a breakpoint; it is therefore best
to ensure the application is built prior to any debugging or
recording session.

The debugger must inform the API how to reconcile
addresses 1n the image being debugged; it does this by
specifying a number of paths to the API that tell it where to
look for PDB files.

For system DLLs (kernel32, mfc90ud) for which no debug
symbols are found, the Call Stack shows some frames with
module names and addresses only.

You can supplement the symbols translated by passing
additional paths to the API; you pass additional symbol
paths in a semi-colon separated list in the 'Debug' tab.
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Code Miner Script

The Code Miner system uses a set of databases to provide
fast and comprehensive access to information derived from
existing source code. The Intelli-sense features of Enterprise
Architect's code editors and its search tools can make use of
the information mined from these databases.

Through the Code Miner script pages, you can specify
which Code Miner databases to use with a particular project
and you can create, update and add new databases to the
Code Miner library. The 'Services' page allows you to
specify a local Code Miner library, or that you wish to
access the library available through a Code Miner Service.

Different Code Miner details can be specified for each
Analyzer Script, so the Code Miner libraries that are used
are determined by the active Analyzer Script.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Code Miner' page or

. Click on # - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Code Miner'

page

Ribbon Execute > Tools > Analyzer, or
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Develop > Preferences > Analyzer > Edit
Analyzer Scripts

Keyboard Shift+F12
Shortcuts

Code Miner Service

A Code Miner Library can be used locally, or it can be
deployed to a server location where it can service multiple
clients. You select the scenario to use on the 'Code Miner
Service' page of the Analyzer Script.

Execution Analyzer: Intel |ava

=1 Build

- Build

i Clean

- Test

E----Test ..............................

Te StDDiI'ItS- ...........................

El- Debug

Platform Host : Port Macro

i DebugRun

E----Tracepoints Use Server 172.16.17.184:9001 #INTELHOST £

. Waorkbench

[ Code Miner

Service

. Libraries

[=)- Private Options
L Services

- Run

- Deploy

Code Miner Senvice:

Limit Query Results to: 200 rows

- Recording Code Miner databases provides support to Enterprise Architect intellisense, metrics and
- Simulation search tools. You can choose between a local library or server.

- Merge
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Code Miner Libraries

The Code Miner Database Libraries are a collection of
databases containing information derived from source code.
Together, these databases form the Code Miner Library used
by the Intelli-sense features of Enterprise Architect.

Usually, a library would be created for each framework or
project. The Code Miner Libraries page allows new
databases to be created, and existing databases to be added,
updated or removed from a library.

Code Miner Query Libraries are a collection of functions,
written in Code Miner's mFQL language, bundled together
into one source file.

The Code Miner Database Library and Query Library for a
given Analyzer Script are specified on the 'Code Miner |
Libraries' page of the Script Editor.
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El- Build

Build

+ Warkbench
Bl Code Miner

- Senvice

- Libraries

[=)- Private Options
L Services

- Run

- Deploy

- Recording

- Simulation

- Merge

Code Miner Database Library

Library Path Language
E\java\jdk-1.28.0_91\java)DK.cdb Java
E'\cladonia-xst\exchanger.cdb Java
E\java\gwt-2.8.cdb Java

‘ .

Code Miner Query Library

New

Source Recursive
EVava\jdk-1.8.0_31\src\  True
E\cladonia-dst\exchan... True
E\java\gwt-2.8. 1\samples\ True

| e:\javahsparx-queries.qul

Help
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Services Script

The 'Services' page of an Analyzer Script describes the
default ports used when scripts are created by various Visual
Execution Analyzer functions (Import project, Generate
Executable StateMachine).

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Private Options | Services' page or

. Click on # - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Private
Options | Services' page

Ribbon Develop > Preferences > Analyzer > Edit
Analyzer Scripts

Execute > Tools > Analyzer

Keyboard Shift+F12
Shortcuts
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Run Script

This section describes how to create a command for running
your executable code.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Run' page or

. Click on ¥ - in the window Toolbar, select the Package in
which to create a new script, and select the 'Run' page

Ribbon Develop > Preferences > Analyzer > Edit
Analyzer Scripts

Execute > Tools > Analyzer

Keyboard Ctrl+Alt+N
Shortcuts

Script elements

Element Description
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Command This is the command that 1s executed
when you select the 'Execute > Run >
Start' ribbon option; at its simplest, the
script would contain the location and
name of the file to be run.

Examples These two examples show scripts
configured to run a .Net and a Java
application in Enterprise Architect.

Net:

C:\benchmark\cpp\example net I\release
\example.exe

Java:
customer

The command listed 1n this field 1s
executed as if from the command prompt;
as a result, if the executable path or any
arguments contain spaces, they must be
enclosed by quotes.

Notes

. Enterprise Architect provides the ability to start your
application normally OR with debugging from the same
script; the 'Analyzer' menu has separate options for
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starting a normal run and a debug run
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Deploy Script

These sections explain how to create a command script for
deploying the current Package. The script can be executed
by selecting the 'Execute > Source > Build > Deploy' ribbon
option or by pressing Ctrl+Shift+Alt+F12.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Deploy' page or

. Click on & - in the window Toolbar, select the Package in
which to create a new script, and select the 'Deploy' page

Ribbon Develop > Preferences > Analyzer > Edit

Analyzer Scripts
Execute > Tools > Analyzer

Keyboard Ctrl+Shift+Alt+F12
Shortcuts

Actions
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Action Detail

Execute Process

Command as:  [f the deployment is handled externally,
enter the path to the program or batch file
to run, followed by any parameters; the
program is launched in a separate
process.

Example:

C:\apache-ant-1.7.1\bin\ant.cmd
myproject deploy

Batch File

When using this option, you can enter
multiple commands that are then
executed as a single script in a command
console; you have access to any
environment variables available in a
standard command console.

Example:
@echo on

IF NOT EXIST "%1%" GOTO
DEPLOY NOWAR

IF "%APACHE HOME%" ==""
GOTO DEPLOY NOAPACHE

xcopy /L "%1%"
"0%APACHE HOME%\webapps"
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GOTO DEPLOY END

rem

rem NO WAR FILE

rem

:DEPLOY NOWAR

echo "%1% WAR file not found"
GOTO DEPLOY END

rem

rem NO APACHE ENVIRONMENT
VARIABLE

rem
:DEPLOY NOAPACHE

echo "APACHE HOME environment
variable not found"

:DEPLOY END
pause

Parse Output = Selecting a Parser from the list causes
output of the deploy script to be captured;
the output 1s parsed according to the
syntax selected from the list.

To display the System Output window,
select the 'Start > Desktop > Design >
System Output' ribbon option.
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Recording Scripts

The beauty of recording is not really that we always get to
see the bigger picture, but a chance to see a smaller picture
that has some truth to tell. We have all seen Sequence
diagrams that are less than helpful. (The same message
appearing 100 times in succession on a diagram does tell us
something, but not much.) Fortunately Enterprise Architect
takes care of this first point through the use of fragments.
Repeating behaviors are identified as Patterns and
represented once as a fragment on the Sequence diagram.
The fragment 1s labeled according to the number of
iterations. The recording history, of course, always shows
the entire history. We also need tools to help us focus the
recording on particular areas of interest and reduce the noise
from others. We can use filters to do this. With filters, you
can exclude any Classes, functions, or even modules from
any recording. You can create multiple sets of filters and use
them with marker sets to target different Use Cases.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Recording' page or

. Click on # - 1n the window Toolbar, select the Package in
which to create a new script, and select the 'Recording’

page
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Ribbon

Keyboard
Shortcuts

Filter Strings

Element

Filtering
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Develop > Preferences > Analyzer > Edit
Analyzer Scripts

Execute > Tools > Analyzer

Shift+F12

Discussion

If the 'Enable Filter' checkbox is selected
on the 'Recording' page of the Execution
Analyzer Script Editor, the debugger
excludes calls to matching methods from
the recording. The comparison is
case-sensitive.

To add a value, click on the 'New'
('Insert') icon in the right corner of the
'Exclusion Filters' box, and type in the
comparison string; each filter string takes
the form:

class name token::method name token
The class name token excludes calls to
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Example

(c) Sparx Systems 2019

all methods of a Class or Classes that
have a name matching the token; the
string can contain the wildcard character
* (asterisk).

The method name_token excludes calls
to methods having a name that matches
the token; again, the string can contain
the wildcard character *.

Both tokens are optional; if no Class
token 1s present, the filter is applied only
to global or public functions (that 1s,
methods not belonging to any Class).

In this Java example, the debugger would
exclude:

. Calls to the OnDraw method for the

Class
Example.common.draw.DrawPane

. Calls to any method of any Class
having a name beginning with
Example.source.Collection

. Calls to any constructor for any Class
(such as <clint> and <init>)

Filters

Example.common, draw. DrawPane: :OnDraw
Example.saurce, Collection™
*init*

In this Native Code example, the
debugger would exclude:
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. Calls made to Standard Template
Library namespace

. Calls to any Class beginning with TOb
. Calls to any method of Class CLock

. Calls to the method GetLocation for
Class CTrain

. Calls to any Global or Public Function
with a name beginning with Get

Filters

std*

TOb*

Clock
CTrain::Getlocation
iGet™

Filters

Use Filter To Filter

Entry

:Get* All public functions having a name
beginning with 'Get' from the recording
session (for example, GetClientRect in
Windows API).

*.:Get* All methods beginning with 'Get' in any
Class.
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CClass::Get* | All methods beginning with Get for the
CClass Class.

CClass::* All methods for CClass Class.

ATL* All methods for Classes belonging to
std* Standard Template and Active Template
Libraries.

CClass::GetN | The specific method(s) GetName for the
ame CClass Class.
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Merge Script

A Merge command in an Analyzer Script gives users an
additional command to perform some action. The merge
action 1s dependent on your requirements.

Access

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Merge' page or

. Click on & - in the window Toolbar, select the Package in
which to create a new script, and select the 'Merge' page

Ribbon Develop > Preferences > Analyzer > Edit
Analyzer Scripts

Execute > Source > Merge

Keyboard Ctrl+Alt+M
Shortcuts
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Build Application

This topic explains how to execute a Build script on your
application, within Enterprise Architect.

Access

Ribbon Execute > Source > Build > Build

Keyboard Ctrl+Shift+F12

Shortcuts
Other 'Build' toolbar > &
Execution Analyzer window | &
Action

When you select the 'Build' option, it executes the 'Build'
command 1n the script selected in the Execution Analyzer
window. The progress and outcome of the build operation
are displayed in the 'Build' tab of the System Output
window.

You can quickly visit the line of code for any compilation
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error appearing by double-clicking the error.
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Locate Compiler Errors in Code

When you build an application using an Analyzer Script,
compiler output is logged in the System Output window.
You can double-click on any error message that appears
here and be taken to the source code. When you do, the
cursor 1s positioned on the line containing the error.

61
62 if{PeopleOFF > 8)
63 re turn PeopleOFF * 28;

B4
B5 return @;
B
Output
Fy| i

58| Running Analyzer Script - CityLoop

581 Microsoft (R) Visual Studio Version 10,0,30319.1.

76 Copyright (C) Microsoft Corp. All rights reserved.

12-mmee- Build started: Project: CityLoop, Configuration: Debug Win32 ------

72| 1= Train.cpp

y 241> cdata\wea\microsoft native\citylooptrain.cpp(63): error C2065: 're' : undeclared identifier

751 1=chdata\weahmicrosoft nativehcityloopitrain.cpp(83): error C2146: syntax error : missing ;' before identifier 'turn’
78] 1> c\data\wea\microsoft native\cityloop\train.cpp(63): error C2065: "turn’ : undeclared identifier

Tip

If output 1s missing, check that a language parser is
mentioned in the Analyzer Script (Shift+F12).

Parse Output: Java SDK -

Access

Start > Desktop > Design > System
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Ribbon Output

Keyboard Ctrl+Shift+8
Shortcuts
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Debugging

feature that you might expect in an IDE is also available.
Comprehensive debugging environments and tools for many
major platforms are provided. By integrating debugging
capability within the modeling tool allows code to be
developed, built and managed by its authors, working and
collaborating in an integrated model has made actions count
and every action accountable in ways that are just not
possible using other tool chains.

Features

Speed
Debuggers in Enterprise Architect are quick! Stepping
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through programs will not take all day.

The Recording program execution can be done without
manual stepping.

Support
. C++, C and Visual Basic

. Microsoft NET, ASP.NET WCF

. Java, using socket transport (JDWP) or in memory model
(JVMIT)

. Android on an emulator or device
. JavaSscript, VBScript and JScript
. PHP scripts on Apache web servers

. Remote Linux GDB processes using Enterprise Architect
on Windows

. Simulation - debug simulations in UML and BPMN

. Executable StateMachines - debug an executing
StateMachine

Isolation

The debuggers operate out of process from Enterprise
Architect, 1solating it from side effects.

Efficiency

Starting and stopping the debugger i1s quick and painless. It
does not hold you back. Designed to be a responsive UI, the
main UI thread 1s 1solated from duties that are not its
responsibility.

Productivity

Switch from modeling to requirements, from raising a
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change request to tracking code changes in a model shared
across an organization, to profiling recent code changes. All
in the one tool.

Notes

. The debug and record features of the Visual Execution
Analyzer are not supported for the Java server platform
'Weblogic' from Oracle
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Run the Debugger

Enterprise Architect provides a number of ways to start and
control a debug session. There 1s the main Debug window,
as well as a Debug toolbar and the 'Run' panel in the
'Execute’ ribbon. It is always best to display the Debug
window whenever you are running a debug session, as this
is where all debug output is captured.

Access

Ribbon

Keyboard
Shortcuts

Toolbar

Execute > Run > Start

Execute > Tools > Debugger > Start
Debugging

Alt+8 (displays the Debug window)

F6 (begins execution of the
application being debuggea)

Explore > Portals > Show Toolbar >
Debug

Using the Debug window
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Action

Start the
Debugger

Detail

When an Analyzer script has been
configured to support debugging, you can
start the debugger in these ways:

. From the ribbon, select 'Execute > Run

> Start > Run'

. From the ribbon, select 'Execute >

Tools > Debugger > Start Debugging'

. On the 'Debug' toolbar, click on the =

button, or

. Press F6

You can also launch the debugger for any
script through its context menu in the

'Analyzer Script Window', or press
Shift+F12

If you have no Analyzer Script, it 1s still
possible to debug a running application
by attaching to that process directly:

. From the ribbon, select 'Execute >

Tools > Debugger > Attach to Process',
or

. On the 'Debug' toolbar, click on the *#

(Attach) button and choose the
debugging platform manually

Pause/Resum = You can pause a debugging session, or
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e Debugging | resume the session after pausing, in these
ways:
. From the ribbon, select 'Execute > Run
> Pause'

. On the 'Debug' toolbar, click on the
button

Stop the To stop debugging, either:

Debugger . From the ribbon, select 'Execute > Run
> Stop'

. On the 'Debug' toolbar, click on the &
(Stop) button

. Press Ctrl+Alt+F6

The debugger normally ends when the
current debug process terminates;
however, some applications and services
(such as Java Virtual Machine) might
require the debugger to be manually

stopped.
Step Over To step over the next line of code:
Lines of . From the ribbon, select 'Execute > Run
Code > Step Over', or

. On the 'Debug' toolbar, click on the
(Step Over) button, or

. Press AIt+F6
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Step Into To step into a function call:
Function . From the ribbon, select 'Execute > Run
Calls > Step In', or

. On the 'Debug' toolbar, click on the Iz
(Step In) button, or

. Press Shift+F6

If no source is available for the target
function then the Debugger returns
immediately to the caller.

Step Out Of | To step out of a function:

Functions . From the ribbon, select 'Execute > Run
> Step Out'
. On the 'Debug' toolbar, click on the I*=
(Step Out) button, or

. Press Ctrl+F6

If the debugger steps out into a function
with no source code, it will continue to
step out until a point is found that has
source code.

Show While the Debugger is paused, to return
Execution to the source file and line of code that the
Point Debugger 1s about to execute:

. From the ribbon, select 'Execute > Run
> Start > Show Execution Point'

. On the 'Debug' toolbar, click on the ~
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Output

Save Output
(and Clear

Output)

(c) Sparx Systems 2019

(Show Execution Point) button.

The appropriate line 1s highlighted, with a
pink arrow 1n the left margin of the
screen.

During a debug session, messages display
in the Debug window detailing:

Startup of session
. Termination of session
. Exceptions
. Errors

. Trace messages, such as those output
using Java System.out or NET
System.Diagnostics.Debug

If you double-click on a debug message,

either:

. A pop-up displays with more complete
message text, or

. If there has been a memory leak, the
file 1s displayed at the point at which
the error occurred

You can save the entire contents of the
Debug output to an external .txt file, or
you can save selected lines from the
output to the Enterprise Architect
clipboard.

To save all of the output to file, click on
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the 18 (Save output to file) button.

To save selected lines to the clipboard,
right-click on the selection and select the
'Copy Selected to Clipboard' option.

When you have saved the output or
otherwise do not want to display it any
more, right-click on the current output
and select the 'Clear Results' option.

Switch to If you are running a debug session on
Profiler code, you can stop the debug session and
immediately switch to a Profiling session.

To switch from the Debugger to the
Profiler:

. From the ribbon, select 'Execute >
Tools > Debugger > Switch to Profiler’

. On the Debug window, click on the
' # | | Switch to Profiler' option, or

. On the Debug toolbar, click on the ' #
| Switch to Profiler' option

The Profiler attaches to the
currently-running process.

This facility is not available for the Java
debuggers.
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Breakpoint and Marker Management

Breakpoints work in Enterprise Architect in the same way as
in any other Debugger. Markers are similar to breakpoints,
but in Enterprise Architect they have special powers. Simply
put, markers perform actions - such as recording execution
and analysis - that breakpoints do not. The action of a
breakpoint 1s always to stop the program.

You set any marker or breakpoint in the Source Code editor,
where they are visible in the left margin. Clicking in this
margin will add a breakpoint at that line. Breakpoints and
markers are interchangeable - you can change a breakpoint
into a marker and vice versa, using its 'Properties' dialog.
You can quickly view and edit a breakpoint or marker's
properties using Ctrl+click either on its icon in the editor
margin or in the Breakpoints and Markers window.

Breakpoints are maintained in sets. There is a default set for
ecach model and each breakpoint typically resides there, but
you can save the current breakpoint configuration as a
named set, create a new set and switch between them.
Breakpoint sets are shared; that is, they are available to the
model community. The exception is the Default set which 1s
a private and personal set allocated to each user of any
model.

Access
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Ribbon Execute > Windows > Breakpoints

Simulate > Dynamic Simulation >
Breakpoints

Breakpoint and Marker Options

Option Detail

Delete a To delete a specific breakpoint:
breakpoint or |, If the breakpoint is enabled, click on
marker the red breakpoint circle in the left

margin of the Source Code Editor, or

. Right-click on the breakpoint or marker
1n the Source Code Editor, the
Breakpoints folder or the Breakpoints
& Markers window and select the
'Delete’ option, or

. Select the breakpoint in the 'Debug
Breakpoints' tab and press the Delete
key

Delete all Click on the Delete all breakpoints button
breakpoints ().
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Breakpoint
properties

Disable a
breakpoint

Enable a
breakpoint or
marker

Disable all
breakpoints

Enable all
breakpoints

Break when
memory

address 1s
modified

Identify or
change the

(c) Sparx Systems 2019
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In the Breakpoints window or code
editor, use the marker's context menu to
bring up the properties. Here you can
change the marker type, add or modify
constraints and enter trace statements.
(Useful shortcut: hold the Ctrl key while
clicking the marker, to quickly show its
properties.)

Deselect the checkbox against the
breakpoint or marker.

Select the checkbox against the
breakpoint or marker.

Click on the 2 button

Click on the Enable all breakpoints
button (1<),

Click on the Data breakpoint button ().

Check the peaut - field in the
Breakpoints & Events window toolbar.
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marker set

Change how
breakpoints
and markers
are grouped

If necessary, click on the drop down
arrow and select a different marker set.

The Default set 1s normally used for
debugging and is personal to your user
ID; other marker sets are shared between
all users within the model

The breakpoints and markers can be
grouped by Class or by code file. To
group the items, click on the down arrow
on the = - icon in the toolbar, and click

on the on the appropriate option. If you do not
Breakpoints = want to group the items, click on the
& Events selected option to deselect it; the
window breakpoints and markers are then listed
by line number.
Breakpoint States
State Remarks

(c) Sparx Systems 2019

Debug Running: Bound
Debug Not Running: Enabled

Debug Running: Disabled
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Debug Not Running: Disabled

Debug Running: Not bound - this usually
means that a module 1s yet to be loaded.
Also, dlls are unloaded from time to time.

Debug Not Running: N/a

Debug Running: Failed - this means the
debugger was unable to a match this line
of code to an instruction in any of the
loaded modules. Perhaps the source 1s
from another project or the project
configuration is out of date. Note, that if
the module date 1s earlier than the
breakpoint's source code date you will see
a notification in the debugger window.
The text 1s red in color so they will stand
out. This is clear sign that the project
requires building.

Debug Not Running.: N/a
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Setting Code Breakpoints

Normal Breakpoints are typically set on a line of source
code. When the Debugger hits the indicated line during
normal execution, the Debugger halts execution and
displays the local variables, call stack, threads and other
run-time information.

Set a breakpoint on a line of code

Ste Action
p

1 | Open the source code to debug in the integrated
source code editor.

2 Find the appropriate code line and click in the left
margin column - a solid red circle in the margin
indicates that a breakpoint has been set at that
position.

12 CTest::CTest (LPCTSTE name, TTestType type)

124
1}5 '_-JT m Name = name;

15 m Type = type;

la theTest = this;

If the code is currently halted at a breakpoint, that
point is indicated by a blue arrow next to the marker.
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& int tmain(int argc, _TCHAR* argv[])

{
L g8 CTest Test( T ("Model™), CTeszt::Regression):
g return Test.Run() ;

Alternatively, you can set the Breakpoint marker (or
other marker) by right-clicking on the left margin on
the required line, to display the breakpoint/marker
context menu; select the appropriate marker type.
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Trace Statements

A Trace Statement 1s a message that is output during
execution of a debug session. Trace statements can be
defined in Enterprise Architect without requiring any
changes to your application source code.

Tracepoint Markers are set in the code editor. Like
breakpoints, they are placed on a line of code. When that
line of code executes, the debugger evaluates the statement,
the result of which 1s logged to the Debug window (or to file
if overridden by the Analyzer script).

Access

Any existing Trace statements can be viewed and managed
in the Breakpoints & Markers window. The Breakpoints &
Markers window can be displayed using either of the
methods outlined here.

Ribbon Execute > Windows > Breakpoints

Add a Tracepoint Marker

Ste Action
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Open the source code to debug in the source code
editor.

Find the appropriate code line, right-click in the left
margin and select the 'Add Tracepoint Marker'
option.

If a marker 1s already there, press Ctrl+click to show
the Breakpoint Properties window.

Ensure the 'Trace statement' checkbox is selected.

In the text field under the '"Trace statement'
checkbox, type the required Trace statement.

Click on the OK button. A Tracepoint Marker is
shown in the left margin of the code editor.

55 DWORD CTrain::Disembark({int PeopleOFF)

56 |
o 57 if(Passengers - PeopleOFF > -1)
: 58 Passengers -= PeopleOFF;

59 else

o8 Passengers = @;

6l

62 if(PeopleQFF > @)

63 return PeocpleQFF * 28;

64

65 return &;

66 }

Specifying a Trace Statement

(c) Sparx Systems 2019
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A trace statement can be any freeform text. The value of any
variables currently in scope can also be included in a trace
statement by prefixing the variable name with a special
token.

The available tokens are:
. § - when the variable is to be interpreted as a string

. (@ - when the variable 1s a primitive type (int, double,
char)

Using our example in the image, we could output the
number of people getting off a train by using this statement:

There were @Passengers before @PeopleOFF got off the
train at $Arriving.Name Station

In addition to tracing the values of variables from your code,
you can use the $stack and $frame keywords in your Trace
statement to print the current stack trace; use:

. $stack - to print all frames, or

. $frame[start](count) - print a specific number of frames
from the stack starting at a given frame; for example,
$frame[0](5) will print the current frame and 4 ancestors

Notes

. Trace statements can be included on any type of
breakpoint or marker.
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Break When a Variable Changes Value

Data breakpoints can be set on a pre-determined memory
variable to cause the debugger to halt execution at the line
of code that has just caused the value of the variable to
change. This can be useful when trying to track down the
point at which a variable is modified during program
execution, especially if it 1s not clear how program
execution is affecting a particular object state.

Access

Ribbon Execute > Windows > Local Variables :
Right-click on variable > Break When
Variable 1s Modified or

Execute > Windows > Watches :
Right-click on variable > Break When
Variable 1s Modified

Other In a code editor window: Right-click on

the variable of interest | Break when item
modified

Capture changes to a variable using data
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breakpoints

Ste Detail
ps

1 | Set a normal breakpoint in the code so you can
choose a variable. Then run the debugger (F6).

2 | When the program has hit the breakpoint, select the
variable of interest and from its context menu, select
the 'Break When Variable is Modified' option.

Locals o ox
Yariable Value
24 this 0x008efel10
Iél--v CTrain
H-¢ TObject
®-¢ h_thread 00000000
- m_tid 2864
W4 Network 00012F78¢
®-¢ Arriving 05008 efdad
-4 Distance 0.000000
.. Capacity 500
g Mumbe Break When Vanable is Modified Ib
-4 Departi View Memory at Address
% Locatio  yiew in Editor
-4 Delay . .
¢ PeopleON Dump Variable Members to File
. Save Snapshot of Variable -

Compare Variable Snapshots
| Watches |3 Local P P

LR F U

3 | There are no breakpoint indicators in the code, but
data breakpoints are easily recognizable in the
Breakpoints & Events window, being a blue icon
with a white diamond. Enterprise Architect displays
the name of the variable and its address instead of a
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line number.

BrEEkpUiﬂtS & Markers PP b e e b e P e P B P B

@ @ 4 8 : [Defautt 8-8-@
Enabled Line Source

Q D0ZEBEE4  int Passengers (D0ZEBEE4)

» O 127 CHEANEATRIMNCode Samples ' VEAND

4 | With the data breakpoint set, you can disable any
other breakpoints you might have. The program will
stop at any line of code that changes this variable's
value. Now run your program.

5 | When this variable is modified, the debugger halts
and displays the current line of code in the editor.
This 1s not the line that caused the break, but the line
of code following the event. The event is logged to

the Debug window.
Dehug B R R s R s a s e sl
@ - b mlESzza o H @

[1650154916] Module loaded CAWindows\SysWOWEdole32.dll no symbols

[1650154916] Module loaded C:AWindowsh\SysWOWENSHCORE.dIl no symbaols

[1650205565] Data breakpeint hit at CTrain.Disemnbark, cea\ea73 0 code samples\vea\microsoft nativecityloop'
[1650270313]  Data breakpoint hit at CTrain.Embark, c\ea\ea730M code samples\vea\microsoft nativelcityloophtrai
[1650271852] Data breakpeint hit at CTrain.Disembark, c\ea\ea?30hcode samplesiveaimicrosoft native\cityloop'y
[1650272025] Data breakpoint hit at CTrain.Embark, chea\ea73 M code samples\vea\microsoft native\cityloophtrai
[1650273270] Data breakpoint hit at CTrain.Disembark, c\ea\ea?30"code samplesivea\microsoft native\cityloop'y
[1650273521]  Data breakpoint hit at CTrain.Embark, chea\ea730\code samplesi\vea\microsoft nativel\cityloop'trai
[16530274759]  Data breakpoint hit at CTrain.Disernbark, chea\ea73 M code samples\vea\microsoft nativelcityloop'
4

# Debug g Execution Analyzer

Now we know how and where this value (its State)
has changed. For example, the statement at line 58
has just updated the number of Passengers.
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55 DWORD CTrain::Disembark(int PeopleOFF)

56 {

57
58

if(Passengers - PeopleOFF » -1)
Passengers -= PeopleOFF;
else
Passengers = 8j

if(PeocpledFF » @)
return PeopleOFF * 28;

return @j

20 January, 2020

6 | Having discovered this and other places where this
value 1s being changed, be sure to get rid of the
notification before moving on. You can delete the
data breakpoint quickly by selecting it in the
Breakpoints window and pressing the Delete key.

You can also use the right-click context menu to do

this.

iy 4y 4y 8 T Default - B-Hd

Enabled Line Source
sl n Break at Add 12BBEE
In emove Break a ress de Sam

g View Memory at Address
O de Sam
') O el de Sam|
O b de Sam|
O ] CHEANEATRIMNCode Sam)

Notes

. This feature is not presently supported by the Microsoft
NET platform
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Trace When Variable Changes Value

When your code executes, it might change the value of a
variable. It is possible to capture such changes and the
variable's new value, on the Debug window. You can then
double-click on the change record to display the line of code
that caused the change, in the Code Editor.

Access

Ribbon Execute > Windows > Local Variables :
Right-click on variable > Trace When
Variable 1s Modified or

Execute > Windows > Watches :
Right-click on variable > Trace When
Variable 1s Modified

Other In Code Editor | Right-click on variable |
Trace When Variable Modified

Set up Trace

The variable you are tracing must be in scope, so to identify
and select it, set a normal breakpoint on the line of code
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where you know that the variable will exist. When the
debugger reaches this breakpoint, locate the variable and use
its context menu to enable the trace.

To locate a variable:

. If you see the variable in the source code, hover over it,
right-click and select the 'Display variable' option;
Enterprise Architect will locate it

. If the variable is in scope (a local, or 'this' or a member of
'this'), look for it in the Locals Window ('Execute >
Windows > Local Variables')

. If the variable 1s global (C, C++), display the Watches
window (‘'Execute > Windows > Watches') and search for
it by name

. If the variable is a Class static member, display the
Watches window ('Execute > Windows > Watches') and
enter its fully qualified name

Once trace is enabled, you can disable all other breakpoints
and let the program run. Each time the variable changes
value, it will be logged to the 'Output' tab of the debugger.
Check the change in value and double-click on the line to
display the code in the Code Editor.

Notes

. The debugger does not halt when the change event occurs,
it only logs the change

. This facility is available on the Microsoft Native and Java
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platforms
. Microsoft .NET does not support breakpoints on values
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Detecting Memory Address Operations

Being able to detect where and when an area of memory is
being read or written can be a great help for investigators,
even when the code base 1s well understood. Without this
tool, a C++ developer could have a potentially daunting task
of tracking where and when a global variable is accessed,
and debugging those functions. Data breakpoints allow a
C++ programmer to track when a variable / memory
location is read or when it 1s written. When the operation 1s
detected, the debugger will halt the execution and the line of
code following the operation will be displayed in the code
editor.

Access

Ribbon Execute > Windows > Breakpoints

Detect operation on memory address

Ste Action
p
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1 Click the @ button.

2 | Enter the memory address to watch. You can copy
an address from the Locals (Local Variables)
window.

Data Ei.?a kpoint
Address: (=0033Fdf4

Operation: Write Action: Break

Read [ Write Trace

0K Cancel

3 | Select the operation to detect. If you select "Write',
the debugger will break when the address is written
to. If you choose 'Read / Write', the debugger will
notify you when the address is read or when it 1s
written.

4  Select the action to perform. If you choose 'Break’,
the debugger will halt the program and the line of
code will be shown in the editor. If you choose
"Trace', the debugger will not halt execution, but log
any operation on the address as i1t occurs. This output
1s displayed in the Debugger Window.

5 | The data breakpoint 1s added to the Breakpoints and
Markers window.
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Breakpoints & Markers

@ AN < | MyBreakpoints - B~ H- ':@'
Enabled Line Source
L) O033FDF4 (NN3I3ENF4

Remove Break at Address

Viﬁv Memory at Address

Help

6 | You can use the context menu on the data breakpoint
to check the value at the memory address.

Memory Viewer

(33fdf4 Q @:l
0x0033FDF4 01 00 00 00 00 00 00 O0 00 00 00 00 00 00 00 00 CCCCCC
0x0033FEDY CCHBFE 330018 1D 41000100 00 00 AS 14 42 00 AB43
0x0033FE1A 42 00 F9 97 04 A7 82 10 41 00 00 FO FD 7F 00 FO 63 7B 28
0x0033FE2D 2D 4100 256 AE44 7B 00 00 00 00 00 00 34 00 00 00 00 00

7 | To delete a data breakpoint, select it in the
Breakpoints and Markers window and press the
Delete key. Alternatively, deselect the checkbox next
to it. Data breakpoints are deleted when they are
disabled; they do not persist as other breakpoints do.

System Requirements

Memory address breakpoints are supported in the C/C++
native debugger.
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Breakpoint Properties

Breakpoints have a number of additional properties that
determine what occurs when executing the line of code that
the breakpoint applies to.

These properties define:
. The action to be performed
. The line of code that the breakpoint applies to

. Constraints that determine whether or not the action is
performed when the breakpoint is hit

. Trace information to be output when the breakpoint is hit

Ereakpoint Properties x

Action: Line number:

@ Break Execution - 62

| Constraints:

h_secClosingVolume < 0

.| Trace statement

Closing Volume @m_secClosingVolume is Megative 11

Cancel Help

Access

There are several ways to display the 'Breakpoint Properties'
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dialog:

Code Editor | . Right-click on a breakpoint marker |
Properties or

. Ctrl+Click on breakpoint marker or

. Right-click on code that has a
breakpoint marker | Breakpoint |
Properties

Breakpoints | . Right-click on breakpoint | Properties
& Markers

window

Options

Field Details
Action The behavior when the breakpoint 1s hit.
Line The line of source code that this

breakpoint applies to.

Stack Height = For Stack Capture markers, the number of
caller frames to record. To record the
entire Stack, set the value to 0.
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Constraints Defines the condition under which the
breakpoint action will be taken. For
normal breakpoints this would be the
condition that halts execution. In this
example, for a normal breakpoint,
execution would stop at this line when
the condition evaluates to True.
Constraints are evaluated each time the
line of code is executed.

(this.m_FirstName="Joe") AND
(this.m LastName="Smith")

Trace A message output to the Debug window

statement when the breakpoint is hit. Variables
currently in scope can be included in a
trace statement output by prefixing the
variable name with a $ token for string
variables, or an (@ token for primitive
types such as int or long. For example:

Account $pAccount->m_sName has a
balance of @pAccount->m_f{Balance

(c) Sparx Systems 2019 Page 190 of 421



User Guide - Visual Execution Analysis 20 January, 2020

Failure to Bind Breakpoint

A breakpoint failure occurs if there is a problem in binding
the breakpoint. Breakpoint failures are most often caused by
source files being changed without the application being
rebuilt. Breakpoints can sometimes bind to a different line,
causing them to be moved. If a breakpoint cannot be bound
to the binary at this line or the three lines following it, it is
displayed with a question mark.

A warning message displays in the 'Details' column of the
Breakpoints & Events window, identifying the type of
problem:

. The source file for the breakpoint does not match the
source file used to build the application image

. The time date stamp on the file 1s greater than that of the
1mage
A warning message is also output to the Debug window.
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Debug a Running Application

Rather than starting a process explicitly from within
Enterprise Architect, you might want to debug an
application (process) that 1s already running on your system.

In this case you can use the debugging capability to attach to
the process that 1s already running. Provided you have the
appropriate debug information written into the running
process, and/or associated debug files (such as .PDB files),
the debugger binds to that process and initiates a debug
session.

You can also 'detach' from the process after you have
completed your inspection and leave the process to run as
normal.

Access

Ribbon Execute > Run > Start > Attach to
Process

Debugger The debugger window toolbar has an
Window Attach button

Stages
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Stage Description

Show When you select to debug another

Processes process, the 'Attach To Process' dialog
displays.

You can limit the processes displayed
using the radio buttons at the top of the
dialog; to find a service such as Apache
Tomcat or ASP.NET, select the System
radio button.

Select When you select a process, you might

Debugger have to choose the debugger from the
Debugger dropdown list; however, if the
selected Package has already been
configured in an Analyzer Script, then the
debugger listed 1n the script is preset on

the dialog.
Process Once you double-click on a process
Selection containing debug information, and
Enterprise Architect is attached to the
process:

. Any breakpoints encountered are
detected by the debugger

. The process 1s halted when a
breakpoint 1s encountered, and
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. The information 1s available in the
Debug window

Detach From  To detach from a process, click on the @
Process (Debug Stop) button.
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View the Local Variables

The Locals window displays variables of the executing
system. Whether you are recording C#, debugging Java,
C++ or VBScript, debugging an Executable StateMachine,
or running a simulation, this window is where the system's
variables are located. Current values are only displayed
when a program is halted. This occurs when a breakpoint is
encountered during debugging, when you step over a line of
code or when you step between States 1n a simulation.

Access
Ribbon Execute > Windows > Local Variables
Simulate > Dynamic Simulation > Local
Variables
Context In Code Editor | Right-click on any
Menu variable identifier > Display Variable
Icons

The value and type of any in-scope variable 1s displayed in a
tree; each variable has a colored box icon that 1dentifies the
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type of variable:

. Blue - Object with members
. Green - Arrays

. Pink - Elemental types

. Yellow - Parameters

. Red - Workbench instance

Finding variables

The easiest way to find a variable is to first locate it in the
code editor and use the right-click context menu on the
variable, selecting 'Display Variable'. Enterprise Architect
will find and reveal any variable in scope, including deeply
nested members. If the variable is found in a different scope
(global, file, module, static), it will be displayed in the
Watches window (see View Variables in Other Scopes).
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Go to Declaration

Go to Definition

synchronize Tree to Editor

+  Auto Synchronize Tree and Editor

Search for 'y 4

Search Intelli-sense +

5et Debugger to Line

Run to Cursor

Display Variable

Show in 5tring Viewer
Break when item modified
Trace when item modified
Create Use Case for 'Run’

EBreakpoint +

Persistent View

The examination of variables usually involves digging
around 1in the tree to expose the values of interest. It can be
annoying then, having gone through that trouble, to step to
the next line of code, only to have those variables buried
from sight again due to a change in context. The Locals
window has a persistent view that lingers for a while after a
run or step command. When you step through a function in
Enterprise Architect, the variables structure persists line
after line. This makes stepping through a function quick and
easy.

What changed
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As part of the persistent view, the Locals window tracks
changes to values and highlights them.

LONCE IS 10ttt T T e T T D D e D D D DT D DT DT e e D D DD D e DD D D DD DD D DD D D e e e D D D D D D D D
Variable Value Type Address
= § this OxD2BDOAAD Exchange:Account™  Ox00cBfed0
= § ExchangenAccount Exchange:Account Ox02bd0aal
#  Exchange:lAccount 0x02bd0aal
4 § m_pExchange O00CEFE44 Exchange:lExchange® x02bdDaad
3 m_acctMName "Its not broken Pty Ltd" ATL:CStringT<wchar  Ox02bd0aal8
§ m_acctBalance Dx9B8aB7T (10004599 int Ox02bd0aac
& m_acctlD 1 (1) unsigned int x02bd0abl
; sid O (2 unsigned int Ox00cBfeed
; amount OxGa (106 unsigned int Ox00cBfeed
; debitPurchaseCost Duffffec? (-318 int DxD0cEfbeld

Context Menu

Facility Detail

Break When | Set data breakpoints on the selected

Variable is memory variable to halt debugger

Modified execution at the line of code that has just
caused the value of the variable to
change.

View Display the raw values in memory at the

Memory at selected address, in hex and ASCII.
Address

Show 1n Display the variable string in the 'String
String Viewer' dialog.
Viewer
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Dump
Variable
Members to
File

Save
Snapshot of
Variable

Compare
Variable
Snapshots

Copy

Add Instance

Run State to
Diagram

Set
Conditional
Breakpoint

(c) Sparx Systems 2019
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Capture and store the selected variables
to a separate location; a browser displays
to select the appropriate .txt file name and
file path.

Capture the value of a variable at a
specific point in the life of that variable.

Compare the values of a variable at
different points in the life of that variable.

Copy the selected variable to the
Enterprise Architect clipboard.

If you have opened a model diagram
containing an Object of the Class for
which the source code is being debugged,
this option updates that Object with the
Run State represented by the variable
value.

Add a breakpoint at the current execution
position with a constraint for this variable
matching its current value.
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View Content Of Long Strings

For efficiency, the Locals window only shows partial
strings. However, you can display the entire contents of a
string variable using the 'String Viewer'.

Locals
Variahle Value Type Address
@ this (b2 5604 E0D CContextHandler* x0887efbd
& grammar “ff XKML nBMF Grammar caseSensitivel); delir - ATLzCStringT<unsiqn  Ox08870b4
B ¢ data "= Txml version="1.0" encoding="UTF-8"?> =  ATL:CStringT<unsigi (x0387f0ed
= & ATL:CSimpleStringT= (nc0887f0ed
= 4 m_pszData "=l version="1.0" encoding="UTF-8"?> = wchar* (0887 0ed
L
& macros Break When Variable is Modified ATL:CStringT<unsigr (k0887 0dc
& ret Trace When Variable is Modified bool 0x0B57efbf

View Memory at Address

Show in String Viewer

Dump Variable Members to File
Save Snapshot of Variable

ahle Snapshaots

Copy

Set Conditional Breakpoint

Help

This example shows the value of a variable holding the
contents of an XML schema file.
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« fusd:enumeration =

«<wsd:enumeration value="204143">

<xsd:annotation =

<¥sd:documentation xml:lang="en"=
<ccts:Mame =Discharging chassis in overtime < focts:Name =

< fwsdidocumentation =
< fusd:annotation =
« fwsd:enumeration =

<wsd:enumeration value="204144">

<xsd:annotation =

<xsd:documentation xml:lang="en"=
<rctsiMame =Discharging breakbulk (1 ton to 7 ton) ro—o in overtime < fccts:Mame =

< fusd:documentation
< fusd:annotation =
< fusd:enumeration =

«<wsd:enumeration value="204145">

Access

From Code
Editor or
Locals
window
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Right-click on string variable | Show in
String Viewer

Page 202 of 421



User Guide - Visual Execution Analysis 20 January, 2020

View Debug Variables in Code Editors

When a breakpoint occurs, you will see all the local
variables in that window. You can also inspect variables in
the Source Code Editor by hovering your mouse over the
reference. Here are some examples.

public woid Print ()
{
int n = 0;
while (names[n].Length = 0}

{ names = {[4] names[0]=book, names[0]=book, names[1]=novel, names[2]=Ffilm}, }-|
Documeft d = few DoCumers THEmes [T+ 7T 7

d_Printi{) ;

public woid Print ()

{
int n = 0;
whi 14 37-hit signed inkeger n=0} 0%
{

Document d = new Document (hames[n+t++]);
d.Print () ;

Note: The variable does not have to be one of the local
variables. It can have a file or module scope.
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Variable Snapshots

It 1s possible to take a 'snapshot' of a variable when your
program hits a breakpoint and use this snapshot to see how
the value of the variable changes at different points in its
life. The debugger does not copy the value of the selected
variable only; for complex variables it copies the values of
the selected variable and of each of its hierarchy of members
until it can no longer find any more debug information for a
member or no more members can be found.

Capture Variable Snapshot

Ste Action
p

1 | Inthe Code Editor, set two breakpoints: one at the
start of a function and another at the end of the
function.

2 At the start breakpoint, right-click on a variable in
the Locals window and select the 'Save Variable
Snapshot' menu option.

3 | Run the application.

4 When the end breakpoint is reached, right-click on
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the variable in the Locals window and select the
'Compare Variable Snapshots' option.

A dialog displays that shows the original value from
the first snapshot and the current value from the
second snapshot as illustrated in this diagram taken
from the EA.Example model.

CTrain® this

Mame Address Valuel Value2
int::Passengers 0x0003BEE4  Owxb1 (177) Oxds (214)
int::Delay 0x0003BEF4  Ox3c (60) 0x23 (40)

Save Variable Snapshot to File

You can save the state of a variable to file using its
right-click context menu.
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Break When Variable is Modified
Trace When Variable is Modified
Yiew Memory at Address
Show in String Viewer

Dump Variable Members to File

Save Snapshot of Variable
Copy

5et Conditional Breakpoint

Help

This 1s an excerpt of the file contents.

73 BEBREEEE | Bxe8731F08 | name | TObjectType: :Type |value|TypeIsStation|
74 BEBBEEES | Bx88731F05 | name |wchar: :Name |value|"Treasury”|

75 BEEREEES | Bxe8731FC |name |unsigned: :Location |value|@x48 (64) |

76 BE028663 | Bx8083BEDS | name | float: :Distance |value|®|

77 BEBREEES | BxeBB3EEER | name|int: :Capacity |wvalue|@xlf4 (588) |

75 BEEREEES | BxeBB3EEE4L | name|int: :Passengers |value|Bxds (214} |

79 BEBREEES | Bx@BB3EEES |name |unsigned: :Number  |value|@&x3 (3)|

86 BEBREEES | BxeBB3EEFA | name|unsigned: :Location |value|@xd (@) |

81 eEBREEES | Bx@BB3EEFL |name|int: :Delay |value|B8x28 (4@) |
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Actionpoints

Actionpoints are breakpoints that can perform actions.
When a breakpoint is hit, the actionpoint script is invoked
by the debugger, and the process continues to run.
Actionpoints are sophisticated debugging tools, and provide
expert developers with an additional command suite. With
them, a developer can alter the behavior of a function,
capture the point at which a behavior changes, and
modify/detect an object's state. To support these features,
Actionpoints can alter the value of primitive local and
member variables, can define their own
'user-defined-variables' and alter program execution.

User-Defined Variables in Actionpoints and
Breakpoints

User Defined Variables (UDVs):

. Provide the means for setting a UDV primitive or string in
Actionpoint statements

. Can be used in condition statements of multiple
markers/breakpoints

. Can be seen easily in the same Local Variables window

. The final values of all UDVs are logged when debugging
ends.

(c) Sparx Systems 2019 Page 207 of 421



User Guide - Visual Execution Analysis 20 January, 2020

In the UDV syntax, the UDV name:
. Must be preceded by a # (hash) character
. Is case-insensitive

Actionpoint Statements

Actionpoint statements can contain set commands and goto
commands.

set command

Sets variable values. An Actionpoint statement can contain
multiple 'set' commands, all of which should precede any
'g0t0' command.

The 'set' command syntax is:
set LHS = RHS

Where:

. LHS = the name of the variable as a:
- user defined variable (UDV) such as #myval
- local or member variable such as strName or
this.m_strName

. RHS = the value to assign:
- As a literal or local variable
- If a literal, as one of: integer, boolean, floating point,
char or string
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set command - Variable Examples

UDV Local Variable Examples
Examples

set #mychar | set this.m nCount=0
=g

set #mystr = set bSuccess=false
"a string"

set #myint =
10

set #myfloat
=0.5

set #mytrue =
true

goto command

goto command - switches execution to a different line
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number in a function. An Actionpoint statement can contain
only one goto command, as the final command in the
statement.

The goto command syntax is:
goto L
Where L is a line number in the current function.

Integer operators

Where a UDV exists and is of type int, it can be
incremented and decremented using the ++ and -- operators.
For example:

1. Create a UDV and set its value and type to a local integer
variable.
API1: set #myint = nTotalSoFar

2. Increment the UDV.
AP2: #myint++

3. Decrement the UDV.
AP3: #myint--

Timer operations

Actionpoints can report elapsed time between two points.
There 1s only one timer available, which is reset or started
with the startTimer command. The current elapsed time can

(c) Sparx Systems 2019 Page 210 of 421



User Guide - Visual Execution Analysis 20 January, 2020

then be printed with the printTimer command. Finally, the
total elapsed time is printed and the timer ended with the
endTimer command.

Example Actionpoint Conditions

With Literals and constants:
. (#mychar='a")

. (#mystr<>"")

. (#myint > 10)

. (#myfloat > 0.0)

With Local Variables:

. (#myval == this.m_strValue)
. (#myint <> this->m_nCount)
. (#myint != this-=>m nCount)

Instruction Recording

Instruction recording can be useful for detecting changes to
a known behavior; the point in execution (B) that diverges
from a previous execution(s) (A). The commands are:

. recStart - starts recording or starts comparing if a previous
recording exists
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. recStop - ends recording
. recPause - pause recording
. recResume - resumes recording

The recStart command begins recording instructions.
Executed instructions are then stored. When a recStop
command is encountered, the recording is saved. There can
only be one saved recording at any one time between two
Actionpoints. When a recStart is encountered and a
previous recording exists, the debugger will begin
comparing each subsequent instruction with its recording. It
could perform many comparisons. If and when a difference
is detected, the debugger will break and the line of code
where the behavior changed will be displayed in the code
editor. The iteration of the comparison is also printed.

The recording is stored in memory by default, but it can also
be stored to a file with the command syntax:

recStart filesspec
For example:
recStart c:\mylogs\onclickbutton.dat

When a recStart command is encountered that specifies a
file, and that file exists, it is loaded into memory and the
debugger will immediately enter comparison mode.

Expressions

There 1s no implicit precedence in Breakpoint, Actionpoint
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and Testpoint conditional expressions. In complex
expressions, the use of parentheses 1s mandatory. See these
examples:

Type Example

Actionpoint (Amyint=1) AND (#mystr="Germany")
UDV

example

Local (this.m_nCount > 10) OR (nCount%]1)
variables (this.m_nCount > 10) OR (bForce)
examples

Equality <> - Not Equal

operators 1n 1= - Not Equal

conditional — - Equal

expressions - - Equ

Assignment = - Assigns RHS to LHS
operator in

Actionpoint

Arithmetic / - division

operators in  + - pluys

conditional - - minus

expressions

* - multiplication
% - modulus
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Logical AND - both must be true
operators in OR - one must be true
cond1t19nal && - both must be true
expressions

|| - one must be true
A - exclusive OR (only one must be true)
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View Variables in Other Scopes

Access
Ribbon Execute > Windows > Watches
Other Execution Analyzer window toolbar :
# - | Watches
Views
View Description
Watches The Watches window 1s most useful for

native code (C, C++, VB) where it can be
used to evaluate data items that are not
available as Local Variables - data items
with module or file scope and static Class
member items.

You can also use the window to evaluate

static Class member 1tems in Java and
NET

To add a watch, type the name of the

(c) Sparx Systems 2019 Page 215 of 421



User Guide - Visual Execution Analysis 20 January, 2020

variable to watch in the toolbar, and press
the Enter key.

To examine a static Class member
variable in C++, Java or Microsoft .NET,
enter its fully qualified name:

CMyClass::MyStaticVar

To examine a C++ data symbol with
module or file scope, just enter its name.

Variables are evaluated by looking at the
current scope; that is, the module of the
current stack frame (you can change the
scope at a breakpoint by double-clicking
the frame in the Call Stack).

If the global variable exists in a different
module, you can examine the variable by
prefixing the module name to the variable

modulename!variable name

History The history of items entered is
maintained. Previously entered names or
expressions can be selected again using
the Up arrow key and Down arrow key
inside the toolbar text box. The history
will also persist for the user across any
instance of Enterprise Architect or model
on the same machine.
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View Elements of Array

You can use the Watches window to inspect one or more
specific elements of an array.

In the field to the left of the Watches window toolbar, type
the variable name of the array followed by the start element
and the number of elements to display. The start element is
enclosed in square brackets and the count of elements is
enclosed in parentheses; that is:

variable[start element](count of elements)

For example, Points[3](2) displays the fourth and fifth
elements of the Points array, as illustrated.

Watches 3 =
Points[3](2) =
Variable Value Type
=I-4 Puoints CPoint[100]
— s Points[3] CPoint
{ O tagPOINT
e X 610 leng
: ey Y 35 long
—-ip  Points[4] CPoint
-4 tagPQINT
e X 45 leng
ey Y 35 long
F 1] I
#%| Watches \;_,J Locals Memory Viewer

If you entered Points[3] the Watches window would show
the third array element only.

Access
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Ribbon Execute > Windows > Watches
Other Execution Analyzer window toolbar :
# - | Watches
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View the Call Stack

The Call Stack window is used to display all currently
running threads in a process. It can be used to identify which
thread is operational, immediately before program failure
occurs.

When a Simulation is active, the Call Stack will show the
current execution context for the running simulation. This
will include a separate context stack for each concurrent
simulation 'thread'.

A stack trace is displayed whenever a thread is suspended,
through one of the step actions or through encountering a
breakpoint. The Call Stack window can record a history of
stack changes, and enables you to generate Sequence
diagrams from this history.

Access
Ribbon Execute > Windows > Call Stack
Other Execution Analyzer window toolbar :
# - | Call Stack
Use to
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. View stack history to understand the execution of a
process

. View threads
. Save a call stack for later use

. Record call stack changes for Sequence diagram
generation

. Generate a Sequence diagram from the call stack
. View the related code line in the Source Code Editor

Facilities
Facility Description
Indicators . A pink arrow highlights the current
stack frame
. A blue arrow indicates a thread that is
running
. A red arrow indicates a thread for
which a stack trace history is being
recorded
Save a Call Not currently available.
Stack to a
TXT File
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Record a To record the execution of a thread and
Thread in a direct the recording to the Record &
Debug Analyze window, right-click on the
Session thread in the Call Stack and select the

appropriate context menu option:

. 'Record' - to manually record the
current thread during the debug session
Used in conjunction with the 'step'
buttons of the debugger; each function
that is called due to a step command i1s
logged to the Record & Analyze
window

. 'Auto-Record' - to perform
auto-recording during a debug session
When you select this icon, the
Analyzer begins recording and does not
stop until either the program ends, you
stop the debugger or you click on the

'Stop' 1con
Stop If you have started a manual or automatic
Recording recording of a thread you can stop it

before completion; select the thread
(indicated by a red arrow) and either:

. Click on the (= (Stop Recording)
button in the toolbar or

. Right-click and select the 'Stop' option

Generate a To generate Sequence diagram from the
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Sequence Call Stack trace, either:

Diagram . Click on the % (Generate Sequence

from the Call Diagram of Stack) button, or

Stack . Right-click and select the 'Generate

Sequence Diagram' option

Copy Stack To add the stack details immediately to
to Recording  the Record & Analyze window (for later
History generation of Sequence diagrams) either:

. Click on the (% button, or

. Right-click and select the 'Copy Stack
to Record History' option

Toggle Stack = To toggle between showing the full stack

Depth and showing only frames with source,
click on the = (Toggle Stack Depth)
button.

Display Double-click on a thread/frame to display

Related Code @ the related line of code in the Source

1n Source Code Editor; local variables are also

Code Editor refreshed for the selected frame.
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Create Sequence Diagram of Call Stack

The Call Stack window records a history of stack changes
from which you can generate Sequence diagrams.

Access
Ribbon Execute > Windows > Call Stack
Other Execution Analyzer window toolbar :
# - | Call Stacxk
Use to

. Record Call Stack changes for Sequence diagram
generation

. Generate a Sequence diagram from the Call Stack

To generate a Sequence diagram from the current Stack,
click on the i# (Generate Sequence Diagram of Stack)
button on the Call Stack window toolbar.

This immediately generates a Sequence diagram in the
Diagram View.
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Inspect Process Memory

Using the Memory Viewer, you can display the raw values
of memory in hex and ASCII. You can manually define the
memory address in the 'Address' field (top right), or
right-click on a variable in the Locals window or Watches
window and select the "View Memory at Address' option.

Access
Ribbon Execute > Windows > Memory Viewer
Other Execution Analyzer window toolbar :
# | Memory Viewer
From Locals window or Watches window
: Right-click on a variable | View
Memory at Address
Notes

. The Memory Viewer 1s available for debugging Microsoft
Native Code Applications (C, C++, VB) running on
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Windows or within WINE on Linux
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Show Loaded Modules

For .NET and native Windows applications, you can list the
DLL's loaded by the debugged process, using the Modules
window. This list can also include associated symbolic files
(PDB files) used by the debugger.

Access

Ribbon Execute > Windows > Modules

Modules Window display

Column Description

Path Shows the file path of the loaded module.
Load Shows the base memory address of the
Address loaded module.

Modified Shows the local file date and the time the
Date module was modified.
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Debug Shows:
Symbols . The debug symbols type

. Whether debug information is present
in the module, and

. Whether line information is present for
the module (required for debugging)

Symbol File = Indicates the validity of the symbol file; if
Match the value 1s false, the symbol file 1s out of
date.

Symbol Path =~ Shows the file path of the symbol file,
which must be present for debugging to

work.
Modified Shows the local file date and time the
Date symbol file was created.
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Process First Chance Exceptions

Access
Ribbon Execute > Tools > Debugger > Process
First Chance Exceptions
Other Debug window toolbar : # “/| Process

First Chance Exceptions

Processing Elements

Element Description
Debug When an application is being debugged
Process and the debugger is notified of an

exception, the application 1s paused and
the debugger responds in the way it is
configured to do; it either:

. Resumes the application and leaves the
exception to the application to manage,
or

. Keeps the application suspended and
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passes the exception to the appropriate
routines for automatic resolution or
manual intervention

Second The Enterprise Architect debugger
Chance defaults to the first listed behavior.

Exceptions If the application can handle the
exception, it continues to process; if it
cannot handle the exception, the
debugger 1s notified again and this time 1t
must suspend the application and resolve
the exception condition.

In this behavior, because the debugger
has encountered the exception twice, it 1s
known as a second-chance exception; in
this case, if the exception does not halt
execution, it 1s ignored and you avoid
spending time on conditions that do not
impact the overall outcome of processing.

You might work this way on large or
complex systems that invariably involve
exception conditions somewhere in the
processing paths.

First Chance = However, if you want to examine every

Exceptions exception that occurs as soon as it occurs,
you can set the debugger to adopt the
second behavior.

Because the debugger responds to the

(c) Sparx Systems 2019 Page 231 of 421



User Guide - Visual Execution Analysis 20 January, 2020

exception on first contact, it is known as
a first-chance exception.

You might work this way with individual
functions or routines that must work
cleanly or not at all.

Selection Select the 'Process First Chance
Exceptions' option to debug exceptions
on first contact.

Deselect the option to process exceptions
only if the application fails when they
occur.
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Just-in-time Debugger

You can register the Enterprise Architect debugger as the
operating system Just-in-time debugger, to be invoked when
an application running outside Enterprise Architect on the
system either encounters an exception or crashes. When you
do so, an application crash will cause Enterprise Architect to
be opened, and the source and reason for the crash
displayed.

Access

Ribbon Execute > Tools > Debugger > Set as JIT
Debugger
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Services

Enterprise Architect provides two services to facilitate
remote script execution and remote debugging. The services
primarily support Enterprise Architect running on Linux to
allow users to run native Linux shell scripts and debug
Linux programs. The Satellite service supports Analyzer
Scripts while the Agent service supports debugging.

Access

Ribbon Execute > Tools > Services

The Satellite Service

The Satellite service is responsible for executing Analyzer
Scripts on the machine on which it 1s running. The feature
can help Linux users to execute native Linux programs and
shell commands directly, bypassing Wine. The service can
be managed from the ribbon. It can also be run
independently from a terminal.
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The Linux Shell

The default shell used by Enterprise Architect is 'bash'. To
override the Linux Shell used by Enterprise Architect, open
a Linux terminal, run 'wine regedit ' and add a string value
to this registry key:

HKEY CURRENT USER\Software\Sparx
Systems\EA400\EA\Options

where:
. key name: "LINUX"
. key value: path

and path 1s the Linux path to the shell program "/bin/bash",
for example.

Permissions

Under Linux you must check that the service programs have
the appropriate permissions. The programs are located under
the Enterprise Architect installation folder. The sub
directory "VEA/x86/linux". Check that each of the programs
in this directory has the execute permission set for the
owner.

Notes
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. The Satellite services are enabled in the Unified and
Ultimate editions of Enterprise Architect

The Agent Service

The Agent service 1s responsible for managing debugging
sessions for Enterprise Architect's GDB debugger. The
service allows Enterprise Architect users to debug Linux
programs. The service can be managed from the ribbon. It
can also be run independently from a terminal.

The Services Menu

Start Satellite = Starts the service. The service listens on
Service the Satellite Port configured in any
Analyzer Script Services Page.

Stop Satellite = Stops the service.
Service

Test Satellite = Tests whether the service is running or
Service not.
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Start Agent Starts the service. The service listens on
Service the Agent Port configured in an Analyzer
Script Services Page.

Stop Agent Stops the service.

Service
Test Agent Tests whether the service 1s running or
Service not.
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Profiling

o lona Bt rvt s | mraras | 4k b s bty o i i b

[ —

During the lifetime of software applications, it is not
uncommon to investigate application tasks that are
determined to be performing slower than expected. You
might also simply want to know what 1s going on when you
'press this button'! You can work this out quite quickly in
Enterprise Architect by using its Profiler. Results can
usually be produced in a few seconds and you will quickly
be able to see the actions that are consuming the application
and the functions involved. In the Execution Analyzer, The
feature employs two separate strategies; Process Sampling
and Process Hooking. In one, samples are taken at regular
intervals to identify CPU-intensive patterns, while in the
other, the process is hooked to record demands made on
memory. Data 1s analyzed to produce a weighted Call
Graph. Behaviors are usually identifiable as root nodes
(entrypoints) in the graph, or branches near these points. All
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reports can be reviewed on demand. They can be saved to
file within the model, both as Artifact elements and as Team
Library posts.

Access
Ribbon Execute > Tools > Profiler
Other Execution Analyzer toolbar : Analyzer

Windows | Profiler

Call Sampling

Profiler O x
i - e o 1 - Call Graph @

Process Id: 3540 Fath: CApache'xerces \DOMPrint exe

Sample time {ms): (0.0963 Court: 46257

Process time (ms): 1.1381 Fragments: 2

Entrypoints Sampled Processed Time

1 mainCRTStartup 46257 46228 00:00:38.63

The Profiler is controlled using its toolbar buttons. Here you
can attach the Profiler to an existing process (or JVM), or
launch the application for the active Analyzer Script. The
Profiler window displays the details of the target process as
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it 1s profiled. These details provide feedback, letting you see
the number of samples taken. You also have options for
pausing and resuming capture, clearing captured data and
generating reports. You can gain access to the reporting
feature by pausing the capture - the reporting feature is

disabled whilst data capture is in progress.

Weighted Call Graph

| = = |& | Y | §|@
Call Stack

Inclusive Hits  Hits

= xercesc_3_1uSAX2ZXMLReaderlmpliparse 16051
=l wercesc_3_TluXMLScanner:scanDocument 160351
=l xercesc_3_l:lGEXMLScanner:scanDocument 160351
= xercesc_3_lulGEMLScanner:scanContent 160351
= xercesc_3_1:lGEMLScanner:scanStartTaghs 16031
=l xercesc_3_l:lGHMLScanner:resolveSchemaGrammar 16031
= xercesc_3_Tl:SchemaValidator:preContentValidation 16049
= xercesc_3_1:ComplexTypelnfo:checkUniqueParticledttribution 16049
= xercesc_3_luComplexTypelnfoimakeContentModel 16049
= xercesc_3_1uDFAContentModel:DFAContentModel 16047
= wercesc_3_1uDFAContentModel:buildDFA 15998 515
= xercesc_3_1uCMStateSetioperator|= 2174 2093
memcpy 32 32
1 xercesc_3_TuCM5StateSetiallocateChunk 27 1
__security_check_cockie 21 21
TrailUpVec 1 1
4 wercesc_3_luCMStateSet:~CMStateSet 3573 4
+ xercesc_3_TuXMemory:operator delete a4 2
xerces-c_3_10 4416 2
xercesc_3_1uCMStateSet:getBit 1036 1036
+ xercesc_3_1:DFAContentModel:buildSyntaxTree 528 3
+ xercesc_3_T:uCMStateSet: CMStateSet 373 3
xercesc_3_1uCMStateSet:getBitCountlnRange 285 285
+ xercesc_3_1uXMemony::operator new 21 2
1 xercesc_3_1:CMStateSet:zeroBits 154
1 xercesc_3_1:nCMStateSetEnumerator:nextElement 133 136
+ xercesc_3_luRefHashTableOf<xercesc_3_1uXMLintegery 39 2
# xercesc_3_luRefHashTableOf<xercesc_3_1uXMLintegery 28 2
# xercesc_3_luRefHashTableOf<xercesc_3_1uXMLintegery 25
1 xercesc_3_luDFAContentModel:makeDefStatelist 25 2

This detailed report shows the unique set of Call
Stacks/behaviors as a weighted Call Graph. The weight of
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cach branch is depicted by a hit count, which is the total hits
of that branch plus all branches from this point. By
following the hit trail, a user can quickly identify the areas
of code that occupied the program the most during the
capture period.

Stack Profile

®5tartPagE W% Sampler Report >

Stack Profile Summary Report

Call Stack
Stack Profile: E\Apache\walan-builds\xerces-src-31\Build\Win320WCWdebug\sax2print. exe
@ xerces-c_3 1Dxercesc_3_1:RefHashTableOf<xercesc_3 1:XMLStringPool: PoolElem,xercesc_3 1::5tri
@ xerces-c_3 1Dxercesc 3 1:RefHashTableOf<xercesc_3 1:XMLStringPool::PooclElem,xercesc_3 1:
@ xerces-C_3 1Dxercesc 3 1 XMLStringPool: XMLStringPool
@ xerces-c_3 1Dxercesc 3 1:DOMDocumentImpl:DOMDocumentImpl
FEEI xerces-c_3 1Dxercesc_3_ 1:DOMImplementationImpl: createDocument
@ xerces-c_3 1Dxercesc_ 3 1:XMLGrammarPoolImpl: XMLGrammarPool Impl
@ xerces-c_3 1Dxercesc_3 1-ElemStack:ElemStack
@ xerces-c_3 1Dxercesc 3 1:SAXZXMLReaderImpl:initialize
@ xerces-c_3 1Dxercesc_3 1-RangeTokenMap:RangeTokenMap

Stack Profiles are a taken to discover the different ways
(stacks) and the count of ways that a particular function is
invoked during the running of the program. Unlike other the
other profiler modes, this profile is activated through the use
of a Profile Point, which is a special kind of breakpoint
marker. The marker is set in the source code like any other
breakpoint. When the breakpoint is encountered by the
program, the stack is captured. When you later produce the
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report, the stacks are analyzed and a weighted call graph
produced. The graph shows the unique stacks that were
involved 1n that function during the time the profiler was
running, The 'Hit Count' column indicates the count of times
that same stack occurred.

106
107 template <class TVal, class THashers
108 void RefHashTableO0f<TVal, THasher>::initialize(|const EMLSize_t modulus)

109 {
Q 110 if (modulus == 0)
111 ThrowKMLwithMemMgr({IllegalArgqumentException, XMLEzcepts::HshTbl_ZeroMo
112
112 /f Rllocate the bucket list and zero them
114 fBucketlList = (REefHashTableBucketElem<TVal>*+*) fMemoryManager—-=allocate
115 {
116 fHazhModulus * sizeof(RefHazhTableBucketElem<TVal>*)
117 I
118 for (EMLSize_ t indexz = 0; indez < fHashModulus; indesz++)
119 fBucketlList[index] = 0O;
120 }
121

Memory Profiles

Profiler o)
i - & O 1 - Memory Profile @

Program:

C:\Apachewerces\DOMPrint. exe C:ltest'materialsYarge. xml

Frames (4-64): 20

Allocations: 7000 Frees: 0
Stack holdings: 7000 Frees not found: 0
Heap Holdings (ME): 8 Bapsed: 1:24 mins

The Memory profile tracks allocations, ignoring when
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memory 1s freed. It uses this information to rate the
executing code's demands for memory, in terms not of the
amount of memory but of the frequency of demands. The
Allocations figure 1s the total number of memory allocations
requested. The Stack Holdings is the number of stack traces
taken at those times, and the Heap Holding figure is the total
amount of memory obtained by these calls. Note that
profiling can be turned on and off on demand. There is also
no need to rebuild your program to get it to work as there 1s
no linkage involved

profile -
@ start Page % *leaks | 4 *profile X q
Call Stack Instances Bytes

E\Apache\xalan-builds\xerces-src-31\Build\Win32\WC 3 debughDOMPrint.exe C\test\materials\portrait.xml
ntdll:RtlAllocateHeap
ntdll:RtlpNtSetValueKey
ntdll:RtIDestroyMemoryBlockLookaside
ntdl:RtlAllocateHeap

e S e B e e |
-~ o
o=

R R R R=R==R=R=]
v} B & i e e e N = R
Fofo o o o o & o o e e O

o oo
=]

ercesc_3_luStringHasher=:put

753 43
33 52
291 19,788
287 28,700
18 12,914
sc_3_l:RangeTokenElermMap,xercesc_3_1 146 7,008
ntry,xercesc_3_1::5tringH: 144 6,912
112 6,612
106 6,2

This example 1s of a report produced from Profiling a
demonstration program in the Xerces project from Apache.

The program iterates over the Document Object Model
(DOM) for a provided XML file.
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Function Summary Report

Mame Inclusive Hits
P P

profiler/Example.Run 156
profiler/Example.main 156
java/lio/FileQutputStream.write 154
java/io/PrintStream.println 154
profiler/Example.Print 154
profiler/Example. MakeltalianCars 2
profiler/Example. Newar 2

20 January, 2020

This summary report lists the functions and only those
functions executed during the sample period. Functions are
listed by total invocations, with a function that presents
twice in separate Call Stacks appearing before a function
that appears just the once.

Function Line Report

LineMo

54
55
56
57
58
59
60
61
R

Hits Code
1 forfint n = 0: n < 10000 n++)

{
1408 m_Cars = new Collection<Car=);
1408 ifiin % 3)>0)

i
938 forfint i = 0; i < 1000; i++)
i

538000 MakeltalianCars();

1
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This detailed report shows the source code for a function
line by line displaying beside it the total times each was
executed. We uncovered code using this report, that exposed
case statements in code that never appeared to be executed.

Support

The Profiler is supported for programs written in C, C++,
Visual Basic, Java and the Microsoft .NET languages.
Memory profiling is currently available for native C and
C++ programs.

Notes

. The Profiler is available in Enterprise Architect
Professional editions and above

. The Profiler can also be used under WINE (Linux and
Mac) for Profiling standard Windows applications
deployed in a WINE environment
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System Requirements

Using the Profiler, you can analyze applications built for
these platforms:

. Microsoft ™MNative (C++, C, Visual basic)

. Microsoft .NET (supporting a mix of managed and
unmanaged code)

. Java

Microsoft Native applications

For C, C++ or Visual Basic applications, the Profiler
requires that the applications are compiled with the
Microsoft ™ Native compiler and that for each application or
module of interest, a PDB file 1s available. The Profiler can
sample both debug and release configurations of an
application, provided that the PDB file for each executable
exists and 1s up to date.

Microsoft .NET applications

For Microsoft .NET applications, the Profiler requires that
the appropriate Microsoft .NET framework 1s installed, and
that for each application or module to be analyzed, a PDB
file 1s available.
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Java

For Java, the Profiler requires that the appropriate JDK from
Oracle 1s installed.

The classes of interest should also have been compiled with
debug information. For example: "java -g *java"

. New instance of application VM is launched from
Enterprise Architect - no other action is required

. Existing application VM 1s attached to from within
Enterprise Architect - the target Java Virtual Machine has
to have been launched with the Enterprise Architect
profiling agent

These are examples of command lines to create a Java VM

with a specific JVMTI agent:

1. java.exe -cp "%classpath%:;.\" -agentpath:"C:\Program
Files (x86)\Sparx Systems\EA\vea\x86\ssamplerlib32"
myapp

2. java.exe -cp "%classpath%:;.\" -agentpath:"C:\Program
Files (x86)\Sparx Systems\EA\vea\x64\ssamplerlib64"
myapp

(Refer to the JDK documentation for details of the

-agentpath VM startup option.)
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Getting Started

The Profiler can be used to investigate performance issues,
providing four separate tools for you to choose from,
namely:

. Call Graph

. Stack Profile

. Memory Profile

. Memory Leaks

You select these tools from the Profiler toolbar.

Access

Ribbon Execute > Tools > Profiler
Tools

Tool Description

Call Graph Analyzes performance by taking samples
during an activity in a program. Each
sample represents a stack. The samples
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Memory
Profile

Stack Profile

(c) Sparx Systems 2019

are taken at intervals controlled using the
toolbar. In this scenario, poor
performance is rated by the patterns of
behavior that repeat the most during the
sample time period. This figure 1s used to
weight the Call Graph produced.

Analyzes performance by hooking the
memory allocations made by a program.
In this scenario, poor performance is
rated by the activities making the most
requests for memory. This figure 1s used
to weight the Call Graph produced.

The Stack Profiler enables you to set a
marker in your source code so that
whenever execution hits that marker, a
full stack trace is captured. As the
application continues executing and the
marked position 1s accessed from a
variety of places within the running
executable, a very detailed and useful
picture 1s built up showing hot spots and
usage scenarios for a particular point in
code.

The Stack Profile report, like the Memory
Profile report, is displayed in 'reverse
stack' order. This means that the root of
the report 1s always a single node (in this
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Memory
Leaks

case the marker) and the tree then fans
out to show all the various places the
marked position has been accessed from.

Analyzes memory leaks by hooking the
memory operations performed by a
program. What is produced is a Call
Graph presenting the Call Stacks that
allocated memory for which a free
operation was not detected.

Toolbar Buttons

Button

(c) Sparx Systems 2019

Action

Displays a menu of options for managing
your Profiling session.

Launches the configured application to be
profiled. By default, this is the
application configured in the active
Analyzer Script.

Indicates the state of the sampler. When
green, sampling is enabled; when red,
sampling is disabled.
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Stops the Profiler process; if any samples
have been collected, the Report button
and Discard Data button are active.

Generates a report from the current data
collection.

Displays the Profiling tool in use, which
determines the fields shown in the
Profiler window. Click on the drop-down
arrow and select a different tool, which
changes the window fields.

Discards the collected data. You are
prompted to confirm the discard.

Displays the Help topic for this window.
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Call Graph

Profiler O x
ol
- & O 1 : Call Graph @
Process Id: 3540 Path: CM\Apachewences \DOMPrint exe
Sample time {ms): 0.0963 Court: 46257
Process time (ms): 1.1381 Fragments: 2
Entrypoints Sampled Processzed Tirme
1 mainCRTStartup 46257 46228 00:00:38.63
Call Stack Inclusive Hits UFP
7| mainCRT5tartu 740
[7] mainCRTStartup 7,408
& sax2printmainCRTStartup 7408 1
& sax2print__trmainCRTStartup TA07 1
& sax2print:main 7,350 1
werces-c_3_1Diwercesc 3_1:5AXZXMLReaderlmpl:parse 7,350 1
ph:p
[ xerces-c_3_1D:ercesc_3_1:XMLScanner:scanDocument 7,350 1
[ xerces-c_3_1Dwercesc_3_1:XMLScanner:scanDocument 7,349 1
& xerces-c_3_1Dmxercesc_3_1:IGXMLScanner:scanDocument 7348 1
& xerces-c_3_1Dmxercesc_3_1:GXMLScanner:scanContent 3,309 1
& xerces-c_3_1D:xercesc_3_1:1GXMLScanner:scanCharData 3,301 1
[ xerces-c_3_1D:xercesc_3_1:GXMLScanner:sendCharData 3,301 1,742
@ xerces-c_3_1Dxercesc_3_1:5AKZXMLReaderimpl:docCharacters 3,301 1,742

. Quickly discover what a program 1s doing at any point in
time

. Easily identify performance issues

. Be surprised how quickly you can realize improvements

. See your improvements at work and have the evidence

. Support for C/C++, NET and Java platforms

Usage

The 'Call Graph' option is typically used in situations where
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an activity is performing slower than expected, but it can
also be used simply to better understand the patterns of
behavior at play during an activity.

Operation

The Profiler operates by taking samples - or Call Stacks - at
regular intervals over a period of time; the interval is set
using the Profiler toolbar. You use the Profiler to run a
particular program, or you can attach to an existing process.
The Profiler capture is controlled, and you can pause and
resume capture at any time. You can also elect to have
capture initiated immediately when the Profiler is started. If
necessary, you can discard any captured samples and start
again during the same session. If you cannot continue with
the same session, restarting the Profiler 1s quick and easy.

Results

Results can be produced at any time during the session;
however, capture must be disabled in order for the Report
button to become active. It is up to you to decide how long
you let the Profiler run. You might know when an activity is
finished, or it might be apparent for other reasons. The
reason you are here might be that an activity is not
completing at all.
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You enable the Report button by either pausing capture or
stopping the Profiler altogether.

Results are displayed in a Report view. The report opens
with two tabs initially visible: the Call Graph and the
Function Summary. The reports can be saved to file, stored
in the model as Artifacts or posted in the Team Library.
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Stack Profile

The Stack Profiler enables you to set a marker in your
source code so that whenever execution hits that marker, a
full stack trace 1s captured. As the application continues
executing and the marked position is accessed from a
variety of places within the running executable, a very
detailed and useful picture is built up showing hot spots and
usage scenarios for a particular point in code.

The Stack Profile report, like the Memory Profile report, is
displayed in 'reverse stack' order. This means that the root of
the report is always a single node (in this case the marker)
and the tree then fans out to show all the various places the
marked position has been accessed from.

@StartF'agE . Sampler Report X

Stack Profile  Summary Report

Call Stack
Stack Profile: EANApache\xalan-buildsixerces-src-31\BuildWin323W CMdebug'\sax2print. exe
@ xerces-c_3_1Dxercesc_3 1:RefHashTableOf<xercesc_3 1:XMLStringPool::PoolElem,xercesc_3_1::5tri
@ xerces-c_3 1Dxercesc_3_ 1:RefHashTableOf<xercesc_3_1:XMLStringPool:PoolElem,xercesc_3 1:
@ xerces-c_3_1Dxercesc_3 1:XMLStringPool: XMLStringPool
@ xerces-c_3 1Dxercesc_3 1:DOMDocumentImpl::DOMDocumentImpl
@ werces-c_3 1Dxercesc_3_1:DOMImplementationImpl:createDocument
@ xerces-c_3 1Dxercesc_3 1-XMLGrammarPoolImpl: XMLGrammarPool Impl
@ xerces-c_3_1Dxercesc_3 1:ElemStack::ElemStack
@ xerces-C_3_1Dxercesc 3 10SAXZXMLReaderImpl:initialize
@ xerces-c_3_1Dxercesc_3 1:RangeTokenMap:RangeTokenMap

Usage
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Use the Stack Profile mode to produce a report that shows
the unique ways in which a function can be invoked during
the running of a program. Determine the parts of the model
that rely on this function and their frequency.

Operation

106

107 template <class TVal, class THasher>

108 void RefHashTableOf<TVal, THasher>::initialize(const XMLSize_t modulus)
109 {

P 110 if (medulus == 0)
111 ThrowXMLwithMenMgr({IllegalArgqumentException, XMLEzcepts::HshTbhl_ZeroMo
11=2
113 // Bllocate the buckeset list and zero them
114 fBucketlist = (RefHashTableBucketElem<TVal>**) fMemoryManager-»allocate
115 {
116 fHashModulus * sizeof(RefHashTableBucketElem<TVal>¥*)
117 Vi
118 for (EMLSize_t index = 0; indexz < fHashModulus; indszx++)
119 fBucketlist[index] = 0;

120 }
121

Profiler modes are selected using the Profiler control
Toolbar. If a Profiler Point 1s already created, it 1s displayed.
The Profiler Point is the point at which stack traces are
captured. You can set the Profiler Point using the Set button
on the control itself, once the mode is selected. After
deciding on the Profile Point, build the project to be sure
everything is up to date, then start the Profiler. The number
of unique stack holdings detected 1s visible during the run.

Results

A results can be produced by clicking the report button on
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the Profiler control Toolbar. This button is enabled when
either:

. Capture 1s turned off (using the Pause Button) or
. The Profiler is stopped (using the Stop Button)

The results produced are displayed as a weighted call graph,
where the lines on the graph represent a unique stack, and
weighted to show the higher frequency stacks first. The
report can then be saved, either to file or to the model, using
the context menu of the report itself.
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Memory Profile

Profiler 0 x
- | O 1 + | 5 | Memory Profile @
Program:

C:Vapache \werces\DOMPrint, exe C:\test\materialsYarge, xml

Frames (4-64): 20

Alocations: 7000 Frees: 0
Stack holdings: 7000 Frees not found: 0
Heap Holdings (ME): 8 Elapsed: 1:24 mins

Call Stack Instances Bytes

c\Apachetxalan-builds\xerces-sre-31\Build\Win32\WCH\ debughDOMPrint.exe "c\sysinternalsh\LogFilexml” 4,136 78,256,467

ntdll:RtlAllocateHeap 4,136 78,256,467

ntdll:RtlpNtSetValueKey 4136 78,236,467

ntdll:RtIDestroyMemoryBlocklockaside 4136 78,256,467

ntdll:RtlAllocateHeap 4136 78,256,467

ntdll 4136 78,236,467

msverS0d:malloc_base 4132 78,253,895

ms 4132 78,253,895

msvcr3ld:malloc_dbg 4132 78,253,895

msver3ld:malloc_dbg 4132 78,253,895

0 4131 47

msverdldioperator new 4131 47

@ xerces-c_3_1dixercesc_3_1:MemoryManagerimpliallocate 4126 78,253,539

@ xerces-c_3_ldiwercesc_3_1:ValueHashTableOf < bool xercesc_3_1:StringHasher= zput 791 37,968

@ xerces-c_3_ldixercesc_3_TuXMemerny:operator new 746 75,364

@ xerces-c_3_ldiwercesc_3_1:DOMDocumentimpliallocate 372 142,664

@ xerces-c_3_ldixercesc_3_luXMemorny:operator new 332 21,596

@ xerces-c_3_ldixercesc_3_1:RangeToken:doCreateMap 291 19,738

[ xerces-c_3_1dmercesc_3_1:RangeToken:addRange 223 22,300

[ xerces-c_3_1dmercesc_3_1:XMLStringzreplicate 202 11,906

[ xerces-c_3_1d:wercesc_3_1:DOMDocumentimpl:allocate 152 77,583,712

[ xerces-c_3_1dwercesc_3_1:RefHashTableOf<xercesc_3_1:RangeTokenElemMap,xercesc_3_ 146 7,008

[ xerces-c_3_1diercesc_3_1:RefHashTableOf<xercesc_3_1:CPMapEntry,xercesc_3_1:Stringh 144 6,912

[ xerces-c_3_1duercesc_3_1:RangeToken:expand %8 74,052

. Quickly rate performance of activities that interest you
. Nothing influences a discussion more than evidence

. Reward your efforts by working in those areas that will
make a difference

. Surprise yourself by delivering optimizations you might
not have known existed
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Usage

The Memory Profile can be used to reveal how activities
perform in regard to memory consumption. Using this
mode, a user would be interested in questioning the
frequency of demands made for memory during a task. They
would be less interested in the actual amount consumed. A
well managed activity might make relatively few calls to
allocate resources but allocate enough memory to do its job
efficiently. Other activities might make many thousands of
requests, and that typically makes them less efficient. This
mode is useful for detecting those scenarios.

Operation

The Memory Profile works by hooking the process in
question, so that program has to be launched using the tool
in Enterprise Architect. Unlike the Call Graph option, you
cannot attach to an existing process. When the program is
started, hooking mechanisms track the allocation of
memory; this information is collected and collated in
Enterprise Architect. You can easily monitor the number of
allocations being made. Also, the process 1s controlled; that
1s, the memory hooks can be turned on and off on demand.
If you might have mistimed some action, you can pause
capture, discard the data and resume capture again easily.
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Results

Results can be produced at any time during the session;
however, capture must be disabled in order for the Report
button to become active. It 1s your decision how long you let
the Profiler run. You enable the Report button by either
pausing capture or stopping the Profiler altogether.

Results are displayed in a Report view. The report initially
opens with two tabs visible; a single weighted Call Graph
and a Function Summary. The Call Graph depicts all the
Call Stacks that led to memory allocations, which are
aggregated and weighted according to the frequency of the
pattern.

Requirements

For best results, the image and its modules should be built
with debug information included, and without optimizations.
Any module with the Frame Pointer Omission (FPO)
optimization is likely to produce misleading results.
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Memory Leaks

Profiler
TR 1 - Memory Leaks - @
Program: IUsing Analyzer Script -
E:\Apachewalan-buildsyerces-src-31Build Win32WC9debug \DOMPrint.exe C

Frames (4-64): 20 :

Allocations: 70238 Frees: 7083

Stack holdings: 1 Frees not found: g6

Heap Haoldings (MB): 0 Elapsed: 3.1zecs

The Profiler control, showing the count of memory
allocations and the count of operations that are memory free.

leaks
@Start Page |+ *leaks =
Call Stack Instances Bytes

EMvApache\xalan-builds\xerces-src-31\Build\Win32\WCH debug\DOMPrint.exe Ch\test\materials\portrait.xml

ntdll:RtlAllocateHeap 1 151
ntdll:RtlpMNtSetValuekey 1 151
ntdll:RtIDestroyMemeryBlockLookaside 1 151
ntdll:RtlAllocateHeap 1 151

nitdll 1 151
msverddimalloc_base 1 151
msver¥d:malloc_dbg 1 151
msvcrdldimalloc_dbg 1 151
msverd0d:malloc_dbg 1 151

msverdd:malloc_dbg 1 151

msver®ldiunlock 1 151

msverdld:_getmainargs 1 151

msvcrddd 1 151

msverd0diinitterm 1 151

msverdld 1 151

msverd0d 1 151

A well behaved program.

Memory leak detection 1s a road well traveled. Although
many other good options are available, we believe our
approach has major benefits, such as:
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. No changes at all to existing project build

. No header files required by the project code
. No runtime dependencies to worry about

. No system configuration to think about

Usage

A person would use this mode to track memory leaks in an
application or in an activity within the application. A
memory leak from the Profiler's point of view is a successful
call made to a memory allocation function that returns a
memory address for which no matching call 1s made to free
that address.

Operation

The Memory Leak detection works through hooking. The
memory routines of the process are hooked to track when
memory 1s both allocated and freed. Call Stacks are captured
at the point of the allocation and this information 1s collated
in Enterprise Architect to produce a report in the form of a
Call Graph. Capture is controlled; that is, the hooking
mechanisms can be enabled or disabled on demand.

Depending on the type of program and its memory
consumption, you could employ an appropriate strategy. For
small programs, you might track the program from start to
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finish. For larger windowed programs, you would probably
do better by toggling capturing before and after a specific
task to avoid tracking too much data.

Results

Results can be produced at any time during the session;
however, capture must be disabled in order for the Report
button to become active. It 1s your decision how long you let
the Profiler run. You enable the Report button by either
pausing capture or stopping the Profiler altogether.

Results are displayed in a Report view. The report initially
opens with two tabs visible; a single weighted Call Graph
and a Function Summary. The Call Graph depicts all the
Call Stacks that led to memory allocations, and are
aggregated and weighted according to the frequency of the
pattern.

Reports can contain a variable amount of 'noise'. To focus
on an area you have specific concerns for, locate a function
known to you in the summary report and use that to navigate
directly into the line in the graph where it 1s featured.

Requirements

For best results, the image and its modules should be built
with debug information included, and without optimizations.
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Any module with the Frame Pointer Omission (FPO)
optimization 1s likely to produce misleading results.
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The first icon on the Profiler window toolbar displays a list
of options that you can set to tailor your Profiling session.

# Attach to Running Process

*

Load Report
D Analyzer SCripts... Shift+F12

Delay Sampling b
CallGraph Aggregates Method
CallGraph Samples Include Wait State
Start Sampling Immediately
+ Discard Fragments
Capture Debug Output

Options

Option Description

Attach to Select this option to display the 'Attach to

Running Process' dialog, from which you choose
Process an active process to Profile.
Switch to Select this option to change operations

Debugger = from Profiling to Debugging. The
Debugger has an equivalent drop-down
menu option that you can use to switch
from Debugging to Profiling.
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Load Report = Select this option to load a previously
saved report from the file system.

Analyzer Select this option to open the Analyzer
Scripts Script window, which 1s the model
repository for configuring builds,
debugging, and all other Visual
Execution Analyzer options.

Delay Select this option to set a delay between
Sampling clicking on a 'Start Profiling' option and
the Profiling actually beginning. The
delay can be 3, 5 or 10 seconds. Select
'None' to cancel any delay set.

CallGraph ~~ When this option 1s selected, instances of
Aggregates | the identical stack sequences are
Method aggregated by method. That is to say, line
numbers / instructions within a method
are 1gnored, so two stacks will be counted
as one where they differ only by line
number in their final frame.

CallGraph | When this option is selected, the Profiler

Samples will sample all threads, including those in
Include Wait  Wait states. When unselected, the Profiler
State only samples threads that have

accumulated CPU time since the last
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Start
Sampling
Immediately

Discard
Fragments

Capture
Debug
Output

(c) Sparx Systems 2019

interval expired.

Select this option to trigger Data
Collection immediately on launch. You
would typically use this option to profile
a process during start up.

When stacks cannot be reconciled to the
entry point of a thread they are referred to
as fragments. The number of fragments
encountered during sampling is displayed
in the sampler Summary window. You
can set this option to collect or discard
fragments; when the Discard Fragments
option 1s:
. Selected, fragments do not appear in
the reports, although the number
encountered is still updated

. Deselected, a special collection named
'fragments' 1s created in the call graph
to house them, and to ensure they data
1s not mixed in with the complete
samples

(Applies to Process Sampling). When
selected, output normally visible during
debugging 1s captured and displayed in
the Debug window. Note that only debug
builds will typically emit debug output.
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Stop Process = This option determines termination
on Exit behavior for the Profiler. When the option
is selected, the target process will
terminate when the Profiler is stopped.
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Start & Stop the Profiler

Profiling 1s a two stage process of data collection and
reporting. In Enterprise Architect the data collection has the
advantage of being a background task - so you are free to do
other things while it runs. The information sent back to
Enterprise Architect is stored until you generate a report. To
view a report, the capture must be turned off. After the
report 1s produced you can resume capture with the click of
a button. If, for some reason, you decide to scrap your data
and start again, you can do so easily and without having to
stop and start the program again.

class Profiler
EA -E:_'FT——ﬂ;H—n——— Profiler - _ﬂ; - _Target Application
Access
Ribbon Execute > Tools > Profiler > Open
Profiler
Other Execution Analyzer toolbar : Analyzer

Windows | Profiler
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Actions

Action

Toolbar

Strategy
Selection

Start the
Profiler

Stop the
Profiler

Pause and
Resume
Capture

(c) Sparx Systems 2019

Detail

Profiler

-k 1 Call Graph @

4 F

Memaory Profile

Memory Leaks

Select the Profiling strategy from the
available options on the Toolbar.

Click the Run button on the Profiler
window

The process exits if:

. You click on the Stop button

. The target application terminates, or
. You close the current model

If you stop the Profiler and the process is
still running, you can quickly attach to it
again.

You can pause and resume capture at any
time during a session.

When capture is turned on, samples are
collected from the target. When paused,
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Generate
Reports

Clear Data
Collection

(c) Sparx Systems 2019

the Profiler enters and remains in a wait
state until either capture is enabled, the
Profiler is stopped or the application
finishes.

The Report button 1s disabled during
capture but is available when capture is
turned off.

You can clear any data samples collected
and resume at any time. First suspend
capture by clicking on the Pause button.
The Discard button, as for the Report
button, 1s enabled whenever capture 1s
turned off. In clicking on the Discard
button you will be asked to confirm the
operation. This action cannot be undone.
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Function Line Reports

After you have run the Profiler on an executing application
and generated a Sampler report, you can further analyze the
activity of a specific function listed in the report by
generating a Function Line report from that item. A
Function Line report shows the number of times each line of
the function was executed. You produce one Function Line
report at a time, on any method in the Sampler report that
has a valid source file. The Function Line report is
particularly useful for functions that perform loops
containing conditional branching; the coverage can provide
a picture of the most frequently and least frequently
executed portions of code within a single method.

The line report you generate is saved when you save the
Sampler report. The body of the function is also saved with
the Function Line report to preserve the function state at that
time.

Platforms supported

Java, Microsoft .NET and Microsoft native code

Create a Line Report

In the Sampler report, right-click on the name of the
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function to analyze, and select the 'Create Line report for

function' option.

Once the Profiler binds the method, the Function Line report
is opened on the Sampler Report window. The report shows
the body of the function, including line numbers and text.
As each line is executed a hit value will accumulate against
that line. A timer will update the report approximately once
every second.

4 4 » M

1A | @)

Call Tree Report

Module:ConsoleApplication

Function: CQuickSort:Quicksort

Date: 20/09/2013 2:53:21 PM

Author: smeagher
Iterations: 28679

LineMo

21
22
23
24
25
26
27
28
25
30
31
32
13
H
35
36
37
38
35
40
41
42
43
44

AC
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Hits

28645
28644
14460
14184

435520
14185

14185

14185
14185
14185

Summary Report

ConsoleApplication:CQuick Sort:Quicksort

Code

if fr <=1}
retum;

inti=l1,j=r.p=l.q=r;

for ()
while {a[++] < a[]) ;
while @[] = alrl)
i i==I)
break;
if i >=j)
break:;

Exchangelz. i, j);
# (al] ==al)
Exchanagela, ++p. if;

if {af] ==al}
Exchangela. j. —q);

H

Exchangela. i. r);
j=i-1i=i#1;

forfintk =1 k < p; ke+,j-)

—
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End Line Report Capture

Once enough information is captured, or the function has
ended, click on the Profiler toolbar Stop button to stop
recording the capture.

Save Reports

Use the Save button on the Call Stack toolbar to save the
Sampler report and any Function Line reports to a file.

Delete Line Reports

Closing the 'Line Report' tab will close that report but the
report data will only be deleted when the report is saved.

(c) Sparx Systems 2019 Page 274 of 421



User Guide - Visual Execution Analysis 20 January, 2020

Generate, Save and Load Profile
Reports

Reports can be produced at any time during a session, or
naturally when a program ends. To enable the Report button
while the program is running, however, you need to suspend
Profiling by toggling the Pause/Resume button, or by
terminating the Profiler with the Stop button. You have
some options for reviewing and sharing the results:

. View the report

. Save the report to File

. Distribute the report as a Team Library resource

. Attach the report as a document to an Artifact element

. Synchronize the model by reverse engineering the source
code that participated in the profile

Access
Ribbon Execute > Tools > Profiler > Create
Report from Current Data
Profiler From the Profiler window, click on the

1icon in the toolbar.
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Load Report from File

The option 1s available from the drop down menu of the
Profiler Window

Generate Report

From the Profiler window, click on the E icon in the toolbar.

CallFrequency Report
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=2 |a4b|r T @

Call Stack

= xercesc_3_1uSAK2ZKMLReaderlmpl:parse
= xercesc_3_luXMLScanner:scanDocument
=1 wercesc_3_l1:1GXMLScanneriscanDocument

= wercesc_3_l1:1GXMLScanner:scanContent
= xercesc_3_1:IGXMLScanner:scanStartTaghs
= xercesc_3_l1:1GXMLScanner:resolveSchemaGrammar

= xercesc_3_l:uSchemaValidator:preContentValidation

= xercesc_3_T:ComplexTypelnfoicheckUniqueParticleAttribution

= xercesc_3_l1uComplexTypelnfoimakeContentModel

= xercesc_3_1:DFAContentModel:DFAContentModel

= xercesc_3 1:DFAContentModel:buildDFL

= xercesc_3_1uCMStateSet:ioperator|=
memcpy

xercesc 3 1nCMStateSet:iallocateChunk
__security_check_cockie

TraillpVec

xercesc_3_1nCMStateSet:: ~CM5StateSet
xercesc_3_luXMemoryioperator delete

xerces-c_3_10

B =

[E2 I E3 I c e e R e

xercesc_3_1u
xercesc_3_1u
xercesc_3_1u
xercesc_3_1u
xercesc_3_1u
xercesc_3_1u
xercesc_3 1u
xercesc_3 1u
xercesc_3 1n
xercesc_3 1n
xercesc_3 1u

CMStateSetgetBit

DFAContentModel:buildSyntaxTree

CM5StateSet: CMStateSet

CM5StateSet::getBitCountinRange

AMemony:operator new
CMStateSet:zeroBits

CM5StateSetEnumerator:nextElement

RefHashTableOf<xercesc_3_1:XMLinteger,»
RefHashTableOf <xercesc_3_1uXMLinteger,:
RefHashTableOf <xercesc_3_1uXMLinteger,:

DFAContentModel::makeDef5tatelist

Function Summary

@Start Page

Mame

(& mainCRTStartup
(2] _tmain CRTStartup

@ xercesc_3_T:¥MLFormatter:handleUnEscaped Chars

@ xercesc_3_1XMLRormatter:format Buf

@ xercesc_3_Tu¥MLFormatterispecialFormat
@ 54x2PrintHandlers:write Chars

@ xercesc_3_1:EMLScanner:iscanDocument
(2] main

@ xercesc_3_105Ax2XMLReaderImpl:parse
@ Kercesc_3_1XMLScanner:scanDocument
@ ¥ercesc_3_1IGXMLScanner::scanDocument

@ xercesc_3_1XMLRormatter:format Buf

W% C\ea\tests\cg-xerces-sax2print ssprf X

Inclusive Hits

7408
7407
7351
7351
7351
7350
7350
7350
7350
7349
7348
4042

Inclusive Hits  Hits

16051
16051
16051
16051
16051
16051
16049
16049
16049
16047
15993
8174
32

27

21

1

3573
41
4416
1036
528
373
285
21
154
153
59

28

25

25

515
8093

QOccurrences
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Unfiltered Summary Report listing all participating
functions in order of inclusive hits.

@ Start Page | ;+ C:\eal\tests\cg-xerces-sax2print.ssprf X
Marme

SAX

@ S&2PrintHandlers:write Chars

[ xercesc_3_1:5Ax2XMLReaderimpl:parse

FE“‘ xercesc_3_1:5AXZXMLReaderImpl:doc Characters

FE“‘ S542PrintHandlers::characters

@ xercesc_3_1:5AX2xXNMLReaderImpl:endElerment

@ xercesc_3_1:5Ax2XNMLReaderImpl:startEement

@ 5802 PrintHandlers::iendElerment

Inclusive Hits Occurrences
7350 10

7350
3309
3309
2114
1925
1523

e I

You can filter and reorganize the information in the report,
in the same way as you do for the results of a Model Searcn.

Report Options

Right-click on the report to display the context menu.

rl @ xerces-c_3_1Dhxercesc_3_1:lGXMLScanner:scanCharData
4 @ xerces-c_3_1Dhxercesc_3_1:IGXMLScanner:sendCharData

4 [ xerces-c_3_1Dwxercesc_3_1:5AX2XMLReaderimpl:docCharacters

4 [ Sax2Print:SAX2PrintHandlers:characters
A @ werces-c_3_1Dkxercesc_3 1nXMLFormatter:formatBu
4 [ xerces-c_3_1Dmxercesc_3_1uXMLFormatter:specii
rl @ werces-c_3_1Dhercesc_3_1:XMLFormatter:fo
rl @ xerces-c_3_1Dmercesc 3 1nXMLFormatte
b [ Sax2Print:SAX2PrintHandlersiwriteCh
b 2 Sax2Print:SAX2PrintHandlers:writeCh

rl @ xerces-c_3_1Dmwercesc 3 1nIGXMLScanner:scanCharData
4 @ xerces-c_3_1Duxercesc_3_1:IGXMLScanner:sendCharData

4 [ xerces-c_3_1Dwxercesc_3_1:5AX2XMLReaderimpl:docChara

4 [ Sax2Print:SAX2PrintHandlers:characters
4 @ werces-c_3_10kxercesc_3_T:uXMLFormatter:formatBu
4 [ xerces-c_3_1Dmxercesc_3_1:XMLFormatter:specii
Fl @ werces-c_3_1Dhxercesc_3_1:¥XMLFormatter:fo
4 @ xerces-c_3_1Dixercesc_3_1uXMLFormatte
b [ Sax2Print:SAX2PrintHandlersiwriteCh

rFl @ werces-c_3_1Dhercesc_3_1:1GXMLScanner:scanContent

rl @ werces-c_3_1Dwercesc_3_1:ulGXMLScanner:scanEndTag
a4 [ xerces-c_3_1Dmercesc_3_1:5AX2XMLReaderlmpl:endElement
4 [ Sax2Print:SAX2PrintHandlers:endElement
rl @ werces-c_3_1Dmercesc_3_TuXMLFormatter:operator< <

4 [ xerces-c_3_1Dnxercesc_3_luXMLFormatter:formatBy
4 [ xerces-c_3_1Dmxercesc_3_1:XMLFormatter:specii
Fl @ xerces-c_3_1Dhxercesc_3 1uXMLFormatter:fo
4 @ werces-c_3_10kwercesc_3_T:uXMLFormatte
4 [ Sax?Print:SAX2PrintHandlers:writeCh

W

621
621
821

Show Source for Function
Find in Summary Window
Collapse Graph

Collapse To Mode

Follow Max Allocations
Create Line Report for Function
Create Function Graph

Mark Initial Frame for Call Stack Diagram

Create Call Stack Diagram
Create Weighted Call Graph Diagram

Display Heaviest Weighted Use
Display Mext Weighted Use

Autofit

Save Report to File
Save Report to Artifact

Help
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Action Detail

Show Source = For the selected frame, select this option

for Function | to display the corresponding line of code
in a code editor. Frames that have source
available are identifiable by their icon.

Find in Select this option to locate the function in

Summary the Summary View.

Window

Collapse Select this option to collapse the entire

Graph graph including child nodes, visible or
not.

Collapse to Select this option to collapse the entire

Node graph, then expand and set the focus to

the selected node.

Follow Max  Select this option to expand an entire line
Allocations in the graph.

Create Line Select this option to launch the Profiler (if

Report for it 1s not already running), immediately

Function bind the selected function and ready it for
recording. Once bound, an extra tab i1s
opened in the current Report View. This
report will update instantaneously,
showing the number of times each line
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executed. Of course, the report will
continue to record activity in the function
even if 1s not visible.

Note: In windowed programs, it is
usually necessary to take some action in
the application to cause the function to be

invoked.
Create Select this option to create an additional
Function tab, which shows the selected function in
Graph isolation. For a Call Frequency Profile,

this produces a graph showing all the
lines that led to this function being called
(that 1s, the callers). For a Memory
Profile, this produces a graph showing all
lines that emanate from this function (that
is, the callees).

Mark Initial ~ Use prior to creating a Call Stack

Frame for sequence diagram to limit the stack
Call Stack length. When this option is selected, the
Diagram frame 1s marked and its text is

highlighted. Frames above this one will
then be excluded from any Sequence
diagram produced.

Remove Removes the mark from a frame that was
Mark previously marked as 'Initial'.
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Create Call
Stack
Diagram

Create
Weighted

Call Graph
Diagram

Display the
Heaviest
Weighted
Use

Display the
Next
Weighted
Use

Display the
Previous
Weighted
Use
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Generates a sequence diagram for a
single stack in the graph. The selected
frame 1s depicted as the terminal frame in
the stack. The initial frame of the stack
defaults to the root node if no 'Initial’
frame has been marked.

Generates a sequence diagram that
presents a sequence for each visible stack
branching from the selected frame. By
expanding and collapsing the nodes of
interest, a user can tailor the sequence
diagram content to their liking,.

Select this option to display the line in the
graph with the highest weight in which
this function appears.

Select this option to navigate to the next
line 1n the graph where the function
appears.

You can use the shortcut key combination
Ctrl+Down Arrow.

Select this option to navigate to the
previous line in the graph where this
function appears.

You can also use the shortcut key
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combination Ctrl+Up Arrow

Save Report | Select this option to display the 'Save As'
to File dialog, allowing you to choose where to
store the report.

Save Report = Note: Before selecting this option, go to

to Artifact the Browser window and select the
Package or element under which to create
the Artifact element.

You are prompted to provide a name for
the report (and element); type this in and
click on the OK button.

The Artifact element 1s created in the
Browser window, underneath the selected
Package or element.

If you add the Artifact to a diagram as a
simple link, when you double-click on
the element the report is re-opened.

Team Library Options

Option Description

Make Report = You can save any current report as a
a Team resource for a Category, Topic or Post in

(c) Sparx Systems 2019 Page 282 of 421



User Guide - Visual Execution Analysis 20 January, 2020

Library the Team Library to share and review at

Resource any time, as it is saved with the model.
The report can also be compared with
future runs.

To begin this process, on the "Team
Library context menu select the menu
option 'Share Resource | Add Active
Profiler Report'.

Notes

. If you add the Profiler report to an Artifact element and
also attach a Linked Document, the Profiler report takes
precedence and 1s displayed when you double-click on the
element; you can display the Linked Document using the
'Edit Linked Document' context menu option
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Save Report in Team Library

You can save any current report as a resource for a
Category, Topic or Document in the Team Library. The
report can then be shared and reviewed at any time as it 1s
saved with the model. This helps you to:

. Preserve a Profiler report to compare against future runs
. Allow other people to investigate the profile

Access
Context Right-click in Team Library window |
Menu Share Resource | Active Profiler Report
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Recording

Sequence diagrams are a superb aid to understanding
behavior. Class Collaboration diagrams also can be helpful.
In addition to these, sometimes a Call Graph 1s just what we
need. Then again, if you have this information available,
you could use it to document a Use Case, and why not build
a Test domain while you are at it? The Enterprise Architect
Analyzer can generate all of these for you and from a single
recording. It does this by recording a running program, and
it works on all of the most popular platforms.

Access

Ribbon Execute > Tools > Recorder
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Overview

At 1ts simplest, a Sequence diagram can be produced in very
few steps, using even a brand new model. You do not even
have to configure an Analyzer Script. Open the Enterprise
Architect code editor (Ctrl+Shift+0O), place a recording
marker in a function of your choice, and then attach the
Enterprise Architect Debugger to a program running that
code. Any time that function is called, its behavior will be
captured to form a recording history. From this history these
diagrams can be easily created.

eeeeeeeeeeeeeeeeeeeeeeeeeeeee
eeeeeeeeeeeeeeeeeeeeeeeee

The Sequence diagram from the Example Model recording.
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ckiD
countiD, TStockiD, INT)

Stock

STR, FLOAT, UINT, ESector): IStock*

k(IStock®): TStockiD
ESector, INT): void

The Test Domain diagram from the same recording.

Of course, an Analyzer Script is still the best idea, and
opens up an incredibly rich development environment, but it
1s worth noting that significant results can be obtained
without one. This is also true of the Enterprise Architect
Debugger and Profiler tools.

A point of interest: you can view a thread's behavior while it
is recorded. Showing the Call Stack during a recording will
show updates to a thread's stack in real-time, much like an
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animation. It is a good feedback tool and in some
circumstances it might be all that is required

D Y =

H#&%B" 1@

o Thread 4184
Broker.exe! wmain, chea\wea\projects\c++\stockexchange\brok
Broker.exe! Trade, chea\wea\projectsc++\stockexchange\broke
Broker.exe! GetMext, ciea\wea\projects\c++\stockexchange\bro
Broker.exe! CArray<Exchange Transaction *,Exchange. Transactio

Eroker.exe! CArray<Exchange Transaction *,Exchange Transactio
g+ Broker.exe! CArray<ExchangeTransaction * Exchange. Transactio

Features at a glance

Diagram Generation

. Sequence diagram

. Class Collaboration diagram

. Test Domain diagram

. State Transition capture

. Call Graph

Control

. Support multi-threaded and single-threaded models

Support stack depth control 2=
Support filters to restrict capture

Filter wildcard support

Real-time stack update
Integration
. Class Model
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. Test Domain

. StateMachine

. Executable StateMachines
. Unit Tests

Platforms

. Microsoft NET
. Microsoft Native
. Java

. PHP

. GDB

. Android

Requirements

. Recording 1s available to users of all editions of
Enterprise Architect

Notes

. The debug and record features of the Visual Execution
Analyzer are not supported for the Java server platform
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'Weblogic' from Oracle
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How it Works

This topic explains how the Visual Execution Analyzer
generates Sequence diagrams.

Explanation
Points Detail
Usage The Visual Execution Analyzer enables

you to generate a Sequence diagram from
recordings of the live execution of an
application. As the application runs, the
history of each thread is recorded. This
history can be used to generate the
Sequence diagram.

This 1s a Sequence diagram generated

from a program that calculates the price
of books:
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How does the recorder know what to
record?

. The recorder works from recording
markers; these are placed by you in the
functions of interest

Call Stacks in Java can stretch further
than the eye can see. How can we restrict
the recording to just ten frames?

. The recorder is controlled by the depth
either set on the recorder toolbar or
associated with a Marker Set stored in

the model
[ts the real In recording, the target application 1s not
thing modified; no instrumentation of any

image or module occurs at all. A
recording produced using a 'Release’
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Where do
you start

(c) Sparx Systems 2019

build of a program is a trustworthy
document of what a program did.

We have a very large server application;
so where do we start? If you have little or
no understanding of the program you
intend to record and little or no model to
speak off, you might be best starting with
the Profiler. Running the Profiler whilst
using a program in a specific manner can
quickly 1dentify Use Cases from the entry
points and Call Graphs presented. Having
that knowledge can enable you to focus
on areas that are uncovered and record
those functions.

If you have the source code, all you need
to do is place a recording marker in a
function that interests you. We
recommend against placing multiple
recording markers in multiple functions at
the same time. In practice this has shown
to be less helpful. Where do you place a
recording marker? For windows Ul
programs, and in relation to some
business use case, you might start by
placing one in the event handlers for a
message that seems most pertinent. If you
are investigating a utility function, just
set a method recording marker at or
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somewhere near the start.

For services, daecmons and batch
processes you might want to profile the
program once for each behavior of
interest and use the report to explore
those areas uncovered.

Tip It's a good 1dea to have a quick glance at
the Breakpoints and Markers window
before debugging, and check that the
markers listed here are what you are
expecting.

Scenarios . Microsoft Native C and C++, VB
(Windows programs, Window
Services, Console programs, COM
servers, IIS ISAPI modules, Legacy)

. Microsoft NET
(ASP.NET, Windows Presentation
Foundation (WPF), Windows Forms,
Workflow Services, devices,
emulators)

. Java
(Apps, Applets, Servlets, Beans)

. Android
(using Android debug bridge for
devices and emulators)

. PHP
(Web site scripts)
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. GDB
(Windows / Linux interopability)
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The Recording History

When the execution analysis of an application encounters
user-defined recording markers, all information recorded is
held in the Record & Analyze window.

Access
Ribbon Execute > Tools > Recorder > Open
Recorder
Facilities
Facility Information/Options

Information | The columns in the Record & Analyze
Display window are:

. Sequence - The unique sequence
number

. Threads - The operating system thread
ID

. Delta - The elapsed thread CPU time
since the start of the sequence
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. Method - There are two Method
columns: the first shows the caller for a
call or for a current frame 1f a return;
the second shows the function called or
the function it is returning to

. Direction - Stack Frame Movement,
can be Call, Return, State, Breakpoint
or Escape (Escape 1s used internally
when producing a Sequence diagram,
to mark the end of an iteration)

. Depth - The stack depth at the time of a
call; used in the generation of Sequence
diagrams

State - The state between sequences

Source - There are two Source
columns: the first shows the source
filename and line number of the caller
for a call or, if a return, for a current
frame; the second shows the source
filename and line number of the
function called or function returning

. Instance - There are two Instance
columns, which only have values when
the Sequence diagram produced
contains State Transitions; the values
consist of two items separated by a
comma - the first item is a unique
number for the instance of the Class
that was captured, and the second 1s the
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actual instance of the Class

For example: supposing a Class
'CName' has an internal value of 4567
and the program created two instances
of that Class; the values might be:

- 4567,1

- 4567,2
The first entry shows the first instance
of the Class and the second entry
shows the second 1nstance

Operations The Record & Analyze window toolbar

on provides a range of facilities for

Information | controlling the recording of the execution
of an Analyzer script.

You can perform a number of operations
on the results of a recording, using the
Record & Analyze window context
menu, once the recording 1s complete.

Notes

. The checkbox against each operation is used to control
whether or not this call can be used to create a Sequence,
Test Domain Class or Collaborative Class diagram from
this history
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. In addition to enabling or disabling the call using the
checkbox, you can use context menu options to enable or
disable an entire call, all calls to a given method, or all
calls to a given Class
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Diagram Features

When you generate a Sequence diagram, it includes these

features:

Features

Feature

References

Fragments

States

(c) Sparx Systems 2019

Detail

When the Visual Execution Analyzer
cannot match a function call to an
operation within the model, it still creates
the Sequence but also creates a reference
for any Class that it cannot locate.

It does this for all languages.

Fragments displayed in the Sequence
diagram represent loops or iterations of a
section(s) of code.

The Visual Execution Analyzer attempts
to match function scope with method
calls to as accurately as possible represent
the execution visually.

If a StateMachine has been used during
the recording process, any transitions in
State are presented after the method call
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that caused the transition to occur.

States are calculated on the return of
every method to its caller.
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Setup for Recording

This section explains how to prepare to record execution of
the application.

Steps

Step

Prerequisites - To set up the environment for recording
Sequence diagrams you must:

. Have completed the basic set up for Build & Debug and
created Execution Analysis scripts for the Package

. Be able to successfully debug the application

Narrow the focus of a recording by applying filters.

Control the detail of a recording by adjusting the stack
depth.
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Control Stack Depth

When recording particularly high-level points in an
application, the Stack Frame count can result in a lot of
information being collected; to achieve a quicker and clearer
picture, it is better to limit the stack depth on the toolbar of
either:

. The Breakpoint and Markers window or
. The Record & Analyze window

Access

Ribbon Execute > Tools > Recorder > Open
Recorder

Set the recording stack depth

You set the recording stack depth in the numerical field on
the toolbar of the Breakpoints & Markers window or the
Record & Analyze window:

3

By default, the stack depth is set to three frames. The
maximum depth that can be entered is 30 frames.
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The depth is relative to the stack frame where a recording
marker is encountered; so, when recording begins, if the
stack frame 1s 6 and the stack depth 1s set to 3, the Debugger
records the frames 6 through 8.

For situations where the stack is very large, it 1s
recommended that you first use a low stack depth of 2 or 3.
From there you can gradually increase the stack recording
depth and insert additional recording markers to expand the
picture until all the necessary information is displayed
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Place Recording Markers

This section explains how to place recording markers, which
enable you to silently record code execution between two
points. The recording can be used to generate a Sequence
diagram.

As this process records the execution of multiple threads, it
can be particularly useful in capturing event driven
sequences (such as mouse and timer events).

Access

Ribbon Execute > Windows > Breakpoints

Actions

Action

Different recording markers can be used for recording the
execution flow; see the related links for information on
the properties and usage of these markers.

Manage breakpoints in the Breakpoint & Markers
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window.
Activate and deactivate markers.

Working with Marker Sets - when you create a breakpoint
or marker, it 1s automatically added to a marker set, either
the Default set or a set that you create for a specific

purpose.

Notes

. The Breakpoint and Marker Management topic (Software
Engineering) describes a different perspective
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Set Record Markers

Markers are set in the source code editor. They are placed
on a line of code; when that line of code executes, the
Execution Analyzer performs the recording action
appropriate to the marker.

Access

Use one of the methods outlined here, to display the Code
Editor window and load the source code associated with the
selected Class or Class element.

Ribbon Execute > Source > Edit > Edit Element
Source
Execute > Source > Edit > Open Source
File

Keyboard On an element press Ctrl+E or F12

Shortcuts To bring up file dialog Ctrl+Alt+O

Set a recording marker

Ste | Action

(c) Sparx Systems 2019 Page 307 of 421



User Guide - Visual Execution Analysis 20 January, 2020

1 | Open the source code to debug, in the integrated
source code editor.

2 | Find the appropriate code line and right-click in the
left (Breakpoint) margin to bring up the
breakpoint/marker context menu; select the required
marker type:

12 F'a:sseng;ar*s = GetRandom(@,288);
13 Humber = number;

Y P T LY .

Add Breakpoint

Add Start Recording Marker tation(Station);
Add End Recording Marker

Add Stack Auto Capture Marker

Add Method Auto Record Marker

00009

Add Tracepoint Marker

®

Help

3 | If a Start Recording Marker has been set, you must
also set an End Recording Marker.
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Marker Types

Markers are really fantastic. Unusual by their very light
footprint when used with care, their impact on the
performance of the programs being recorded can be
negligible. Markers come in several flavors (well colors
actually) and more are always being added. They are placed
and are visible in the left margin of the editor, so you will
need to have some source code.

Use to

. Record a single function

. Record parts of a function

. Use Cases spanning multiple functions
. Record call stacks

. Generate Sequence diagrams

. Generate Test Domain diagrams

. Generate Class Collaboration diagrams

Reference

Marker Detail
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Start / End
Recording
markers

(c) Sparx Systems 2019

Place the markers at the start and end
lines of the code to record. These need
not be within the same function.

o 17 private int m delivery:
12 public ClassLibi(){
20
21
22
23
2
25 # @Eexception Throwable
26 [
9 27 public vold finalize()

When the program encounters a start
recording marker, a new recording is
initiated (the camera starts rolling!).
When an end marker 1s encountered, the
current recording ends (it's a take). How
you use these markers is up to you and
your knowledge of the system under your
care.

Advanced Stuff (nested markers):

If a Start recording marker is encountered
while a recording is in progress, but
where capture is inhibited by the Stack
depth value in use, a separate recording
will be initiated. Each recording is kept
on a stack. When one ends, it is removed.
This technique can be used in Enterprise
Architect to record and render scenes in
very complex systems. It resembles
splicing short scenes from a video to
create a trailer. If you only want to record
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a single function, you should use an Auto
record marker.

Method Auto = A Method Auto Record marker enables

Record you to record a particular function. The

marker debugger will automatically end the
recording when the function completes.
This is good because recording is an
intensive operation.

The function marker combines a Start
Recording marker and an End Recording
marker in one, so recording is executed
after the marker point, and always stops
when this function exits.

185

188 BCOL CRecurrenceDlg::CnInitDialog()
189 H{
& 1390 CBCGPDialog: :OnInitDialog ()

TUINT nMaszk =
CECGFDateTimeCrrl: :DTM SPIN |
CBECGPDateTimeCrrl: :DTM DATE |
CBCGPDateTimeCtrl: :DTM TIME |
CECGPDateTimeCrrl: :DTM CHECKBOX |
CBECGPDateTimeCrrl: ;DTM DROPCALENDAR |
CECGPDateTimeCtrl: :DTM CHECKED:

O W0 W0 W0 W0 W0 0 W0
B T T ST

UINT nFlags = CBCGPDateTimeCtrl::DIM CHECKED | CBCGPDateTimeCtrl::DI

ff Setup date fields:

Recording markers can be nested. When
a new Method Auto Record marker is hit
while recording, the stack depth to record
to will be extended to include the current
method and the required depth from that
function
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k 76 /* End - EA generated code for Parts and Ports */f
StaC 77 /* Begin - EA generated code for Activities and In

public wvoid ClassLib ActivityGraphWithActionPin ()
Auto-Capture

{
marker

Stack markers enable you to capture any
unique stack traces that occur at a point in
an application; they provide a quick and
useful picture of where a point in an
application is being called from.

To insert a marker at the required point in
code, right-click on the line and select the
'Add Stack Auto Capture Marker' option.

Each time the debugger encounters the
marker it performs a stack trace; if the
stack trace 1s not in the recording history,
it 1s copied, and the application continues
running

Limiting the = You can limit the depth of frames in any

recording recording using the stack depth control on
depth either the recorder and breakpoints
toolbars.
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The Breakpoints & Markers Window

Using the Breakpoints & Markers window, you can apply
control to Visual Execution Analysis when recording
execution to generate Sequence diagrams; for example, you
can:

. Enable, disable and delete markers
. Manage markers as sets

. Organize how markers are displayed, either in list view or
grouped by file or Class

Access

Ribbon Execute > Windows > Breakpoints
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Working with Marker Sets

Marker sets enable you to create markers as a named group,
which you can reapply to a code file for specific purposes.

You can perform certain operations from the Breakpoints &
Markers window alone, but to understand and use markers
and marker sets you should also display the appropriate
code file in the 'Source Code Viewer' (click on the Class
element and press F12).

Access

Ribbon Execute > Windows > Breakpoints : =~
toolbar icon

Using Marker Sets

Action Details

Example of = You might create a set of Method Auto

Use Record markers to record the action of
various functions in the code, and a set of
Stack Capture markers to record the
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sequence of calls that cause those
functions to be called.

You could then create Sequence diagrams
from the recordings under each set.

Create a To create a marker set from the

Marker Set Breakpoints & Markers window, click on
the drop-down arrow on the = - icon and
select the 'New Set' option.

The 'New Breakpoint Marker Set' dialog
displays; in the 'Enter New Set Name'
field, type a name for the set, and click on
the Save button.

The set name displays in the text field to
the left of the 'Set Options' icon.

Alternatively, you can select the 'Save as
Set' option from the 'Set Options'
drop-down to make an exact copy of the
currently-selected set, which you can then

edit
Accessing To access a marker set, click on the
Sets drop-down arrow on the text field to the

left of the 'Set Options' icon, and select
the required set from the list.

The markers in the set are listed in the
Breakpoints & Markers window.

You would normally load a marker set
prior to the point at which an action is to
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be captured.

For example, to record a sequence
involving a particular dialog, when you
begin debugging you would load the set
prior to invoking the dialog; once you
bring up the dialog in the application, the
operations you have marked are recorded.

Add Markers @ To add markers to a marker set, add each
to Set required marker to the appropriate line of
code 1n the 'Source Code Viewer'.

The marker 1s immediately added to
whichever set 1s currently listed in the
Breakpoints & Markers window.

Each marker listed on the dialog has a
checkbox in the 'Enabled' column;
newly-added markers are automatically
enabled, but you can disable and
re-enable the markers quickly as you
check the code.

Storage of When you create a marker set it is

Sets immediately saved within the model; any
user using the model has access to that
set.

However, the Default set, which always
exists for a model, is a personal
workspace, 1s not shared and is stored
external to the model.
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Delete a Right-click on the marker and select the
Marker from | 'Delete Breakpoint' option.
a Set

Delete a Set | If you no longer require a marker set,
access 1t on the Breakpoints & Markers
window and select the 'Delete Selected
Set' option from the 'Set Options'
drop-down list.

You can also clear all user-defined
marker sets by selecting the 'Delete all
sets' option; a prompt displays to confirm
the deletion.

Notes

. Marker Sets are very simple and flexible but, as they are
available for use by any user of the model, they can be
casily corrupted; consider these guidelines:

- When naming a set, use your initials in the name and
try to indicate its use, so that other model
users can recognize its owner and purpose
- When using a set other than Default, avoid excessive
experimentation so that you don't add
lots of ad-hoc markers to the set
- Make sure you are aware of which marker set is
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exposed in the Breakpoints & Markers window

as you can easily inadvertently add markers to the set
that are not relevant to the code file the

set was created for

- In any set, if you have added markers that don't have

to be kept, delete them to maintain the

purpose of the set; this 1s especially true of the
Default set, which can quickly accumulate

redundant ad-hoc markers
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Control the Recording Session

The Record & Analyze window enables you to control a
recording session. The control has a toolbar, and a history
window that displays the recording history as it 1s captured.
Each entry in this window represents a call sequence made
up of one or more function calls.

Access

Open the Record & Analyze window using one of the
methods outlined here.

Y ou must also open the Execution Analyzer window
('Execute > Analyzer | Analyzer Scripts'), which lists all the
scripts in the model; you must select and activate the
appropriate script for the recording.

Ribbon Execute > Tools > Recorder > Open
Recorder
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Recorder Toolbar

You can access facilities for starting, stopping and
moderating an execution analysis recording session through
the Record & Analyze toolbar.

Access
Ribbon Execute > Tools > Recorder > Open

Recorder
Explore > Portals > Show Toolbar >
Record

Buttons

Button Description

k. Display a menu of options for defining

what the recording session operates on.

. Attach to Process - enabled even if no
Analyzer Script exists, this option
displays a dialog through which you
select a process to record and a
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debugging platform to use; you can
also optionally select a record marker
set and/or a StateMachine to use during
the recording

. Generate Sequence Diagram from
Recording - generate a Sequence/State
diagram from the Execution Analyzer
trace

. Generate Testpoint Diagram from
History - generate a Test Domain
diagram from the Execution Analyzer
trace, that can be used with the
Testpoint facility

. Generate Class Diagram from History -
generate a Collaboration Class diagram
from the Execution Analyzer trace,
depicting only those Classes and
operations involved in the recorded
action (Use Case)

. Generate Call Graph from History -
generate a dynamic Call Graph from
the recording history, as you might see
in the VEA Profile workspace
execution analysis layout; this can be
more useful than the Sequence diagram
in 1dentifying the unique call stacks
involved

. Generate All - generate the Sequence,
Testpoint and Collaboration Class
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diagrams together from the Execution
Analyzer trace

Save as Artifact - create an Artifact
clement that contains the current
recording history, under the
currently-selected Package in the
Browser window; 1f you subsequently
drag this Artifact element onto a Class
diagram and double-click on it, the
history recorded in the Artifact is
copied back into the Record & Analyze
window

. Load Sequence History from file -
select an XML file from which to
restore a previously-saved recording
history

Save Sequence History to file - save
the recording history to an XML file

L= Select the recording stack depth for the
marker set; that 1s, the number of frames
from the point at which recording began.

2 Launch and record the application
described 1n the script; you can optionally
select a record marker set and/or a
StateMachine to use during the recording.

The icon 1s enabled when the active
Analyzer Script 1s configured for
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debugging.

Perform ad-hoc manual recording of the
current thread during a debug session.

Use this function with the 'step' buttons of
the debugger; each function that is called
due to a step command 1s logged to the
history window.

The icon 1s enabled if no recording is
taking place and you are currently at a
breakpoint (that is, debugging).

Perform ad-hoc auto-recording during a
debug session.

When you click on this icon, the
Analyzer begins recording and does not
stop until either the program ends, you
stop the debugger or you click on the
Stop 1con.

This icon is enabled if no recording 1s
taking place and you are currently at a
breakpoint (that 1s, debugging).

Step into a function, record the function
call in the History window, and step back
out.

Enabled for manual recording only.
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Stop recording the execution trace.

= Display the 'Synchronize Model' dialog
through which you can synchronize the
model with the code files generated
during a Record Profile operation.
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Working With Recording History

You can perform a number of operations on or from the
results of a recording session, using the Record & Analyze
window context menu.

Options

Option

Show Source
for Caller

Show Source

Action
Display the source code, in the Source

Code Viewer, for the method calling the
sequence.

Display the source code, in the Source

for Callee Code Viewer, for the method being called
by the sequence.

Generate Generate a Sequence diagram for a single

Diagram for | sequence selected in the recording

Selected history.

Sequence

Generate Generate a Sequence diagram including

Sequence all sequences 1n the recording history.

Diagram
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Clear

Save
Recording
History to
File

Load
Recording

History From
File

Disable All
Calls

Disable This
Call

Disable This
Method

Disable This
Class

Disable All
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20 January, 2020

Clear the recording history currently
displayed in the Record & Analyze
window.

Save the recording history to an XML
file.

A browser window displays, on which
you specify the file path and name for the
XML file.

Load a previously saved recording
history from an XML file.

A browser window displays, on which
you specify the file path and name for the
XML file to load.

Disable every call listed in the Record &
Analyze window.

Disable the selected call.

Disable the selected method.

Disable the selected Class.

Disable every call listed in the Record &
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Calls Outside = Analyze window except for the selected
This Call call.

Enable All Enable every call listed in the Record &
Calls Analyze window.

Enable This Enable the selected call.
Call

Enable This Enable the selected method.
Method

Enable This Enable the selected Class.
Class

Help Display the Help topic for the Record &
Analyze window.
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Start Recording

When you are recording execution flow as a Sequence
diagram, you start the recording by selecting the 'Recording’
icon on the Record & Analyze window toolbar. The 'Record'
dialog displays with the recording options set to the
defaults; that is, the current Breakpoint and Markers Set, the
filters defined in the current Analyzer Script and the
recording mode as basic.

Access

Ribbon Execute > Tools > Recorder > Open
Recorder : &

Record Dialog Options

Field/Button |Detail

Recording Recording markers determine what is
Set recorded.

If you have a recording set to use, click
on the drop-down arrow and select it.
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Additional Filters are used by the debugger to

Filters exclude matching function calls from the
recording history. Recording filters are
defined in the Analyzer Script.

In the 'Additional Filters' field you can
add other filters for this specific run. if
you specify more than one filter, separate
them with a semi-colon.

Basic In basic mode the debugger records a
Recording history of the function calls made by the
Mode program whenever it encounters an

appropriate recording marker.

Track In Track Instances mode the debugger
Instances of | also captures the creation of instances of
Named the Classes you specify. It then includes
Classes that information 1n the history. The

resulting Sequence diagram can then
show lifelines for each instance of that
Class with, where appropriate, function
calls linked to the lifeline.

Track State The recording can also capture changes in

Transitions State using a specified StateMachine
diagram. The StateMachine diagram must
exist as a child of a Class.

The Execution Analyzer captures
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instances of that Class and calculates the
State of each instance whenever a
function in the current recording
sequence returns.

OK Click on this button to start the debugger.
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Step Through Function Calls

The 'Step Through' command can be executed by clicking
on the Step Through button on the Record & Analyze
window toolbar.

Alternatively, press Shift+F6 or select the 'Execute > Run >
Step In' ribbon option.
The 'Step Through' command causes a 'Step Into' command

to be executed; 1f any function 1s detected, then that function
call 1s recorded in the History window.

The Debugger then steps out, and the process can be
repeated.

This button enables you to record a call without having to
actually step into a function; the button is only enabled
when at a breakpoint and in manual recording mode.
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Nested Recording Markers

When a recording marker is first encountered, recording
starts at the current stack frame and continues until the
frame pops, recording additional frames up to the depth
defined on the Recording toolbar. Consider this call
sequence:

A>B>C>D>E>F->G->H->]>]J]>K-—>L -—>
M_>N_>O_>P_>Q_>R_>S_>T_>U_>V->W_>X
>Y ->7

If you set a recording marker at K and set the recording
depth to 3, this would record the call sequence:

K>L->M

If you also wanted to record the calls X, Y and Z as part of
the Sequence diagram, you would place another recording
marker at X and the analyzer would record:

K>L>M->X->Y->Z

However, when recording ends for the X-Y-Z component
(frame X is popped), recording will resume when frame M
of the K-L-M sequence is re-entered. Using this technique
can help where information from the recorded diagram
would be excluded due to the stack depth, and it lets you
focus on the particular areas to be captured.
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Generating Sequence Diagrams

This topic describes what you might do with the recording
of an execution analysis session.

Access
Ribbon Execute > Tools > Recorder > Open
Recorder
Reference
Action Detail
Generate a Select the appropriate Package in the
diagram Browser window, in which to store the

Sequence diagram.
To create the diagram from all recorded
sequences, either:

. Click on the 'Recorder Menu' icon
(1=2) 1n the Record & Analyze window
toolbar, and select the 'Generate
Sequence Diagram from Recording'
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Save a
recorded

sequence to
an XML file

Access an
existing
sequence
XML file
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option, or

. Right-click on the body of the window
and select the 'Generate Sequence
Diagram' option

To create the diagram from a single

sequence, either:

. Click on the 'Recorder Menu' icon
(1=2) in the Record & Analyze window
toolbar, and select the 'Generate
Sequence Diagram from Recording'
option, or

. Right-click on the sequence and select
the 'Generate Diagram from Selected
Sequence' option

Click on the sequence, click on the
'Recorder Menu' icon (:54%) in the Record
& Analyze window toolbar, and select
the 'Save Sequence History to File'
option.

Either:

. Click on the =1z in the Record &
Analyze window toolbar, and select the
'Load Sequence History from File'
option, or

. Right-click on a blank area of the
screen and click on the 'Load Sequence
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From File' option
The 'Windows Open' dialog displays,
from which you select the file to open.

Use to

. Generate a Sequence diagram from a recorded execution
analysis session, for:

. all recorded sequences or
. asingle sequence in the session
Save the recorded sequence to file

. Retrieve the saved recording and load it into the Record &
Analyze window
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Reporting State Transitions

This section describes how you can generate Sequence
diagrams that show transitions in state as a program

executes.

Use to

. Generate Sequence diagrams that report user-defined
transitions in state as a program executes (as shown in the

example generated diagram)

retenenoe =insiaroe= ainsianoes
el y CTmain2 CTremi
T T T
| I |
I
| e
|
I n
- ey i :
L= Ll |
I 1 I
I L} |
iz [ tirma} i
T
L}
I
1
[}
i SrarnaitSimtion= DNOAD
1
: Crisemizari} DWORD
i
: GQesfandomiint. ind} int
1
1
1 (m.n.un)
1
1
Jeop 2 (52) T Ermsifel) [WORD
Casfandarmdint, ind] iint

DnAwmvaliCSintion™) -OWCARD
Desembarnk) DWOAD

GetRandomiint int) et

Central

Emban) DWORD
GatRandam{ing inl) w1

=L
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Topic
Create a StateMachine under the Class to be reported.

Set the constraints against each State to define the change
in state to be reported.
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Reporting a StateMachine

The Execution Analyzer can record a Sequence diagram, we
know that. What you might not know i1s that i1t can use a
StateMachine at the same time to detect State transitions
that might occur along the way. These States are represented
at the point in time on the lifeline of the object. The
transitions also are apparent from the lifelines. Any invalid
or illegal transition will be highlighted with a red border.
Have a look.

Process

Firstly you model a StateMachine for the appropriate Class
clement.

You then compose the expressions that define each State
using the 'Constraints' tab of each State.

These simple expressions are formed using attribute names
from Class model and actual code base. They are not OCL
statements. Each expression should appear on a separate
line.

m_strColor == "Blue"
You then use the Recorder window to launch the debugger.

The Recorder window Run button is different from the
button on other debugger toolbars.

The Recorder window will allow you to browse for a
StateMachine if you do not know the StateMachine name.
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The 'State Transition' dialog presents a list of StateMachines
for the entire model, in which you locate and select the
appropriate diagram (see the example).

When you generate the Sequence diagram, it depicts not
only the sequence but changes in State at the various points
in the sequence; each Class instance participating in the
detection process 1s displayed with its own lifeline.

Example

The Stations StateMachine shows the different States within
the Melbourne Underground Loop subway system.

A train traveling on the subway network can be stopped at
any of the stations represented on the StateMachine.

The Stations StateMachine 1s a child of the CTrain Class.

= |E] Subway
= 4 Subway
T3 Subway
+ «enumeration= <ancnymaot
o CXTrain

mts
<—?0 DoDatakxchange{CDatakE
— =@ Staticns
[ Stations
@ Central
.. @ Flinders

N ‘ i (I Lonsdale
constraints constraints i
{Location=0} {Location=0} 2 Parliamen t
DEpsrting.NsmE=Lans:lsB \.{Espsning.NsmE=SpEncEr (=] Spencer

- @ Treasury
+ Bl Stations
+ CControlPanel
+ B Clock

When you browse for the diagram 1n the 'State Transition
Recorder' dialog, the hierarchy shows only the root Package,
parent Class and child SubMachine and diagram; no other
model components are listed.
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P

-

& | State Transition Recorder [=E3=|
|_i| C++.Software. Implementation Model.Systems Enging »
= B 10

E- @ SearchExternalMedia
b %g SearchExternalMedia
[ Java.Software. Implementation Model, Systems Engine
= 10
- @ SearchExternalMedia
b %g SearchExternalMedia
D VBMet. Software. Implementation Model. Systems Engir
= 10
- @ SearchExternalMedia
b %g SearchExternalMedia
[ Source.C++Mative,Execution Analysis

EI CTrain =
- @ Stations
-3 E =
< | Il | b

Record state transitions for Stations

[ Select ” Cancel ” Help ]

(c) Sparx Systems 2019 Page 340 of 421



User Guide - Visual Execution Analysis 20 January, 2020

Recording and Mapping State Changes

This topic discusses how to set constraints against each
State in the StateMachine under a Class, to define the
change 1n state to be recorded.

Example

This example of a State 'Properties' dialog 1s for the State
called Parliament; the 'Constraints' tab is open to show how
the State 1s linked to the Class CXTrain.

A State can be defined by a single constraint or by many; in
the example, the Parliament State has two constraints:
Defined Constraints Save Delete

Constrairt Type Status

Location=0 Invariant Approved
Departing. Mame=Padiament Imvariant Approved

The values of constraints can only be compared for
elemental, enum and string types

The CXTrain Class has a member called Location of type

int, and a member called Departing.Name of type CString;
what this constraint means is that this State is evaluated to
True when:

. an instance of the CXTrain Class exists and
. 1ts member variable Location has the value 0 and

. the member variable Departing.Name has the value
Parliament
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Operators in Constraints

There are two types of operator you can use on constraints
to define a State:

. Logical operators AND and OR can be used to combine
constraints

. Equivalence operators {= and !=} can be used to define
the conditions of a constraint

All the constraints for a State are subject to an AND
operation unless otherwise specified; you can use the OR
operation on them instead, so you could rewrite the
constraints in the example as:

Location=0 OR
Location=1 AND
Departing.Name!=Central
Here are some examples of using the equivalence operators:
Departing.Name!=Central AND
Location!=1

Notes

. Quotes around strings are optional; the comparison for
strings 1s always case-sensitive in determining the truth of
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a constraint
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State Analyzer

The State Analyzer is a feature that can analyze, detect and
record states for instances of a Class. The feature works by
combining a state definition, defined on a Class as a
constraint, and markers called State points. It is available on
any languages supported by the Execution Analyzer,
including Microsoft. NET, Mono, Java and native C++.

We begin by selecting a Class and composing our state
definition.

Responsibilities v 2 x
B | X

Overview Requirements Scenarios Constraints

Constraint:
StateDefinition.Location

Property

Type Invariant =
Status Approved
= W] —_— | —
BJ7U&E- == %@ [

statedef
{

Location=0;
Departing.Mame;
1

name=Departing.Mame;

default=Moving;

We can get a picture of all the state definitions we've
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defined by placing the Class on a diagram and linking notes
to the Class that themselves link to a particular state
definition constraint. We explain how to do that in a later

section.

Source:CTrain

N ' N N

=lInwvariant» = Invariants

nvanants
[stateDefinition idle - statedef
Location=0;
1

I
name="idlke";

an
{statepefintion Busy : statedef
Fassengers 1007
1

I
name="Busy;

an
|statensfinition Location : statedef

Location=0;
Deepearting Marme;
1

defaukt="active";}

default="Ciet"; namse=Cheparting Hame;

default=rioving;

State points are set by placing one or more markers in
relevant source code.

72 DWOED
74 {

75
(2] —=

75

79
a0
81
82 )

CTrain::0OnArrival{ CStation* 5)

Departing = 5;
Location = 0O;
Dezlay = (Disembark(GetRandom()) + Embark(GetRandem()));
DWORD ScheduleTims = Network->TimsAtStation(Departing);
if({Delay > (int)ScheduleTims)

return Delay;
return ScheduleTime;

The program to be analyzed is run using the State Analyzer
control. When the Execution Analyzer encounters any State
point, the current instance of the Class is analyzed. Where
the value domain of the instance matches the state
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definition, a state 1s recorded. Each time the instance varies,
new states are thus detected. The control lists each state as
it is discovered. Under each state the control lists the
discrete set of transitions to other states made by instances
of the class.

Record & Analyze v rx

Sequence Recorder State Analyzer

CTrain Location @
States Transitions
@ Moving -
@D Lonsdale
Central O
O Flinders
Spencer O
O Spencer
rd Lensdale @
O Central
rd Parliament @
D Parliament
Ve Treasury O
@ Treasury
Z Flinders & =
P »

Record & Analyze System Output

The information can be used to create a State Machine.

» yLoop Statio
stm Cityloon Statsons A
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Using the same information we can easily produce a Heat
Map. This example shows a '"Train' Class, its 'Bulletin' State
Definition (as a linked note), and the Heat Map it produced.
The Figures in the map are percentages. From the map we
can observe that trains were in the 'In Transit' state 46% of

the time.

TObject
Source:{Train

Bulletin

I -

This is the analysis for the 'Bulletin' State Definition that

produced our Heat Map.

Record & Analyze

Sequence Recorder 5State Analyzer

Bulletin

States

2 In Transit
e
e

O Approaching
e

O Arriving
e

O Boarding

e
D Bad
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=i @El
Transitions Count
161
Arriving & 1
Approaching OO 1
26
Boarding & 2
32
In Transit & 2
40
Bad O 2
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Access

Ribbon Execute > Tools > Recorder > Open
Recorder > State Analyzer

Design > Element > Editors >
Constraints

State Definitions

State Definitions are composed in the Constraints properties
of a Class element. The constraint type should be named
StateDefinition.name, where 'name' is your choice of title
for the definition. These titles are listed in the combo box of
the State Analyzer whenever a Class 1s selected. You select
a single definition from this combo box prior to running the
program. The State Definition in our example is named
'StateDefinition.Location'. It defines states based on the
location of instances of the CTrain Class.

State Definitions are composed of one or more
specifications. Each state specification begins with the
keyword 'statedef’ which is then followed by one or more
statements. Statements define the constraints that describe
the state, and optionally a variable whose value can be used
to name the state. Statements are enclosed in curly brackets
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and are terminated with a semi colon as shown:

statedef {
Location=0;
Departing.Name;
b

Naming states using variables

In this example, 'Location' is a constant and
'Departing.name’' 1s a variable. An additional statement
follows the constraints and instructs the name of the State to
be assigned from the variable value. Here is the definition
with the naming directive.

statedef {
Location=0;
Departing.Name;
h

name=Departing.Name;

Naming states using literals

In this example the State Definition only contains constants
and the state 1s named using a literal.

statedef {
Location=100;
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b

name='Central’;

A single State Definition defining multiple State

specifications.

statedef {
Passengers > 100;

b

name=Busy;
statedef {
Passengers >= 50;

h

name=Quiet;

statedef {
Passengers < 50;

b

name=Very Quiet;

statedef {
Passengers = 0;

b

name=Idle;

Default State
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A State definition can specify a default 'catch all' state that
will describe the state of an instance when no other state
holds true. You define a default state for the definition with
a statement resembling this:

statedef {
Location=0;
Departing.Name;
b

name=Departing.Name;
default=Moving;

In this example, while execution is in progress any instance
detected having a non-zero 'Location' attribute will be
recorded as being in the 'Moving' state.

You can choose to exclude the recording of the default state
by disabling the 'Include default state' option on the drop
down menu of the State Analyzer toolbar. This would
exclude transitions to any 'default' state being recorded.

Creating Notes on a Class element that
display State Definitions

This section describes how to create the Class diagram that
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shows all the State Definitions defined for the Class.

Actions

Display a
Class
diagram

Create a link
to the Class
element

Create a note
element

Link the note
to the State
Definition

Choose the
definition to
display on

(c) Sparx Systems 2019

Open an existing Class diagram or create
a new one.

Drag the Class of interest on to the
diagram as a link.

Create a note element on the diagram and
link 1t to the class.

Select the link between the Note and the
Class and, using its context menu, select
the 'Link Note to Element Feature' option.

From the element dialog, choose
'Constraints' from the drop combo. Any
defined State Definitions will be listed for
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the Note you to choose from.

Repeat Repeat the procedure for any other State
Definitions on the class.
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Synchronization

The recording produces a number of assets, the recording
history being the main one. Recording also identifies a set of
source code files. This set can be used to produce Class and
Test Domain diagrams, but can also be used to synchronize
your model.

A synchronized model provides quick and accurate
navigation between diagram elements and the Class model.

Access
Ribbon Execute > Tools > Recorder > Open
Recorder > Toolbar == button
Context Right-click on the Record & Analyze
Menu window | Synchronize Model with Source

Code

Synchronize Model
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Synchronize Model e I,il?-,l
Synchronize Package from selected source code files below:
Package: |Source Select
Files Action
C#
|
| chea'wea'microsoft net'delegates'delegates 1"bookstore cs Synch |

4 4

Select Al Select Mone QK Cancel

Field/Button | Action

Package Click on the Select button and select the
target Package into which to
reverse-engineer the code files.

Files/Action | Lists the files identified during one or
more recording(s). The appropriate action
1s listed next to each file.

Select All Click on this button to select the
checkbox against every file in the 'Files'
list.

Select None | Click on this button to clear the checkbox
against every file in the 'Files' list.

OK Click on this button to start the operation.
The progress of the synchronization will
be displayed.
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Cancel Click on this button to abort
synchronization and close the dialog.
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Testpoints

Testpoints present a scheme by which constraints and rules
governing the behavior of objects can be taken from the
model and applied to one or more applications. The
advantages that schemes such as this offer are tolerance to
code changes - adding and subtracting lines from a function
has no effect on the constraints that govern it. Another
advantage 1s that changes to the behavioral rules do not
require a corresponding change to any source code; meaning
nothing has to be re-compiled!

Also, the ability to verify multiple applications using a
single test domain 1s a simple rather than onerous matter.
The Test Domain is a both a logical and relational model;
constraints in the Class model can be partitioned with Test
Cuts. These can be aggregated simply into Test Sets and
Test Suites using connectors. Due to the decoupling of the
Test Domain from the codebase, it is a simple choice of
buttons to run a program normally, or run it for a specific
Test Domain. This system also delivers practical benefits in
that no instrumentation is required at all. Test results are
displayed in the report window during the run, in real-time,
as the program runs. These results can be retained, and
reviewed at any time in the 'Test Details' dialog or using
Enterprise Architect's documentation features.
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Features

Feature

Testpoint
Composition

(c) Sparx Systems 2019

Details

Testpoint composition is performed using
the Testpoints window. The Testpoints
window 1s context-sensitive and displays
the Test Domain for the selected element
in either the Browser window or diagram.
Selecting a single Class will display the
Class structure. A 'pencil' icon is
displayed against Classes and methods
that have existing constraints.

When you select a Test Cut, Set or Suite
Test, the Testpoints window displays the
entire Domain structure, including all the
Classes that make up the domain. Note:
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You can navigate the domain hierarchy
using the 'Navigation' pane on the right.
Testpoints are composed as expressions,
using the variable names of the Class
members. The Intelli-sense shortcut
Ctrl+Space is available within the editor
to help you find these. Expressions that
evaluate to True are taken to mean a pass.

Returning False is taken to mean a fail.

Tests:Stock [ E-H '@'

Tests Id | Constrai..  Evals Passes Fa Parent Collections:

= & Stock 7 538 538 - ] Exchange Stock
= 2 Invariant 316 316 ] Buy Stock
/ m_stkSector <> "" 1 316 316 ] Sell Stock
=l =% IStock” Create(|lExchange®, LPCTSTR,F @ p/ 12 12
= [z Pre-Condition 12 12
¢ (pExchange=>null) AND (stock 4 12 12
» LPCTSTR GetMName()
= =4 ESector GetSector() o J 70 70
= [z Pre-Condition 7 7
# m_stkSector = "secCount” 5 70 70
=) =4 FLOAT GetStockCost() @ ;7 70 70

¢ m_stkUnitCost = 0 2 70 70
# TStocklD GetStockiD()
= =i UINT GetStockVolume() @ p/ 70 70
# [z3 Pre-Condition 70 70
» void SetStockID{TStockiD)

You can add or edit an existing Invariant
by double-clicking the Class.

You can add or edit an existing pre- or
post-condition similarly by
double-clicking the method.
Double-clicking a Testpoint will

automatically display the source code if it
1s available.

Line conditions are best added from
within the code editor using its shortcut
menus.

This image 1s of a pre-condition in the
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Test domain.

pr'"l Testpoint Editor: : Exchange. StockiGetStockVolume() *

Constrairt
Type: Pre-Condition -

Condition: m_stkVolume ==10

Action on Fail: & Ereak execution -

Evaluate
When:

Trace

Level: Fail Only =
Statement: | Stock volume: @m_stkVolume is not allowed to be negative
Cancel Help
Testpoint Each Testpoint can have its own Trace
Trace statement. The Trace statement 1s a
Statements dynamic message that can reference

variables 1n its object or local scope.

They are output during the evaluation of a
test. They can be configured to be output
every time a constraint is evaluated, or
more usually when a test has failed. Trace
statements can be directed to the
"Testpoints' tab of the System Output
Window, or to an external file. You can
configure this in any Analyzer Script.

Test Domain | The Test Domain diagram 1s a dynamic
Composition = medium where Testpoints are assembled
to test Use Cases. Use Cases in a Test
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Domain diagram are provided in three
different stereotypes: Test Cut, Test Set
and Test Suite. Management of the
domain is as easy as modeling on any
diagram. The toolbox and shortcut menus
provide access to any Test Domain
Artifacts. In brief, Testpoints from
multiple Classes are aggregated into Test
Sets. Test Sets are then linked to form
Test Suites. Both Test Cuts and Test Sets
are re-usable assets. Linking the same
Test Set to the one or more Test Suites is
a matter of drawing connectors.

gtestset»
Sell Stock

4 AN

«testcut»
Sell Stock

Test Domain | Rarely would a Use Case involve all the

and the Class = methods of a single Class. Most likely it

Model 1s realized using a variety of methods
from collaborating Classes. We call this
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subset of methods a 'cut', and the Test Cut
Artifact 1s the tool we use to make these
cuts. The Testpoints window will adapt
depending on the context, to be that for a
Test Domain or Class element. This
image shows the Testpoints window
when a Test Cut has been selected. Note
the checkboxes, which are only visible
for a Test Cut. They denote the methods
(Test Cuts) that are contributing to a Test
Set. In this example the Test domain was
generated by the Execution Analyzer,
which did the method identification work

for us.
TestCut:AddCustomer s J O E-H@
Tests ld  Constraints  Parent Collections:
= ] AddCustomerTC2 @ AddCustomer
= & Customer
s int AddNew() m
¢ int GetAddressi(string] ]
 int GetiD() )
¢ string GetMame(string) (]
Testpoint The Testpoints window is used to
Evaluation evaluate Test domains. The window has a

toolbar for starting or attaching to the
target application. The domain to test is
always reflected by the element that has
context, so i1f you select a Class the
window will show only the Class
structure and Testpoints of that Class. If
you select a Test Suite, the window will
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display the entire domain hierarchy and
all the Testpoints included in it. Clicking
on the Run button will load the Testpoint
domain in the Execution Analyzer, which
will then evaluate, collect and update the
report window as Use Cases pass or fail
each test. The exact details of each
constraint type and the when and how of
that constraint's capture are:

. A Class Invariant 1s evaluated by the
Analyzer whenever any method called
on an object of this Class type is
completed; the invariant serves to test
that the state of a complying object is
both known and permitted

. Pre-conditions are evaluated

immediately before an operation i1s
called

. Post-conditions are evaluated (at the
same time as a Class invariant) when
the method 1s completed

. Line-conditions are evaluated if and
when their specific line of code comes
into scope during program execution
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Test Domain Diagram

The Test Domain diagram 1s the medium where you
assemble and group test cases for a particular domain. An
example of a Test domain might be 'Customer'. The breadth
and depth of the domains you assemble is up to you. You
might have separate domains for 'Add Customer' and 'Delete
Customer', depending entirely on how you consider best to
balance the domain hierarchy. The Diagram Toolbox and
Shortcut menu provide a number of Artifacts to help model
the domain. Because the medium 1s dynamic, allowing you
to revisit and build on relationships between Test domains,
the system is a great model for delivering reusable assets to
an organization that are low overhead and integrate with
both the UML view of the world, and the Software
Engineering nuts and bolts of daily life.

Facilities
Facility Details

Test Domain | If you think the process of composing a

Generation Test Domain is complex, it can be, but
help 1s at hand! The Execution Analyzer
can produce a Test Domain diagram for
you. It cannot write the Tests for you, but
it can do some of the leg work. It can
identify the Classes and pick out only
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those methods that participated in a Use
Case. And this is not guesswork. The
Analyzer Test Domain is obtained from a
running program. This image shows the
Test Domain generated by the Execution
Analyzer from recording an Example
Model program.

«testcu
Buy Sector

And this is the recording itself (as a
Sequence diagram) from which the Test
Domain was generated.

Test Domain | The first task on a Test Domain diagram
Composition  1s to create the Use Cases (Test Sets).
These define this particular domain's
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responsibility. The Diagram Toolbox and
shortcut menu provide Artifacts to help
you achieve this. The first of these
elements 1s the Test Cut, which 1s used in
the next step; identifying those methods
(from the Class model) that you consider
to be participants in the Use Case. The
Test Cut Artifact is useful because it
allows us to partition a Class, selecting
only those methods that are relevant. Test
Cuts can be run individually or linked to
one or more Test Sets. Test Sets in turn
can be linked to one or more Test Suites.
In any case, any element of the Test
Domain tree can be run individually or as

a whole.
#testset»
Buy Stock ot
_ =
_ -
—
_ = (from Buy)
wrestsuite»
Trade Stock
~
- ~
~
~
S\
«testset»
Sell Stock ———— oo

(from Sell)

Exchange:Buy Use Case

TestSet generated from
recording history of

TestSet generated from
recording history of the
Exchange::Sell Use Case
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Test Cut

wtestocuts
TestCutd

Description

A Test Cut element is a stereotyped Object element, used
internal to Enterprise Architect for defining Test Sets using
the Testpoint code testing facilities.

A task, such as 'Print', might involve operations on different
Classes. In order to create a 'Print' test, you would want to
include only the 'Print' operations of these Classes and
exclude any other operations.

A Test Cut enables you to capture only the operations that
represent the behavior (in this case, 'Print') defined for a
single Class. You might then place the Test Cut from each
of several Classes into a single task as a Test Set.

When you drag a Test Cut element onto a Test Domain
diagram, you create a Dependency relationship with the
required Class element. As a result, when you select the Test
Cut element on the Testpoints window, the operations of the
Class are listed in the window, each with a checkbox. You
then select the checkbox against each Class operation to
include in the Test Cut.
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Toolbox icon

Bl TestCut -
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Test Set

stestsets
Test5et1

Description

A Test Set element is a stereotyped Use Case element used
to aggregate one or more groups of methods (Test Cuts),
which perhaps span multiple Classes, into a single task. Test
Sets can also be aggregated into Test Suites.

You link the Test Cut elements to the Test Set using
Dependency connectors.

Toolbox icon

i Test Set
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Test Suite

wtestsuites
TestSuite

Description

A Test Suite element 1s a stereotyped Use Case element,
used to aggregate one or more groups of tasks (Test Sets).

You link the Test Set elements to the Test Suite using
Dependency connectors.

Toolbox icon

i Test Suite
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The Testpoints Window

The Testpoints Window is the hub where Test Domain
constraints are composed. It is also the control that lets you
verify a particular Test Domain on a program. The program
might be already running or it can be launched using the
control's Toolbar. Here you will also be able to see the
results of your tests, as they happen. This control is
context-sensitive, responding to the selection of elements in
the Browser window or on a diagram. Depending on the
selection, tests can be carried out on a single Class, a Use
Case (Test Set) or a collection of Use Cases (A Test Suite).

Access

Ribbon Execute > Tools > Tester > Show
Testpoint Window

Testpoints Window Columns

Column Usage

Tests Displays the name of the selected
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Id

Constraints
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Testpoint object and the hierarchy of
objects beneath it.

The selected object can be a:
. Class

. Operation

. Test Cut

. Test Set or

. Test Suite

For an Operation, this column shows a
Testpoint marker icon (2) when the
Analyzer has successfully bound this
operation in the target application. If no
icon appears in this column during a run,
it indicates that the model and code base
might not be synchronized; perhaps the
signature of the function has changed, or
the operation is a new method you are
working on that exists in the source code
but not yet in your model.

For a Testpoint, this column shows a
generated 1d number. This 1d number i1s
used in trace output to indicate which
constraint 1s being referenced

A pencil icon (/) in this column indicates
that one or more constraints are defined
for this Class or Operation.
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Status

Evals

Passes

Fails

Last Run By
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During a test run, indicates these possible
statuses:

. (») Failed - Constraint has evaluated as
false one or more times.

. (t) Invalid Statement - Constraint
failed to parse due to invalid syntax.

. (?) Variable not found - A referenced
variable name was not found at the
location where the constraint was
evaluated.

No icon 1s shown if a constraint has
Passed.

During a test run, indicates the number of
times the Execution Analyzer has
evaluated this constraint.

During a test run, indicates the number of
times the test passed.

During a test run, indicates the number of
times the test failed.

Displays the username of the last person
to run this test. (Values are derived from
the Project Author definitions in the

'People’ dialog - 'Configure > Reference
Data > Model Types > People > Project
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Last Run
Date

Last Run
Result

Parent
Collections
Pane
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Authors'.)

Displays the date and time this test was
last evaluated.

Displays the result of the last test run.

Lists any parent collections that include
the selected object as part of their design.

Double-click this collection to make it the
selected object in the left pane.

The Parent Collections pane can be
hidden by clicking the Show / Hide
Parent Collections pane button on the
Testpoints Window Toolbar.
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Testpoints Toolbar

The Testpoints Window Toolbar provides options to execute
configured tests on the currently selected Testpoint object,
stop a test run currently in progress, filter the displayed
items, and save the results of a completed test run.

Access

Ribbon Execute > Tools > Tester > Show
Testpoint Window

Testpoints toolbar options

Toolbar Action
Button
TestCut:CTrain Field showing the name of the currently

selected Testpoint object.
b Execute the test run.

B Stop the test run currently in progress.
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; Toggle between showing all items and
showing only those items that have
constraints defined.

= Toggle between showing all items and
showing only operations that have been
marked for inclusion in this Test Cut; this
button is only enabled when a Test Cut
object is selected.

When a Test Cut is selected, each of the
operations of its associated Class are
displayed with a checkbox; you use this
checkbox to mark the operations that
apply to this Test Cut.

=R Click on the drop arrow next to this icon
to display the 'Test Run Options' menu,
providing these options:

. 'Prefix Trace output With Function
Call' - Prefix all trace output lines with
the executing function name

. 'Enable Standard Breakpoints during
Testing' - When not checked, the test
run ignores any breakpoints in the
current breakpoint set, and any
attempts to set breakpoints during the
run are ignored

. 'View Trace output' - Display the
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"Testpoints' tab of the System Output
window

Click on this icon after completion of a
test run to save the results to Test item on
the current object. Saved tests can be
viewed using the Testing Workspace.

A prompt displays to select the Test Class
- Unit, Integration, System, Inspection,
Acceptance or Scenario. Select the
appropriate Test Class and click on the
OK button.

Display the Testpoint Management Help
topic.

Show or hide the Parent Collections pane.
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Testpoint Editor

The Testpoint Editor is used to compose constraints for
Classes and Operations. The types of constraint permitted
are dependent on the selected object. For Classes, the type
will always be Invariant. For operations, the type can be
either Pre-Condition, Post-Condition or Line-Condition.

Invariants are evaluated by the Analyzer when any method
called on an object of the selected Class type completes.
Pre-conditions are evaluated at the beginning of each call to
the specified operation. Post-conditions are evaluated upon
completion of each call to the specified operation.
Line-conditions are evaluated each time the specified line of
code 1s executed.

p-" Testpoint Editor: : Exchange.Stock: GetStockVolume() *

Constraint
Type: Pre-Condition -

Conditian: m_stkVolume =10

Action on Fail: & Ereak execution -

Evaluate
When:

Trace

Level: Fail Only o

Statement: | Stock volume: @m_stkVolume is not allowed to be negative

Cancel Help

Access
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Ribbon

1. Execute > Tools > Tester > Show

Testpoint Window.

2. In the Testpoints window, double-click

on a Class or Operation to display the
"Testpoint Editor' dialog.

Constraint Group fields

Field

Type

(c) Sparx Systems 2019

Usage

The type of constraint for the selected
Class or Operation:

. Invariant - Evaluated after any method

called on the specified Class has
completed

. Pre-Condition - Evaluated at the

beginning of each call to a specific
Operation

. Post-Condition - Evaluated after

completion of each call to a specific
Operation

. Line-Condition - Evaluated upon

execution of a specific line of code
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Offset

Condition

Action on
Fail

Evaluate
When
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within an Operation

For Line-Conditions only, the Line
number within the specified operation
upon which to evaluate the constraint.

An offset value is automatically set if the
Testpoint was created using the Code
Editor context menu.

The constraint to be evaluated when this
Testpoint 1s triggered. A status of pass or
fail will be recorded depending upon
whether this constraint condition
evaluates as true or false.

Click on the drop-down arrow and select
from the three options:

. 'Continue' - ignore failure of this
constraint and continue execution

. 'Break execution' - halt execution and
display the Stack trace

. 'Disable on fail' - do not execute the
constraint again after failing once

(Optional) An additional constraint which
must be met before the main Testpoint
Condition 1s evaluated, providing greater
control over test coverage.
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Trace Group fields

Option Action

Level Specifies when the trace statement (if
defined) will be output. Available options
are:

. 'Fail Only' - Output trace statement
only when this Testpoint condition fails

. 'Always' - Output trace statement every
time this Testpoint is evaluated

Statement (Optional) A message to be output when
this Testpoint is evaluated.

Variables currently in scope can be
included in a trace statement output by
prefixing the variable name with a $
token for string variables, or a (@ token
for primitive types such as int or long.
Output from a Trace Statement can be
directed either to the '"Testpoints' tab of
the System Output Window, or to an
external file, as configured by the
Analyzer Script for the parent Package.
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Testpoint Constraints

A Constraint 1s typically composed using local and member
variables in expressions, separated by operators to define
one or more specific criteria that must be met. A constraint
must evaluate as true to be considered as Passed. If a
constraint evaluates as false, it is considered as Failed.

Any variables referenced within the constraint must be in
scope at the position where the Testpoint or Breakpoint is
evaluated.

General/Arithmetic Operators

Operator Description

+ Add
Example:a+b>0

- Subtract
Example:a-b>0

/ Divide
Example: a/b ==

* Multiply
Example: a*b==c
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% Modulus
Example: a % 2 ==

0 Parentheses - Used to define precedence
in complex expressions.

Example: ((a/b) * ¢c) <= 100

[ ] Square Brackets - Used for accessing
Arrays.
Example: Names[0].Surname == "Smith"

Dot operator - Used to access member
variables of a Class.

Example: Station.Name == "Flinders"
-> Alternative notation for the Dot operator.
Example: Station->Name == "Flinders"

Comparison Operators

Operator Description

= Equal To
Example: a=b
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<>

Equal To
Example: a ==

Not Equal To
Example: a!=b

Not Equal To
Example: a <> b

Greater Than
Example: a>b

Greater Than or Equal To
Example: a>=b

Less Than
Example: a<b

Less Than or Equal To
Example: a <=b

Logical Operators
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Operator Description

AND Logical AND
Example: (a>= 1) AND (a <= 10)

OR Logical OR
Example: (a==1) OR (b==1)

Bitwise Operators

Operator Description

& Bitwise AND
Example: (1 & 1) =1
(1&0)=0

Bitwise OR
Example: (1 |1)=1
(110)=1

A Bitwise XOR (exclusive OR)

Example: (1 7 1)=0
(170)=1
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Additional Examples

Example Description

((m_nValue | Use a Bitwise AND operator (&) with a
& hexadecimal value as the right operand to
OxFFFF0000) test that no bits are set in high order bytes
== () of the variable.

((m_nValue  Use a Bitwise AND operator (&) with a
& hexadecimal value as the right operand to
0x0000FFFF)  test that no bits are set in low order bytes
== 0) of the variable.

m_value[0][1 = Accessing a multi-dimensional array
1=2

a AND (b Combining AND and OR operators,

OR ¢) using parentheses to ensure precedence.
In this example, variable 'a' must be true,
and either 'b' or 'c' must be true.

Notes
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. String comparisons are case-sensitive

(c) Sparx Systems 2019 Page 388 of 421



User Guide - Visual Execution Analysis 20 January, 2020

Object Workbench

The Object Workbench 1s an Enterprise Architect debugging
tool that helps you create objects from your Class model.
The Workbench allows multiple instances of any Class to
coexist in the same session. Each Object can serve as the
target of a method you want to invoke. They can also
participate as parameters in methods you invoke. The Object
Workbench is supported for the Java and Microsoft NET
platforms.

Workbench Tasks

Task

Provides a guide and the requirements for using the
Object Workbench.

Explains what Workbench objects are, and how to create
them.

Explains how to execute methods on a Workbench Object
and provides information on passing arguments.

Explains stepping through a method's execution using the
Debugger.
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Explains how to record a method and produce a Sequence
diagram.

Explains how to delete a Workbench Object once you are
finished with it.

Explains how to shut down the Debugger and close the
Workbench once you have finished with it.
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Using the Workbench

Using the Object Workbench is straightforward. From your
Class model, select the Classes to workbench and drag them
individually on to the Workbench window. You might have
to choose a constructor if more than one exists, then simply
give the variable a name. The Object workbench prepares
the required runtime, loads any required modules and
instantiates the objects for you. Executing a method is a
matter of selecting from a list. Parameters can be entered
where required. Workbench objects themselves can be used
as parameters either singly or as object arrays.

Access

Ribbon Execute > Tools > Tester > Open Object
Workbench

Analyzer Script Requirements

An Analyzer Script that has been configured for debugging
is required. It should specify this information:

. The debugger to match your project
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. For Microsoft .NET, the location of the assembly that will
be hosted by the Object Workbench

. For Java, the location of the JDK and additional class
paths to use

Checklist

. Select the intended Workbench Class and press F12; the
source code should be displayed in a code editor

. Press Shift+F12 to build the project; the output from the
build should show successful compilation
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Creating Objects

This topic explains how to create a workbench instance for a
Class from your model.

Access

Ribbon Execute > Tools > Tester > Open Object
Workbench

Keyboard Ctrl+-Shift+]

Shorcuts
Other Drag a Class directly from the Browser
window onto the Workbench window
Tasks
Task Detail
Creating an Select the Class in the Browser window

Object on the | and drag it on to the Workbench window.
Workbench | The "Workbench' dialog displays.
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Choosing a
Constructor

Enter
Parameters
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MName

Value

MyClassLibrary. CPerson

[ Create ]| Help || Cancel |

Type in a name for the new instance. The
name should be unique for the

Workbench.
Click on the Create button.

The 'Constructor' dialog is displayed
where a choice of constructor exists.

X

Employee(MyClassLibrary: CPerson)

-]

CPerson(]
CPerson({CPerson)
CPerson(String, String,int)

Select the constructor from the
drop-down list

Provide values for the selected
constructor's parameters:

. Strings as arguments - Surround values
with quotes where appropriate, or
where the value would conflict with the
name of a Workbench object

. Objects as arguments - Enter the name
of the Workbench object
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String array arguments take text values
separated by commas:

one,two,three,"a book","a bigger
book"

. Object arrays as arguments take object
names separated by commas; supply
the named Workbench objects
separated by commas, for example:

Tom,Dick,Harry
Invoke Click on the Invoke button to create the

Constructor  instance. The object can be recognized by
its name in the Workbench window.

(c) Sparx Systems 2019 Page 395 of 421



User Guide - Visual Execution Analysis 20 January, 2020

Invoking Methods

Access

On the Workbench window, right-click on the instance on
which to execute a method, and select 'Invoke'.

Ribbon Execute > Tools > Tester > Open Object
Workbench
Actions
Action Details
Choose Select a method from the list and click on
Method the Invoke button.

Note that all methods listed are public;
private methods are not available.
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Rob(MyClassLibrary:Person) x

nt AddFriends(MyClassLibrary.Person[] -
int AddFriends({MyClassLibrary.Person|]

Person Find(string)

int FriendCount()

bool IsFriend(string)
void main(string[])
string Mame()

string Occupation)
void Run(string[])

int SetAge(int)

String SetMame(string)
String SetTown(string)
bool Test{string)

Provide In this image, the method to be invoked
Arguments takes an array of objects as its only
argument. You construct this argument
by naming the other instances on your
Workbench that you want to pass to the
method.
Variable Value Type
$ John MyClassLibrary.CPerson
§ Robert MyClassLibrary.CPerson
MyClassLibrary.CPerson
% mnt 0 Sheila(MyClassLibrary:: CPerson)
g E:El.::;m E; int.ﬁ.ddFriEjnds{MyCIassLibrary.CPersnn[I}l
& AverageAge o.00l MyClassLibrary. CPerson(] John,Robert
& FriendCount 0
& Age 0
& Friends
Argument These are the parameter types supported
Types by the Workbench:

. Strings

. Numbers

. Objects

. String Arrays
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Argument
Syntax

Invoke
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. Object Arrays

Strings as arguments - Surround strings
with quotes where necessary; for
example, to avoid conflict with
Workbench object names

String Arrays as arguments - Enter the
clements that compose the array,
separated by commas; for example:

"A maths book","A geography
book","A computer book"

. Objects as arguments - Type the
Workbench object name as the
argument; the debugger checks any
name entered in an argument against its
list of Workbench instances, and will
substitute that instance in the actual call
to the method

. Object Arrays as arguments - Enter the
Workbench objects' names to satisfy
the argument, separated by commas:

Tom,John,Peter

Click on the Invoke button to execute the
method.

Output confirming this action is
displayed in the Debug window.
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#- % p ulEvEcza | v H @

[437449575]  Stack recording threshold set to 7 frames

[437449717]  created new instance counter of Counter

[437449719]  Default Directory is C\Object Workbench\Microsoft NET\Utilities

[437449720]  Default Directory is CAObject Workbench\Microsoft NET\Utilities

[437449720] C:\Program Files (x86)\Spam Systems\EA\wea\ubd\ 55Workbenchtd . exe targets .M
[437449720]  Process created \Device\HarddiskVolume2yProgram Files (x86)\5pan: SystemshEs
[437449720] Debug process in domain DefaultDomain

[437449720] Debug process in domain DefaultDomain

[437449721]  Debug Session Started

[4374604536]  Invoking method MumberOfDigits on instance counter of type Counter
[437460478]  MumberOfDigits returned 3
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Setting Properties

For languages that support properties, we can set the value
of an Object's property in the same manner in which we
invoke a method. Select the instance in the Workbench, and
use 1ts context menu to select the 'Invoke' option. You will
find the properties exposed by the Class listed
alphabetically, along with its methods. You will be
prompted to provide the new value of the property. Type the
value as you would have entered it for the parameter in a
method call. This image demonstrates changing the
Occupation property of a Person called Bertie,; Bertie being
a type of Person.

Warkbench

Variable Walue A
% § Rob Eertie(MyClassLibrang: Plumber) *

+ @ string Occupation() -

string Schoolteacher
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Debugging and the Workbench

While you are working in the Workbench, you might want
to debug one or more methods you are developing or
investigating. This can easily be accomplished. The same
features of Enterprise Architect's Execution Analyzer are
available to users of the Object Workbench. Debugging can
be performed during object construction and destruction as
well as during the execution of a method. To gain access to
the debugger, simply place a breakpoint at the points at
which to step through the code. You could also set the
condition on these breakpoints to only break under certain
conditions.

28 // The NumberOfDigits static method calculates the number of

21 public int NumberOfDigits(string theString)
22 {
23 int count = 8;
24 for ( int 1 = 85 1 « theString.Length; i++ )
25 {
26 if ( Char.IsDigit(theString[i]) )
27 {
!b 28 count++;
29 }
30 }
31 m_nResult = count;
32 return m_nResult;
33 }
34 }
35 }

When debugging, the states of objects are inspected using
the debugger controls. Here we use the Locals window to
examine the state of our object while execution is halted.
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LGS oottt e e D T e D T e D T e D T e D T e D T e D T e D D e D D e D D e D D e D e P e e
Variable Value Type
=l @ this Litilities, Counter
§ m_nResult 3 int

s theString "123" String

§ i 0 int

& C53150000 0 int

(¥R C 55450001 false Boolean

§ count 0 int

When the program resumes, the Object on the Workbench
will reflect any changes in state.

B ] T 1 R

Variable Value Type

SN counter
@ m_nResult 9 int
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Recording and the Workbench

While you are working in the Workbench, you might want
to produce a Sequence diagram for one or more methods
you are developing or investigating. This can easily be
accomplished. The same features of Enterprise Architect's
Execution Analyzer are available in the Object Workbench.
Y ou might even begin a Workbench session by recording a
Sequence diagram first off, as a means of visualizing what
you plan to work on.

Set the Recording Marker

138
135 public beool Test(string name)

136 {
# 137 Person px = Find(name);
138 if(px !'= null)
139 {
148 return truej;
141 }
142 return IsFriend(name};
143 }

Invoke the Method
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Waorkbench

Variable Value Type
§ John My{ClassLibrary.CPerson
§ FRobert MyClassLibrary.CPerson
MyClassLibrary.CPerson
¢ m.Int k Sheila(MyClassLibrary:: CPerson)
2 E:Blzztlle 1§£ int AddFriends(MyClassLibrary. CPerson[])
& Averagefge 0.00 MyClassLibrary.CPersaon(] John,Robert
@ FriendCount i
@ Age 0
& Friends

View the Recording History

Record & Analyze

(=~ P ES G

Sequence Instance Method Direction Method

- 0ooooDo System.Reflection. RurtimeMethodIn...  Call MyClassLibrary. Person. Test
00000002 MyClassLibrary.Person. Test Call MyClassLibrary. Person.Find
00000003 MyClassLibrary.Person. Test Call MyClassLibrary. Person.Find
00000004 Retum MyClassLibrary . Person. Test
00000005 MyClassLibrary.Person. Test Call MyClassLibrary . Person. IsFriend
00000006 Retum MyClassLibrary . Person. Test

Generate the Sequence Diagram
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Nl 77 MyClassLibrary_Person_Test X

1 i |<¥ P |Default Style -| B
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Deleting Objects

You can easily delete an object by selecting it in the
Workbench, right-clicking on it and selecting the 'Delete’
option.
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Closing the Workbench

To shut down the Workbench perform any of these actions:
. Choose 'Reset' from the Object Workbench context menu
. Press the Stop button on any debugger toolbar

. Delete all objects on the Workbench
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Visualize Run State

You can record the state transitions of a single object by
taking multiple snapshots of the object's run state at key
points 1n its lifetime. To do this simply drag the local or
member variable on to an Object diagram.
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Unit Testing

Enterprise Architect supports integration with unit testing
tools in order to make it easier to develop good quality
software.

In sequence:

. You download and install the NUnit and JUnit
applications (NUnit - http://www.nunit.org/ JUnit -
http://www.junit.org/ ); Enterprise Architect does not
include these applications in the installer

. Enterprise Architect helps you to create test Class stubs
with the NUnit and JUnit transformations

. You define your test code within the Class stubs
. You set up and run a test script against any Package

. All test results are automatically recorded inside
Enterprise Architect
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Set Up Unit Testing

This topic explains the actions you should take in setting up
Unit Testing, after having downloaded and installed the
JUnit and/or NUnit applications.

Actions

Action Details

Create Unit By using the JUnit or NUnit

Test Stubs transformations and code generation you
can create test method stubs for all of the
public methods in each of your Classes.

(TestFixture)
public class CalculatorTest

d
(Test)

public void testAdd(){

)
(Test)

public void testDivide(){

)
(Test)
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public void testMultiply(){
b

(Test)

public void testSubtract() {

b
;

Define Test = Write your unit test in the generated code
Cases stubs (either in Enterprise Architect or in
your preferred IDE).

This is an NUnit example in C#, although
it could also be any other .NET language,
or Java and JUnit.

(TestFixture)
public class CalculatorTest
d
(Test)
public void testAdd(){
Assert.AreEqual(1+1,2);
h
(Test)
public void testDivide(){
Assert.AreEqual(2/2,1);

)
(Test)
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public void testMultiply() {
Assert.AreEqual(1*1,1);

)
(Test)

public void testSubtract(){
Assert.AreEqual(1-1,1);

Alternatively, 1f you have not performed
an xUnit transformation, you can reverse
engineer the code into Enterprise
Architect so that the system can record all
test results against this Class.

Compile Check that the source code being tested
Your Code compiles without errors, so that the test
scripts can be run against it.

Set up the Set up the Test scripts against the
Test Scripts | required Package, and then run the tests.
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Run Unit Tests

On running a test script you generate test results that are
stored as Test Cases against the Classes being tested.

Access
Ribbon Execute > Run > Start > Test
Execution ToolBar > Run Test Script
Analyzer Context Menu > Test
Window
Tasks
Task Details
Run Tests Select the appropriate Package in the

Browser window.

Select the 'Run Test Script' option to run
the test script you previously set up for
that Package, in the Execution Analyzer.
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View Results

(c) Sparx Systems 2019

The results of xUnit tests are displayed in
the System Output window, identifying
which tests have run and which of these
have failed.

The results also show which method
failed, and the file and line number the
failure occurred at.

Double-click on an error message;
Enterprise Architect opens the editor to
that line of code, enabling you to quickly
find and fix the error.

Enterprise Architect also records the run
status of each test against the Class being
tested; these are stored in the element
Test Cases.

A diagram containing the Class can be set
to display these Test Cases, by exposing
the test scripts compartment on the
diagram elements.
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Record Test Results

Enterprise Architect is able to automatically record all
results from tests through a testing script in Enterprise
Architect.

Process

In order to use this feature, you must reverse engineer the
test Class into the Package containing your test script.

Once your model contains your test Class, on the next run of
the test script Enterprise Architect adds Test Cases to the
Class for each test method found; on this and all subsequent
test runs all Test Cases are updated with the current run time
and whether they passed or failed, as shown:

Calculator Test

+ testAdd(): void

+ testDivide() : woid

+ testMultiphy() : void
+ testSubtract() : void

test scripts
Unit: : (Pass) testAdd
Unit: : (Pass) testDivide

Unit: : {Pass) testhultiphy
Unit: : (Fail) testSubtract

The error description for each failed test is added to any
existing results for that Test Case, along with the current
date and time.

Over time this provides a log of all test runs where each Test
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Case has failed, which can then be included in generated
documentation, resembling this:

Failed at 05-Jul-2006 1:02:08 PM
expected: <0>
but was: <1>

Failed at 28-Jun-2006 8:45:36 AM

expected: <0>
but was: <2-
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Samples

Enterprise Architect enables you to easily import complete
sample models (Packages), including all necessary model
information, code and build scripts. These sample Patterns
make it simple to explore and try out the Visual Execution
Analyzer. You can generate an example model for:

. Java

. Microsoft. NET
. Microsoft C++
. PHP Apache

Access
Ribbon Design > Model > Add > Insert > Model
Wizard > VEA Examples

Keyboard Ctrl+Shift+M > VEA Examples
Shortcuts

Other Browser window header bar : = | New
Model from Pattern > VEA Examples
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Display Samples
Field Action
Technology | Select the appropriate technology.
Name Displays the samples available for the
selected technology; select the required
sample to import.
description Displays a description of the selected
field sample.
Destination Browse for and select the directory in
folder which to load the source code for the
sample.
Use Local Enable the selection of an existing local
Path path to place the source code under;
changes the 'Destination folder' field to a
drop-down selection.
Compiler Displays the default compiler command
command path for the selected technology; you
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must either:

. Confirm that the compiler can be found
at this path, or

. Edit the path to the compiler location
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Edit Local Many VEA examples specify their
Paths compiler using a local path.

The first time you use any sample you
must click on this button to display the
'Local Paths' dialog, on which you check
and - if necessary - correct the local path
pointing to the correct compiler location.

Notes

. Ifrequired, you can define custom samples by adding files
to the AppSamples directory in which Enterprise
Architect 1s installed; top-level directories are listed as
Technologies and can contain an icon file to customize
the icon displayed for the technology
Directories below this are defined as groups in the
Patterns list; the Patterns are defined by the presence of
four files with a matching name: a zip file (.zip), XMI file
(.xml), config file (.cfg) and optional icon (.ico)

. The config file supports these fields:
- [provider], [language], [platform], [url],
[description], [version] - all displayed in the 'description’
field
- [xmirootpaths] - the root path of the source code in
the exported XMI; this 1s replaced with the
selected destination folder when the user applies the
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application pattern
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